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WF-6590 User's Guide

Welcome to the WF-6590 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics

See these sections to learn about the basic features of your product.

Note: Printing software instructions in this manual are intended for use with the standard Epson printer
software. For more information on using the Printer Command Language (PCL) or PostScript (PS3)
printer software, please see the appropriate sections.

Using the Control Panel

Product Parts Locations

Using Eco Mode and Other Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Printing and Scanning with NFC from Your Android Device

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel
Setting User Feature Restrictions (Access Control)
Changing LCD Screen Language

Adjusting Control Panel Sounds

Adjusting the Screen Brightness

Turning Off the Operation Time Out Setting

Parent topic: Product Basics
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Control Panel Buttons and Lights

The O power button and light
The M home button

The —* Interrupt button
The % Reset button

The @ Stop button

The LCD screen

The 3 back button

The i Status button and lights
The numeric keypad

The C clear button

The <& B&W button

The & Color button

0 N OO b~ WODN -

- A a
N = O
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Status Icon Information
Status Button Information

Parent topic: Using the Control Panel

Status Icon Information

Your product may display status icons on the LCD screen for certain product status conditions. Press
il to view or change the current network settings.

Icons

Description

S

Displays additional information or instructions, such as on loading paper or placing a
document.

ADF

A document is in the Automatic Document Feeder (ADF).

One or more of the ink cartridges are running low on ink or the maintenance box is nearly full.

Press the i Status button to open the Status Menu, select Printer Information, and check the
status of the consumables.

One or more of the ink cartridges are expended or the maintenance box is full.

Press the i Status button to open the Status Menu, select Printer Information, and check the
status of the consumabiles.

Unread or unprinted fax data is stored in the product. If you have set up the product to save
received faxes on a computer or external storage device, this icon may also indicate that
received faxes have not been saved on the computer or storage device.

Fax memory usage.

-

2\

Fax memory is full. Delete received faxes you have already read or printed. If you have set up
the product to save received faxes on a computer or external storage device, turn on the
computer or connect the storage device to the product.

A Wi-Fi or an Ethernet connection is being processed.

No Ethernet connection.

EWE 55 2 [ E

An Ethernet connection has been established.
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Description

No Wi-Fi connection.

A Wi-Fi network error has occurred or the product is searching for a connection.

A Wi-Fi connection has been established. The number of bars indicates the connection's signal
strength.

An Ad hoc connection has been established.

A Wi-Fi Direct mode connection has been established.

A Simple AP mode connection has been established.

Access to the product's functions are restricted to authorized users. Press the icon to log in to
the printer. (You need to enter a user name and password.) Contact your administrator if you
do not know the login information.

Access to the product's functions are restricted to authorized users and a user is currently
logged in. Press the icon to log out.

u H%o)))@@mmmg

Parent topic: Control Panel Buttons and Lights
Status Button Information
Press the i Status button on the control panel to view the current product and job status.

Function Description

Printer Information Displays the status of consumables and any errors that have occurred
with the product. Select the error from the list to display the error
message.

Job Monitor Displays the current job and any jobs waiting to be processed.

Job History Displays the job history and any error codes for failed jobs in the
history.

Job Storage Select Inbox to display received faxes stored in the product's history.
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Function Description

Confidential Job Displays jobs that require a password to print.

Parent topic: Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel

You can set an administrator password to lock the following settings and prevent them from being
changed:

» System Administration Setup settings
* Eco mode settings

* Presets

+ Contacts

Note: For more information on administration settings, see the Administrator's Guide.

1. Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

' ink Levels &
M EnmnGe: |

Papersee |
Print Status Sheet |

| Hetwark Stalus ]l:

3. Scroll down and select Admin Settings.
4. Select Admin Password.
5. Select Register.
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You see a screen like this:

6. Use the displayed keyboard to enter a password and press .

7. Enter your password again to confirm.

8. Select OK.

9. Select Lock Setting and select On.

When the control panel is locked, you must enter the password to access any of the locked settings.

Note: If you forget your password, contact Epson for assistance.

Entering Characters on the LCD Screen
Using Copy, Fax, and Scan Presets

Parent topic: Using the Control Panel

Related tasks
Setting User Feature Restrictions (Access Control)

21



Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings.

« To move the cursor, selectl - |or| > |

» To change the case of letters, select lil
* To delete the previous character, select E
* To enter numbers or symbols, select m

* To enter a space, select El

» To change the keyboard layout, select .
Parent topic: Setting a Password and Locking the Control Panel
Using Copy, Fax, and Scan Presets
You can save frequently used copy, fax, and scan settings as presets. This lets you easily reuse them
whenever necessary.

Note: Presets can be locked by an administrator. If you cannot access or change presets, contact your
administrator for assistance.

1. Press the f home button, if necessary.
2. Select Presets. Enter the Administrator password, if necessary.
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You see a screen like this:

+ Pressis I
 fuld Hew |
Aol Henw |

Al New |

fald Hew Hii

3. Select Add New.
4. Select the function for which you want to set up a preset.

A
I

You see the main screen for that function, such as the Copy screen:

B cony [ =17
EH Layout ['Ug':lﬁm poples

#ith Border

5. Select the settings you want to save and select Save.
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You see a screen like this:

6. Use the displayed keyboard to enter a name for the preset and press .

7. Select Save.

When you want to copy, fax, or scan using presets, select Presets and select your preset from the list.
Parent topic: Setting a Password and Locking the Control Panel

Related tasks
Entering Characters on the LCD Screen

Setting User Feature Restrictions (Access Control)

Using Web Config Access Control Settings, you can restrict product features for individual users to
prevent misuse of the product. Restricted features require the user to enter an ID and password on the
product control panel.

After you set up feature restrictions in Web Config, you must enable them using the product control
panel, as described here.

Note: For more information on administration settings, see the Administrator's Guide.

1. Press the f home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

I
Print Status Sheet |
. Retwark Shalus ]

Scroll down and select System Administration.

Scroll down and select Security Settings.

Select Access Control.

Select On.

Select whether Jobs Without Authentication are Allowed or Not Allowed.

No o bk o

Parent topic: Using the Control Panel

Related tasks

Setting a Password and Locking the Control Panel
Entering a User ID and Password for Printing

Entering a User ID and Password for Scanning - Windows

Changing LCD Screen Language

You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

. Retwark Stalus

I
Print Status Sheet |
l

Scroll down and select System Administration.
Select Common Settings.
Scroll down and select Language.

o o bk w

Select a language.
Parent topic: Using the Control Panel

Adjusting Control Panel Sounds

You can adjust the sound level heard when you press buttons on the control panel.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the % home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

I
Print Status Sheet |
. Retwark Shalus ]

Scroll down and select System Administration.
Select Common Settings.

Select Sound.

Select Button Press.

Press E to decrease or E to increase the sound.
Select OK to exit.

® N O 0 b~ w

Note: You can also adjust the Sound Type and the sound level for various product functions.
Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the M home button, if necessary.
2. Select Setup.
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You see a screen like this:

[ Ink Levels I
MaTenanpe | |

Faper Selup ]
Print Status Sheet |
. Retwark Shalus ]l:

Scroll down and select System Administration.
Select Common Settings.
Select LCD Brightness.

Adjust the screen brightness by selecting a brightness level or by pressing the left or right arrow
button.

7. Select OK to exit.
Parent topic: Using the Control Panel

o o bk w

Turning Off the Operation Time Out Setting

The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes
of inactivity. This feature is enabled by default, but you can turn it off.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

. Retwark Stalus

I
Print Status Sheet |
l

Scroll down and select System Administration.
Select Common Settings.

Scroll down and select Operation Time Out.
Select Off.

Parent topic: Using the Control Panel

o o kW

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
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Product Parts - Front

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use
these codes to locate and correct the problem.

ADF cover (F)

ADF edge guides

ADF input tray (F)

ADF output tray

Front paper feed slot edge guides
Front paper feed slot (B2)

o o0~ WDN -
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7  Paper cassette 1 (C1)

8  Paper cassettes 2 and 3 (C2 and C3; optional)

Rear paper feed edge guides
Paper support and extension
Rear paper feed slot (B1)
Feeder guard

Output tray

o 0o WN -

Paper cassette edge guides
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7 Paper cassette
Parent topic: Product Parts Locations

Product Parts - Inside

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use
these codes to locate and correct the problem.

=S

R

1 Document cover
2  Scanner glass
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Control panel

USB Type A port for external devices
Print head

Front cover (A)

N O o W

NFC (Near Field Communications) tag

Parent topic: Product Parts Locations

Product Parts - Back

Certain parts are labeled with a letter and number code. If you encounter any paper jams or errors, use
these codes to locate and correct the problem.

1 Rear cover 2 (D2)
2 ACinlet
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Rear cover 1 (D1)

Paper cassette rear cover (E)

Service USB port (do not remove sticker)
LINE port

EXT port

LAN port

USB port

© 00 N OO o~ W

Parent topic: Product Parts Locations

Using Eco Mode and Other Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Eco Mode Settings
Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

Parent topic: Product Basics

Changing the Eco Mode Settings
You can use the product's control panel to change the Eco Mode settings.
Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in the Common Settings
menu. If you turn on Eco Mode, 2-sided copying is selected by default. The Eco Mode setting can be
locked by an administrator. If you cannot access or change this setting, contact your administrator for
assistance.
1. Press the f home button, if necessary.
2. Select Eco Mode. Enter the administrator password, if necessary.

34



You see a screen like this:

== Eco Mode

P )

L o

Sleep Timer

3. Select On.

4. Select Configure.

5. Change any settings as necessary.

6. Select OK to exit.

Parent topic: Using Eco Mode and Other Power Saving Settings
Related tasks

Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

Changing the Sleep Timer Settings

You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance. The Sleep Timer setting in Eco Mode overrides this Sleep
Timer setting.

Press the M home button, if necessary.

Select Setup.

Scroll down and select System Administration. Enter the administrator password, if necessary.
Select Common Settings.

ok~ wbd -~

Select Sleep Timer.
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You see a screen like this:

Bt Sleep Timer

B

(1-FA0minaalEs)

6. Do one of the following:
* Press the — or + icons to reduce or increase the number of minutes.

* Press the number of minutes on the LCD screen, select the number of minutes from the on-screen
keypad, and press .

7. Select OK.

Parent topic: Using Eco Mode and Other Power Saving Settings
Related tasks
Changing the Eco Mode Settings

Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.
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You see a screen like this:

;' Ink Levels I
I MaTenanpe | |

| Faper Selup ]

| Print Status Sheet |

!. Retwark Shalus ]lﬂ

Scroll down and select System Administration. Enter the administrator password, if necessary.
Select Common Settings.

Select Power Off Timer.
Select a time period between 30minutes and 12h (12 hours).
Parent topic: Using Eco Mode and Other Power Saving Settings

o o AW

Epson Connect Solutions for Smartphones, Tablets, and More

You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print from
anywhere: Epson Email Print, Epson iPrint Mobile App, Epson Remote Print, and Epson Scan to Cloud.

Using Epson Email Print

Using the Epson iPrint Mobile App
Using Epson Remote Print

Using Epson Scan to Cloud

Parent topic: Product Basics

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product.

1. Set up your product for network printing. See the link below.
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If you did not already set up Email Print when you installed your product software, visit
epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup
instructions.

Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your Epson Connect account.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network. You can even scan and save a file on your device, send it as an email, or upload it to an online
service such as Box, Dropbox, Evernote, or Google Drive.

1.
2.

3,
4.
5,

Set up your product on a network. See the link below.

Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

Download Epson iPrint from the Apple App Store or Google Play.
Connect your mobile device to the same wireless network that your product is using.
Print from your mobile device to your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print

With Epson Remote Print software, you can print to an Epson Email-enabled product anywhere in the
world.

1.
2.
3.

Set up your product for network printing. See the link below.
Visit epson.com/connect to learn more about Remote Print and how to download the software.
Download and install the Remote Print software.
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4. Obtain the email address and optional access key of the Epson product you want to use for printing,
and enter this address during Remote Print setup.

5. Select the print command in your application and choose the Remote Print driver for your Epson
product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service sends your scanned files to a destination that you have registered with
Epson Connect.

1. Set up your product for network scanning. See the link below.

2. Visit epson.com/connect for instructions on registering an account and your product with Epson
Connect.

3. After registering, sign in to the Epson Connect web page with the email address and password you
selected.

4. Select Destination List for Scan to Cloud.
Click Add, then follow the instructions on the screen to create your destination list.

6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control
panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X.

AirPrint
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Load paper in your product.
Set up your product for wireless printing. See the link below.
Connect your Apple device to the same wireless network that your product is using.

b~

Print from your device to your product.
Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

Connect your device to the same network that your Epson product is using.
Print a network status sheet.

Locate your product's IP address on the network status sheet.

Enter the IP address into the address bar of a web browser.

o kw0~

Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

Click Register.

Select the checkbox to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.
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9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson product is connected to your wireless network before starting the Google
Cloud Print setup.

1. Turn on your Chromebook and connect it to the same wireless network as your product.
Note: See your Chromebook's documentation for details on connecting to a network.

2. Do one of the following:

+ Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
+ If you see a registration confirmation screen instead, click Register.

3. Click Add Device.

4. Click the Register button that appears next to your product.
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5. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

6. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
iPhone, or Android phone with Internet access. For more information on using Google Cloud Print,
visit Epson Support.

Parent topic: Using Google Cloud Print

Related topics
Wi-Fi or Wired Networking

Printing and Scanning with NFC from Your Android Device

You can easily connect your Android 4.0 or later device to your product using NFC (Near Field
Communication). Once connected, you can print and scan using Epson iPrint.

1. Make sure Epson iPrint is installed on your mobile device.

2. Make sure Simple AP mode is enabled on your printer and that you are using the default Wi-Fi Direct
password.

Note: NFC printing and scanning will not work if you changed the Wi-Fi Direct password from the
default.

3. Do one of the following:
+ If you are going to print, make sure paper is loaded in the product.
+ If you are going to scan, place your original on the product for scanning.
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4. Touch the NFC antenna of your mobile device to the NFC tag on your product.

Note: If you do not see the NFC logo on your product, your administrator may have disabled NFC.
The location of your mobile device's NFC antenna varies. See your mobile device documentation for
more details.

Epson iPrint opens.

Note: If you do not have Epson iPrint installed, the app store page for the Epson iPrint app opens.
Install Epson iPrint and repeat this step.

5. Touch the NFC antenna of your mobile device to the product NFC tag on your product again.
The printer and mobile device connect.

Note: If the mobile device and product disconnect, try to print or scan a document. The mobile
device and product should reconnect automatically.

6. If you are going to print, open the file you want to print in Epson iPrint.
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7. Touch the NFC antenna of your mobile device to the NFC tag on your product to start printing or
scanning.

Parent topic: Product Basics
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet
Configuring Email Server Settings
Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
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Wireless router or access point
Computer with a wireless interface
Computer

Internet

o o0~ W DN

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software by downloading it from the Epson website. The installer program guides you
through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

1. Press the f home button, if necessary.

Press -

3. Select Setup.
You see a screen like this:

Hetwork Scitings

WE=Fi Setup

=k i el Sedup
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4. Select Wi-Fi Setup.
You see a screen like this:

=) Wi=Fi Setup ||
. '
Wi-Fi Sedup Wizard |
Push Budton Setup (WFS)
PIH Code Setup (WPS) u
¥

5. Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired
network connection in this guide.

6. Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, select Other Networks and select the
Network (SSID) field. Use the displayed keypad to enter your network name.

7. Select the Password field and enter your wireless password using the displayed keypad.
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Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

* Press E or El to move the cursor.

* Press E to change the case of letters.

* Press ::I to delete the previous character.
* Press to enter numbers and symbols.
* Press El to enter a space.

* Press to change the keyboard layout.

8. When you finish entering your password, press and select Proceed.
9. Confirm the displayed network settings and select OK to save them.

Note: If you need to change a setting, press the 3 back button.

10. If you want to print a network setup report, press one of the <& buttons. (Otherwise, select Done.)
11. Press the M home button to exit.
Your product should now be connected to the network.

Note: If the Wi-Fi connection symbol isn't lit or doesn't appear on the LCD screen, you may have
selected the wrong network name or entered the password incorrectly. Repeat these steps to try
again.

Parent topic: Wi-Fi Infrastructure Mode Setup

Related references
Status Icon Information

Related tasks
Entering Characters on the LCD Screen
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Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

LM (s

1 Epson product
2  Computer with a wireless interface
3  Other wireless device

You can select one of these modes to communicate with your computer or device:

Access point mode
The product itself acts as the network access point for up to 4 devices. When operating in this mode,
your product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
The product communicates one-to-one with another Wi-Fi Direct capable device. When operating in
this mode, your product displays a Direct or D connection symbol on the LCD screen.

To disconnect a peer-to-peer mode connection, release the connection to your product from your
computer or other device.

To enable peer-to-peer mode, you must select it from the Web Config Utility, under WiFi/Network
Settings > Services > Wi-Fi Direct.

Enabling Wi-Fi Direct Mode
Changing the Wi-Fi Direct Password

Parent topic: Wi-Fi or Wired Networking
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Related references
Status Icon Information

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Press the f home button, if necessary.

2. Press -

3. Select Setup.
You see a screen like this:

Hetwork Scitings

W=Fi Setup

=k 1 D Selup

4. Select Wi-Fi Direct Setup.
5. Select Connection Setup.
6. To enable Wi-Fi Direct using the default password, select Proceed.

Note: You can change the Wi-Fi Direct password, but you will no longer be able to use NFC to
connect to the product.
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The product sets up the network and displays the Wi-Fi network name (SSID) and password. You
see a screen like this:

&) Wi-Fi Direct Setup

Connecting via Wi-Fi Cirect
:ct the Wi-Fi
1} below 1o
eslablish a connection
1o ks peinter.

7. Scroll down to view the SSID and password.

8. Use your computer or wireless device to select the SSID displayed on the LCD screen, then enter
the password shown.

9. Press the M home button to exit.

You see either an AP or Direct connection symbol on the LCD screen and should be able to print
directly to your product from your computer or device.

Note: If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode
is not enabled. Repeat these steps to try again.
Parent topic: Wi-Fi Direct Mode Setup

Related references
Status Icon Information

Changing the Wi-Fi Direct Password

You can change the Wi-Fi Direct password from the default to improve the security of your Wi-Fi Direct
connections.

Note: If you change the Wi-Fi Direct password, you cannot use the built-in NFC functionality to connect
to the product. If you have already connected devices or computers to your product via Wi-Fi Direct, they
are disconnected when you change the password.

1. Press the M home button, if necessary.
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Press -

Select Setup.
You see a screen like this:

Hetwork Seitings
|

Wi=F i Sediup
|

I

=k 1 et Selup

Select Wi-Fi Direct Setup.

Select Connection Setup.

To change the Wi-Fi Direct password, select Change Password and select Yes.
Enter your new Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.

* Press II' or El to move the cursor.

* Press EI to change the case of letters.
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* Press ::I to delete the previous character.
* Press to enter numbers and symbols.
* Press El to enter a space.

* Press to change the keyboard layout.

8. When you finish entering your password, press and select Proceed.
You see a screen like this:

i) Wi=Fi Darect Setup

Cancel

9. Scroll down to view the Wi-Fi network name (SSID) and password.

10. Use your computer or wireless device to select the SSID displayed on the LCD screen, then enter
the password shown.

11. Press the M home button to exit.

You see either an AP or Direct connection symbol on the LCD screen and should be able to print
directly to your product from your computer or device.

Note: If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode
is not enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Related tasks
Entering Characters on the LCD Screen
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Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the M home button, if necessary.

2. Press -

3. Select Setup.
4. Select Wi-Fi Setup.
You see a screen like this:

&) Wi=Fl Setup
'
Wi-Fi Sedup Wizard |
Push Bution Setup (WPS)
i
FIH Code Setup (RS l-ﬂ

5. Select Push Button Setup (WPS).
Follow the instructions on the LCD screen to complete WPS setup.
Press the M home button.
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If the network connection is successful, the Wi-Fi icon in the upper-right corner of the LCD screen is
lit as shown.

L Fi_'l'-_-_' &l

Copy Scin X Preseis

EJ-!-*

Tl—ﬁ_'

Note: If you do not see a lit Wi-Fi icon, repeat these steps.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the f home button, if necessary.

2. Select Setup.
You see a screen like this:

§T Setup

[ Ink Levels I
MaiTennnpe | |

Paper Selup

J
Frint Status Sheet |
. Retwark Shalus ]

3. Select Network Status.
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4. Select Print Status Sheet.

5. Press one of the < buttons to print the network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Configuring Email Server Settings

To use features such as scanning to email or forwarding faxes to email, you need to configure the email
server. You can select settings for the email server using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

U ok Levels &
| Maitennnne | |

! Paper Setup ]
| Frint Status Sheed |
.. Hetwark Stalus ll:

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Network Settings > Advanced Setup > Email Server > Server Settings.
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You see a screen like this:

k!t Aauthendication Method

off ]
| o POP before SMTP |
| SMIP-AUTH ]

5. Select one of the options shown above, then select the settings you want to use. Contact your
internet service provider, if necessary, to confirm the authentication method for the email server.

6. Select OK to save the settings and select Done to exit.
7. Select Connection Check to verify the connection to the email server.
Parent topic: Wi-Fi or Wired Networking

Related tasks
Scanning to Email
Forwarding Received Faxes

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking
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Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on the Web Config utility see the Administrator's Guide.

Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.

3. On acomputer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Product Software - Windows

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

1. Disable your product's Wi-Fi features.
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Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.
If you see a Select Setup Option screen, select Set up printer for the first time.

© o N OOk Wb

Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections

Related tasks
Disabling Wi-Fi Features
Uninstalling Product Software - Windows

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
* Windows: Uninstall your product software.
+ OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Product Software - Windows

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.
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Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the M home button, if necessary.

Press -

Select Setup.
Select Wi-Fi Setup.
You see this screen:

oD

i) Wi=Fi Setup

&
Wi-Fi Selup Wizard I

Push Butfon Setup (WFS) |
FIH Codde Setup (WES) | "

5. Scroll down and select Disable Wi-Fi.
6. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing
Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.
To download the Epson Universal Print Driver or PostScript drivers, go to epson.com/support/wf6590.

Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PS3 (PostScript) Status Sheet

Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

. Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

§T Setup

;' K et &
Ml ennnpe | |
| ee———

Faper Selup ]
|

Print Status Sheet |

| Retwork Stalus ]lﬂ

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
. Select Universal Print Settings.
5. Select PDL Print Configuration.
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You see a screen like this:

Bt POL Print Condlguration

;. Conmnon Setlings |I
e ——
Pl Menu |
|

P53 Miemu

6. Select one of the options shown above, then select the settings you want to use.

7. When you are finished, press the A home button to exit.

PDL Print Configuration Options

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

PDL Print Configuration Options

Select the PDL Print Configuration options you want to use for PCL or PostScript printing.

PDL Print Configuration
option

Available
settings

Description

Common Settings

Paper Size Various sizes Sets the default paper size for PCL or PostScript
printing.
Paper Type Various paper Sets the default paper type for PCL or PostScript
types printing.
Orientation Portrait Sets the default orientation for PCL or PostScript
printing.
Landscape
Quality Draft Sets the quality for PCL or PostScript printing.
Standard
Best
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PDL Print Configuration

Available

Description

option settings
Ink Save Mode On/Off Saves ink by reducing print density.
Print Order Last Page on Starts printing from the first page of a file.

Top

First Page on
Top

Starts printing from the last page of a file.

Number of Copies 1 to 999 Selects the number of copies to print.

Binding Margin Left Edge Specifies the binding edge for double-sided documents.
Top Edge

Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job.

2-Sided Printing On/Off Selects duplex printing.

PCL Menu

Font Source Resident Uses a font preinstalled on the product.
Download Uses a font you have downloaded.

Font Number 1to 111 Selects the default font number for the default font

source.

Pitch

0.44 to 99.99 cpi

Selects the default font pitch if the font is scalable and
fixed-pitch (availability depends on font source and
number settings).

Height

4.00 t0 999.75 pt

Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings).

Symbol Set

Various

Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).
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PDL Print Configuration

Available

Description

option settings
Form 510 128 lines Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the product. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.
CR Function CR Selects the line feed command when printing with a
CR+LF driver from a specific operating system.
LF Function LF
CR+LF
Paper Source Assign 4 Makes the paper source select command compatible
with HP LaserJet 4
4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000
58 Makes the paper source select command compatible
with HP LaserJet 5S
PS3 Menu
Error Sheet On/Off Prints a sheet showing the status when errors occur
during PostScript or PDF printing.
Coloration Color Selects the color mode for PostScript printing.
Mono
Binary On/Off Enable when printing files that contain binary images

(available when the product is connected to the
network). Allows you to print binary images even if the
driver is set to ASCII.

PDF Page Size

Various sizes

Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings




Selecting Printer Language and Interface Settings
You can select printer language and interface settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

T &

Paper Selup

| Metwark Stalus Y

I
Frint Status Sheet |
|

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Printer Settings.
You see a screen like this:

&1 Printer Settings

 Paper Source Setiings ] A

LIGE 1#F Timedut Setfing | |

Printing Lanquage
futo Errce Solver I

. Memory Device Inferfooe ] ¥
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5. Select the Printing Language and other settings you want to use.

6. When you are finished, press the f home button to return to the Home screen.

Printer Language and Interface Options

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printer Language and Interface Options

Select the settings you want to use.

Printer Settings option

Available
settings

Description

USB I/F Timeout Setting [ 0.5 to 300 Specify the length of time before ending USB
seconds communication from a computer using the PCL or
PostScript driver. This setting is necessary to avoid
endless USB communication.
Printing Language Auto Select the language for the USB or network interface.
PCL
PS3
PDF
PC Connection via USB | Enable Select whether to allow USB communication with the
Disable product.

Parent topic: Selecting Printer Language and Interface Settings

Printing a PS3 (PostScript) Status Sheet

You can print a PS3 (PostScript) status sheet to confirm the current font information and PostScript

printing software version.

1. Press the M home button, if necessary.

2. Select Setup.
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You see a screen like this:

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheet |
. Retwark Stalus ] ¥

3. Select Print Status Sheet.
4. Select PS3 Status Sheet.
5. Press one of the < buttons to print the status sheet.

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing
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Loading Paper

Before you print, load paper for the type of printing you will do.
Note: Load only plain paper when printing with the PCL or PostScript (PS3) printer software.

Loading Paper in the Cassette

Loading Paper and Envelopes in the Rear Paper Feed Slot
Loading Paper in the Front Paper Feed Slot

Paper Loading Capacity

Available Epson Papers

Paper or Media Type Settings - Printing Software

Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Loading Paper in the Cassette
You can load paper up to this size in the paper cassette: Legal (8.5 x 14 inches [216 x 356 mm]).
1. Make sure the product is not operating and pull out the paper cassette.
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2. Pinch and slide the front edge guide outward all the way, then pinch and slide the side edge guides
to the marker for the paper size you are using.

1 Paper size marker
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3. Load paper with the printable side facedown and slide the front edge guide to the marker for the
paper size you are using.

Note: Make sure the paper fits beneath the arrow mark inside the edge guides.

)

1 Paper size marker

4. Make sure the paper size label matches the size of the paper loaded in the paper cassette. If
necessary, remove the label holder, change the paper size indicated on the label, and replace the

label holder.
\]
=

5. Insert the paper cassette all the way into the product.
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6. Extend the output tray and flip open the paper stopper.

N—

7. Select the size and type of paper you loaded on the product LCD screen.
Always follow these paper loading guidelines:

* Load only the recommended number of sheets.

* Load paper short edge first, no matter which way your document faces.
» Load the printable side facedown.

* Load letterhead or pre-printed paper top edge first.

* Do not load paper above the arrow mark inside the edge guides.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper and Envelopes in the Rear Paper Feed Slot
Loading Paper in the Front Paper Feed Slot

Loading Paper and Envelopes in the Rear Paper Feed Slot
You can print on envelopes or paper in a variety of types and sizes in the rear paper feed slot.
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1. Flip the feeder guard forward and pull up the paper support and extension.

-

o, 8 —

o =

\_

2. Slide the edge guides outward.

-
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3. Ifyou are inserting a stack of paper, fan the sheets and tap the stack on a flat surface to even the
edges.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do not
select automatic 2-sided printing for this type of paper.

000000006 )

I I 000000000000

000000000000
000000000000

4. Do one of the following:
* Insert paper, glossy or printable side up and short edge first, in the center of the slot.

-

Caution: To prevent paper feeding problems, make sure you do not load paper above the arrow
marks inside the edge guides.

73



» Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the
center of the slot.

7D

—

5. Slide the edge guides against the paper or envelope, but not too tightly.

Lk

6. Extend the output tray and flip open the paper stopper.

N—

S

7. Select the size and type of paper you loaded on the product LCD screen.
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Always follow these paper loading guidelines:

* Load only the recommended number of sheets.

» Load paper short edge first, no matter which way your document faces.
» Load the printable side faceup.

» Load letterhead or pre-printed paper top edge first.

* Do not load paper above the arrow mark inside the edge guides.

 If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

« If print quality declines when printing multiple envelopes, try loading one envelope at a time.
» Do not load envelopes that are curled, folded, or too thin.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in the Cassette

Loading Paper in the Front Paper Feed Slot

Loading Paper in the Front Paper Feed Slot

You can load one sheet of paper in the front paper feed slot.

Note: You cannot load paper while printing from the front paper feed slot. Paper that is too stiff may not
load correctly even if it meets the paper thickness specifications.
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1. Extend the output tray and flip open the paper stopper.

L

2. Slide the edge guides to the paper size you are using.

jp%‘ =

3. Insert the paper with the printable side facedown until the product pulls it in partially.
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Note: Keep the paper straight to prevent it from loading at an angle.

4. Select the size and type of paper you loaded on the product LCD screen.

Always follow these paper loading guidelines:

* Load only one sheet at a time.

» Load paper short edge first, no matter which way your document faces.

» Load the printable side facedown.

* Load letterhead or pre-printed paper top edge first.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity

Paper Specifications

Related tasks

Loading Paper and Envelopes in the Rear Paper Feed Slot

Loading Paper in the Cassette

Paper Loading Capacity

Paper cassette and rear paper feed slot

Paper type

Loading capacity

Size

Paper cassette

Rear paper feed
slot

Plain paper’

Letter (8.5 x 11 inches
[216 x 279 mm])

A4 (8.3 x 11.7 inches
[210 x 297 mm])

Legal (8.5 x 14 inches
[216 x 356 mm])

Up to the arrow
mark

80 sheets
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Paper type

Loading capacity

Size

Paper cassette

Rear paper feed
slot

Plain paper

User defined from

2.17 x 5iinches (55 x 127 mm)
to 4.13 x 5.83 inches (105 x
148 mm)

1 sheet

User defined from 4.13 x

5.83 inches (105 x 148 mm) to
8.5 x 14 inches (215.9 x
355.6 mm)?

80 sheets

User defined from 8.5 x

14 inches (215.9 x 355.6 mm) to
8.5 x47.2 inches (215.9 x

1200 mm)

1 sheet

Epson Bright White Paper’

Letter (8.5 x 11 inches
[216 x 279 mm])

A4 (8.3 x 11.7 inches
[210 x 297 mm])

400 sheets

50 sheets

Epson Presentation Paper
Matte

Epson Premium
Presentation Paper Matte

Epson Premium
Presentation Paper Matte
Double-sided

Epson Photo Paper
Glossy

Epson Premium Photo
Paper Glossy

Epson Premium Photo
Paper Semi-gloss

Epson Ultra Premium
Photo Paper Glossy

Letter (8.5 x 11 inches
[216 x 279 mm]) size and
smaller

20 sheets
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Paper type

Loading capacity

Size Paper cassette Rear paper feed

slot

Thick paper (cardstock up
to 68 Ib [256 g/m?))

Letter (8.5 x 11 inches —
[216 x 279 mm])

A4 (8.3 x 11.7 inches
[210 x 297 mm])

10 sheets®

Envelopes

No. 10 (4.1 x 9.5 inches —
[105 % 241 mm])

10 envelopes

' You can print 2-sided print jobs automatically or manually using the paper cassette. When you use the
rear paper feed slot, you can only print 2-sided print jobs manually. Load up to 30 sheets for manual 2-

sided print jobs.

2You can print 2-sided print jobs manually only in the rear paper feed slot. Load up to 30 sheets for

manual 2-sided print jobs.

*You can load up to 5 sheets for manual 2-sided print jobs.

Front paper feed slot

Paper type

Loading capacity

Size

Front paper feed slot

Plain paper

Letter (8.5 x 11 inches [216 x 279 mm])
A4 (8.3 x 11.7 inches [210 x 297 mm])
Legal (8.5 x 14 inches [216 x 356 mm])

User defined from 4.13 x 5.83 inches (105
x 148 mm) to 8.5 x 14 (215.9 x 355.6 mm)
inches

1 sheet

Epson Bright White Paper

Letter (8.5 x 11 inches [216 x 279 mm])
A4 (8.3 x 11.7 inches [210 x 297 mm])

1 sheet

Parent topic: Loading Paper
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Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Paper Type Size Part number Sheet count

Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])

Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])

Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50

Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mm]) 5042180 100

Epson Premium Presentation Letter (8.5 x 11 inches S041568 50

Paper Matte Double-sided [216 x 279 mm])

Epson Photo Paper Glossy 4 x 6inches (102 x 152 mm) | S041809 50

S042038 100
Letter (8.5 x 11 inches S041141 20
[216 > 279 mm]) S041649 50
S041271 100

Epson Premium Photo Paper 4 x 6inches (102 x 152 mm) | S041808 40

Glossy S041727 100
16:9 wide (4 x 7.1 inches S042109 20
[102 x 181 mm])
5x 7 inches (127 x 178 mm) | S041464 20
8 x 10 inches (203 x 254 mm) | S041465 20
Letter (8.5 x 11 inches S042183 25
[216 > 279 mm]) S041667 50
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Paper Type Size Part number Sheet count
Epson Ultra Premium Photo Paper |4 x 6 inches (102 x 152 mm) | S042181 60
Glossy S042174 100

5x 7 inches (127 x 178 mm) | S041945 20

8 x 10 inches (203 x 254 mm) | S041946 20

Letter (8.5 x 11 inches S042182 25

[216 x 279 mm]) S042175 50
Epson Premium Photo Paper 4 x 6 inches (102 x 152 mm) | S041982 40
Semi-gloss Letter (8.5 x 11 inches S041331 20

[216 x 279 mm])

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

For this paper

Select this paper Type or Media Type setting

Plain paper
Epson Bright White Paper

Plain Paper / Bright White Paper

Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope

Epson Ultra Premium Photo Paper Glossy

Ultra Premium Photo Paper Glossy

Epson Premium Photo Paper Glossy

Premium Photo Paper Glossy

Epson Photo Paper Glossy

Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss

Premium Photo Paper Semi-Gloss
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For this paper Select this paper Type or Media Type setting

Epson Presentation Paper Matte Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Thick paper (cardstock up to 68 Ib [256 g/m?]) Card Stock

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the
product.

1. Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

;' K et &
| Maitennnne | |

l
| Paper Selup

; Print Status Sheet

S S

=

.. Hetwark Stalus

3. Select Paper Setup.
4. Select the paper source you want to change.
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You see a screen like this:

= Paper Cazzatle

| Paper Slze |

I
Paper Type I
_|

[—————

L

Select Paper Size.

Select the paper size you loaded.

Select Paper Type.

Select the paper type you loaded.

9. Select OK.

10. Select another paper source to change or press M home to return to exit.

© N o o

Paper Type Settings - Control Panel
Parent topic: Loading Paper

Paper Type Settings - Control Panel

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper

Epson Bright White Paper

Letterhead paper Letterhead
Recycled paper Recycled

Color paper Color

Preprinted paper Preprinted
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Paper type loaded Paper Type setting

Envelopes Envelope

Epson Ultra Premium Photo Paper Glossy Ultra Glossy
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Photo Paper Glossy Glossy

Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Presentation Paper Matte Prem. Matte

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Thick paper (cardstock up to 68 Ib [256 g/m?]) Card Stock

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator
As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Default Printer Settings - Control Panel
Setting the Universal Print Settings

Parent topic: Loading Paper

Selecting the Default Printer Settings - Control Panel

You can change default printer settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.
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You see a screen like this:

[ Ink Levels I

Paper Setup

I
Print Status Sheet |
l

' Melwark Stalus y

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
You see a screen like this:

B System Adsinistration

| Printer Settings Jlall
I: Common Selings ] I

Metwork Seltings |

[ Epsoa Connect Sendces ]

'_: Googke: Clowd Print Services ]d

4. Select Printer Settings.
5. Select the Paper Source Settings options you want to use.
6. Select one of these Auto Error Solver options:

» Turn on this setting to display a warning and print single-sided when a 2-sided printing error
occurs, or to print only what the product could process when a memory full error occurs.

» Turn off this setting to display an error message and stop printing if an error occurs.
7. When you are finished, press the A home button to exit.
Paper Source Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
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Paper Source Settings Options

Select the paper source options you want to use for your printed jobs.

Paper Source
Settings option

Available settings

Description

Rear Paper Feed [ Normal Select Normal to give printing priority to paper loaded in the
Priority Last rear paper feed slot.
Ad4/Letter Auto On Select On to switch the selected paper size to match the
Switching Off loaded paper (Letter or A4) if the wrong size is selected.
Auto Select Copy Select On for any of these settings to automatically print on
Settings Fax paper from any source containing paper that matches your
paper settings.
Other

Error Notice

Paper Size Notice

Paper Type Notice

Select On for either of these settings to display an error
message when the selected paper type or size does not
match the loaded paper.

Parent topic: Selecting the Default Printer Settings - Control Panel

Setting the Universal Print Settings

You can change the default universal print settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the f home button, if necessary.

2. Select Setup.
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You see this screen:

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheet |
. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
You see this screen:

B System Adsinistration

| Printer Settings |
| Comson Settings | I
| etwork Setlings |

| Epson Connect Services
| Google Cloud Print Services ¥

4. Select Universal Print Settings.

5. Adjust the settings as necessary.

6. When you are finished, press the A home button to exit.

Universal Print Settings Options

Parent topic: Selecting Default Paper Settings - Administrator
Universal Print Settings Options

Select the universal print setting options you want to use for your printed jobs.
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Universal Print
Settings option

Available settings

Description

Top Offset

Left Offset

Adjust the top or left margin.

Top Offset in
Back

Left Offset in
Back

Adjust the top or left margin of the back page when
performing double-sided printing.

Check Paper On Select On to check the paper width before printing. This
Width Off prevents printing beyond the edges of the paper when the
paper size settings are incorrect, but may reduce the print
speed.
Dry Time Standard Select the ink drying time you want to use when printing
Long double-sided.
Longer
Skip Blank Page [On Select On to skip printing of blank pages automatically.
Off

Parent topic: Setting the Universal Print Settings
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Installing the Optional Paper Cassette Units

You can install up to two optional paper cassette units to provide more paper capacity.
1. Turn off the product, unplug the power cord, and disconnect any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.
2. Uninstall any optional cassette units already installed on the product.

Note: To uninstall any optional cassette units, turn off the product, unplug the power cord,
disconnect any cables, and follow the rest of these instructions in reverse.

3. Remove the paper cassette unit from its packaging and remove any protective materials.
Make sure you have all the items shown here:
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5. Remove the output tray and paper cassette from the product.

6. Remove the paper cassette from the optional paper cassette unit.
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7. Stack all optional paper cassette units on top of each other and secure them to each other with the
included screws.
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8. Lift up your product and gently lower it onto the paper cassette unit with the corners aligned. Secure
the product to the paper cassette unit with the included screws using a screwdriver.
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Warning: To lift the product, have two people hold it as shown here. Lifting from other areas may
cause the product to fall or cause you to pinch your fingers when placing the product down.

9. Secure the back of the paper cassette units to each other and to the product using the included
brackets and screws.

10. Insert a label into the holder indicating the paper size to be loaded in each paper cassette.

SvY
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11. Place the correct sticker on each cassette unit to indicate the cassette number.
12. Connect the power cord and other interface cables, then plug in the product.
13. Turn on the product.

14. Pull out and reinsert the paper cassette in each optional paper cassette unit to confirm the cassette
unit is displayed on the Paper Setup screen.

15. Enable the optional paper cassette units in the printer software.

Enabling the Optional Paper Cassettes - Windows

Enabling the Optional Paper Cassettes - OS X

Related tasks

Enabling the Optional Paper Cassettes - Windows

Enabling the Optional Paper Cassettes - OS X

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X

Enabling the Optional Paper Cassettes - Windows
You need to enable the optional paper cassette units before you can use them with the printer software.

Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the
sections covering that software in this manual to enable the optional cassette units.

1. Do one of the following:

* Windows 10: Right-click E and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E’ and select Devices and Printers. Right-click your printer name and select
Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your printer name and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.
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2. Click the Optional Settings tab.
You see a window like this:

L] EPSOM Universal Print Dviver Properties H

Gonersl | Sharegy | Ports | Advonced | Color Maragement | Securty  Ortonal Seftings  Verser Infaemation

% Prinvter Usiity

%ﬂ_ Metwork printer seanch
h

'_‘h Briver Settrgs

Correns Previey [ndarmate

Perner Ty A
Eriched Primley & Aogure Som Printer Get
WS | Oniy Opdoral Indformabion

Prinder Mok
AdfLetter Colw [Suandard Remsiston 600 .

Defaudy of Privier Contrad Language Hurrnaal Settre

Prerner Infirmanen

0K Cancel . el

3. Make sure Acquire from Printer is selected, then click Get.
The optional paper sources are listed in the Current Printer Information section.
4. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Installing the Optional Paper Cassette Units

Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
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Enabling the Optional Paper Cassettes - OS X

You need to enable the optional paper cassette units before you can use them with the printer software.

Note: If you are using the PostScript (PS3) printer software, see the section covering that software to
enable the optional cassette units.

In the Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

Ganeral Supply Levels  LHility

To take full odvantage of your printer’s optiona, confiem that they are accurately
shown heeo. For infeamatisn on your prinfor amd ite optisnal hardware, chock the
Erintor s documadlation.

Thick paper and ervalopoes: O =]

Skip Blonk Pege:  ON =)

Qe Mogde: | Off B

Parmit temporary black printing: O B

High Spesd Printing:  On =]

Wrning Notificationa:  On B

Establish bidiroctional communications O B
Lowar Cagddtta: Cassaito 2

4. Select the number of optional cassette units installed for the Lower Cassette setting.
5. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Installing the Optional Paper Cassette Units
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Related tasks
Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X
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Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damagingit.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Legal (8.5 x 14 inches [216 x 356 mm]).
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2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

§ |

Note: You can place multiple originals on the scanner glass. Just make sure they are at least
0.8 inch (20 mm) away from each other.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the
scanner glass.

3. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product

Related topics
Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder

You can place multi-page original documents in the Automatic Document Feeder (ADF).You can also
use the ADF to scan both sides of a 2-sided document. Make sure the originals meet the Automatic
Document Feeder specifications before loading them.

Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or
other materials that could obstruct the feeder.
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1. Slide the ADF edge guide outward.

2. Fan your stack of originals and tap them gently on a flat surface to even the edges.
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3. Insert the originals into the ADF faceup and top-edge first.

The ADF icon on the control panel lights up.
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4. Slide the ADF edge guide against the originals, but not too tightly.

Parent topic: Placing Originals on the Product

Related references

Automatic Document Feeder (ADF) Specifications
Related topics

Copying

Scanning

Faxing
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Copying

See the information here to copy documents or photos using your product.
Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying Options

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.

1. Place your original document or photo on the scanner glass, or place multi-page documents in the
ADF.

2. Load the paper you want to print on.
3. Press the M home button, if necessary.
4. Select Copy.

You see a screen like this:

B Copy

7] DDEL_LI;__':N copies
Lether i

5. To print more than one copy, press a number key on the product's control panel, or select copies
and use the displayed keypad to enter the number of copies.

6. Change any of the displayed settings as necessary.
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7. Select Settings to view and change additional copy settings, if necessary. Then press the 3 back
button.

8. Select Preview to preview your copy on the LCD screen.
9. Select Preset to save your copy settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

10. When you are ready to copy, press one of the < buttons.
Note: To cancel copying, press the & Stop button or select Cancel.

Parent topic: Copying
Related references
Copying Options
Available Epson Papers

Related tasks
Using Copy, Fax, and Scan Presets

Related topics
Placing Originals on the Product
Loading Paper

Copying Options

Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.
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Copying option

Available settings

Description

Layout

With Border Leaves a small margin around the image or document
2-up Copies multiple page documents onto one sheet. Also,
4 select Settings and change the Document Orientation and
=up .
Layout Order settings as necessary.
ID Card Copies both sides of an ID card onto one side of a sheet of

paper

Document Size

Various sizes

Select the document size of your original

Paper Source

Various sources

Select the paper source that you want to use. If you select
Auto, paper is fed automatically depending on the paper
settings you selected for the paper sources.

Zoom Custom Size Automatically sizes the image by the percentage you select
Actual Size Copies at 100% size
Auto Fit Page Automatically sizes the image to fit the paper size you
selected
Letter->4x6in and Automatically converts from one size to another
other conversions
2-Sided Off Select to make 2-sided copies. When you select 1>2-Sided
- or 2>1-Sided, also select Advanced and select the binding
2>2-Sided S .
edge for your originals or copies.
1>2-Sided
2>1-Sided
Document Portrait Specifies the orientation of your originals
Orientation Landscape
Quality Text Specifies the document type of your originals and adjusts
Text(Best) the quality of your copies
Text & Image
Text & Image(Best)
Photo
Density Varying levels Adjusts the lightness or darkness of copies
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Copying option

Available settings

Description

Remove Shadow

Off

Select On to erase the shadows that appear in the center of
a document when copying a book or that appear around a

On document when copying thick paper
Remove Punch | Off Select On to erase the binding holes on a document
Holes 0
n
Collate Copy Off Select On to print multiple copies of a multi-page document
on both in order and sorted into sets
Dry Time Standard Select to adjust the drying time for 2-sided copies, if
L smudges or marks appear on the front of the paper when
ong ) ;
you print on the second side
Longer
Advanced Various settings Select advanced settings such as Saturation and
Settings Sharpness

Parent topic: Copying
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows

Printing with OS X

Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - OS X
Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Locking Printer Settings - Windows

Entering a User ID and Password for Printing

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
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1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

o Printing Preferences H

Man | Moes Opiors | Maiterance

Frimting Fresets Paper Sounoe Autn Select w
Add Flemove Presets. .. Document Sire Ltter (B 172 % 11im) L
= Document - Fagt
=| Dooument - Standard Quaslty Orientation & Portrait Lendscape
= Doasment - High Qualty
™. Dooument - 2-Sded Paper Type Plains Pageer [ Erightt White Paper -

a1F] Doacument - 248
™, Dooument - 2-Sided with 24Up Quasity Stardard ¥
3| Document - Fagt Grayacale Coor ®) Cokor Hlack Grayscle
% Document - Grayscale

2-Gded Frntrg | OFF v

E ég Ml Fage off W
Cogmes 1 . ot
C

W

of| Rty alt O gl

Quist Mode [elid W
Show Satengs Pyl Pranvigw

Job Arvange Lite
Reset Defauins Ik Liwets

0K Cancel Halp

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
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10.

11.

12.
13.
14.

15.

Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.

Select a Color option:

» To print a color document or photo, select the Color setting.

» To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.
To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the
Quiet Mode menu.

Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows

Parent topic: Printing with Windows

Related references
Paper or Media Type Settings - Printing Software
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Related tasks

Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows
Entering a User ID and Password for Printing

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Paper Cassette 2 and Paper Cassette 3 are available only if you have installed the optional
cassettes.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Paper Cassette 3
Selects the paper in cassette 3 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Front Paper Feed Slot
Selects the paper in the front feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.

Draft

For draft printing on plain paper.
Standard

For everyday text and image printing.

Standard - Vivid
For text and graphics with good quality and print speed.
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High
For photos and graphics with high print quality.

More Settings
Opens a window that lets you choose among levels of speed and quality.

Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing | Off W

1. Select one of the following options for 2-Sided Printing:

+ Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

» Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

2. Click the Settings button.
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You see this window:

2-Sided Printing Settings
Binding Edge
eleft ~ Top -~ Right
= iong-edge: ' Shart-edge * Long-edge
=== — S
Binding Margin
Front Page 0.00 & [0.00... 1.18]
Back Page 0.00 = [0.00... 1.18]
Linit ) mm ®inch
Start Page
(®) From Front
(") From Back
Create Folded Booklet
[ Booket
Center Binding Side Binding
FF_‘
o ] [ | [ 1o

Select the double-sided printing options you want to use.
Click OK to return to the Main tab.
Click the Print Density button.
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You see this window:

Print Density Adjustment
Select Document Type
® Text Text & Graphics Text & Photos User-Defined

Adjustments

Print Density 0 (%)

-50
Increase Ink Drying Time i} (s=c)
0 &0
O Cancel Help

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More

Options tab.
= x|
Man | Mo Optora | Margenancs
Frinting Fresets Dooument Sine i.thrf {B 12 x 11iny w
Ak cmarvs Presetes OutputFaper | Same ag Document Size v
=| Document - Fast [ Reduce Endar ge: Dedusrent

=| Dooument - Siandard Qualty Foorm o
8 Donement . High Cuslay e Zoom 1o =
=~ Document - 2-Sded fent=

SIE Qocment - U

7. Documant - 2Sided with 240

Comowr Codreschon

. a .
| Dwscurreent - Fast Grayscale Automati () Custom

2 Dooument - Grayscals

A Image Options...
B Domment 11x 17
Waterrark Featres..,
| ] Corfdental Job
j— Additional Settings
= [ rotate 1207
| 7] 5gh Spesd
'_g_ﬂ ""ﬂﬂ _‘J.P] [ Memor Image
Shew Setings
Reset Defsiis
ok || Cecel Helg

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

+ Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the
your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

» Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:

+ Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation
for your image.
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+ Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:
+ Anti-Copy Pattern: adds a watermark that only appears when your printout is copied.

Note: This setting is not available for all types of printing.
+ Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout.
Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.

Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with Windows

Related tasks
Printing Your Document or Photo - Windows
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Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Comection

ol Maragerent
) Ciobor Coninoes

Fix Shadn
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Ha Color Adpustrers
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& Color Crcle Sile Bar

T
Reset Controls

@
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Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

Header/Footer Settings
Top Left Top Center Top Right
Liser Mame W Mone v Date Time w
Bottom Left Bottom Center Botiom Right
MNone W Nong W None W
Reset Defaults OK Cancel Help

You can select to print the following information:
* User Name

» Computer Name

* Date

+ Date/Time

* Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
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Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available Printing Presets on the left:

Main | More Options | Maintenance

Printing Presets

Add/Remove Presets...

E Document - Fast
:: Document - Standard Quality
1‘ Document - High Quality
Document - 2-Sided
Document - 2-Up
Document - 2-5ided with 2-Up
| Document - Fast Grayscale

Document - Grayscale

13

Fi

Show Settings

Reset Defaults Ink Levels
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2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

B g x
My Mere Options  Mantenanoe
E Magde Chedk ﬂ. EFS0M Statns Morvior 3
W | Hesd Clearng E Wigentarrg Freborenint
'#LI Extended Setngs
L2
g
B Pt
@ Job Aevarger Lite % Preites and Opten Infsrmation
Lo Eregis (Fregiah] w i Software Lindate
verson 2.43.00 ol i
0K Coarval Halgy
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4. Click the Extended Settings button.
You see this window:

Extended Se10mgs
G Settres

1] ]
gl T
— ] | Erabie EFSON Siain Montzr 1
300 e | ek Papess Wcksh et Pring
- | Thick Paguer i Ervosiogees
0. S
S iy Pty
= e St amie e

iy Sposl BAR Dalatyse
Rack Left o W) Pasge Rrclerg Hode
| Print am Bitmap
| S Blawris Frage
et Dorsty | g Sancleedl ek son

Biefre Soeenrs paTem

— e Aopiatens 18 Perform KM Coier Matchneg

Pl [opreply - __j | Atwaryn e B Dronr's Paper Sourme Sriing

| St 1 pesge: dosnamenin Caceciown in J-5ced mode

Rt Doty ix Carvd Hei

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows
Extended Settings - Windows
You can select from these settings on the Extended Settings window.

Enable EPSON Status Monitor 3
Enables product monitoring for ink and paper supplies and other issues.

Check Paper Width Before Printing
Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

123



Short Grain Paper
Prevents ink from smearing when you print on envelopes or other thick paper, and the Thick Paper
setting does not help.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

General

Sadact Prirfer

% Add Printer

i EPSON
EPSOM (FAX)

L4 >

Status Ready [ IParttafile | Preferencas
Location

Comment Fing Printer..

Page Range
.l A Humber of copies: 1 ¥

111l 2121 3|3

7
|

2. Click OK or Print to start printing.
Parent topic: Printing with Windows

Locking Printer Settings - Windows
Administrators can lock some printer settings to prevent unauthorized changes.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.
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* Windows 7: Click EI' and select Devices and Printers. Right-click your product and select
Printer properties.

* Windows Vista: Click H and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click your product and select
Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

Dyriver Settings
Adrmrut atir Lack Fure bon B arvied St
dr-Cogry Fathern
Wanrrark
rigacker Fogher
i
bR P
Muin-Page
Al Desaursant Tetnrgs
L}
L
]
Foeset Detmits o Cancel ]

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.
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5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Locked Setting Options
Parent topic: Printing with Windows
Locked Setting Options
Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy Various data items Lets you select the data to use for the pattern or prohibit anti-
Pattern copy patterns
Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for
the custom anti-copy pattern
Watermark Various text Lets you select the text for the watermark or prohibit
watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based
Settings watermark
Lets you select the size, position, color and other watermark
settings
Header/Footer | Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers
Color Color Allows color printing
Grayscale Allows printing in black or shades of gray only
2-sided printing | Off Allows printing on one side of the paper only
On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings
2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper
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Parent topic: Locking Printer Settings - Windows

Entering a User ID and Password for Printing
If you enabled Access Control on the product, you must enter a user ID and password in the printer
driver to be able to print.

Note: If you do not know the user ID or password, contact your administrator for assistance.

1. Access the Windows Desktop, right-click the product in the Windows taskbar, and select Printer
Settings.

2. Click the Maintenance tab.

ke e

Mg Mess Optiang  Manisnanoe

@ Morde Ched g EF50 Stats Morvior

‘{‘ Heaed Clearg E Marvtarnyg Prefenenoes

'#:L'E Extendesd Setings
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@l Joly Arranger Lite % Prirviey andd Optan Informaion

Lo Eriiah (Ereia] w 5 Softvenre Uindate
verson 2.42.00 ol =
0K Careal Helgr

3. Click the Printer and Option Information button.
4. Selectthe Save Access Control Settings checkbox.
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5. Click the Settings button.

6. Enter your user name and password.
7. Click OK.

Parent topic: Printing with Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window:

i Printing Preferences “

Han Moo Optora | Marterancs
Fristing Fresets Paper Souroe Aurbo Select L
Add Rlemove Fresets. .. Drourmeent Sire Liviter (B 12 = 11in) N

=] Document - Fast
=| Dooument - Standard Qualty

e Ea o & Portrait Lardsiage
= Doosment - High Guality
.' Dooument - 2-Saded Paper Type Plairs Pageer [ Bingt White Faper -
alt] Doament - 345
", Document - 2-Sided with 24p Qualty Stardard v
1| Dooument - Fast Grayscale Crdor ) Coior Blavck Grayscsie

3 Dooument - Grayscake
2-Sadedd Prinbing CHff e

. E. E % . Ml Fage OfF *]
E o - ; o ﬂrcml‘;; O che
J C il
Sharw Satngs

Qusst Mode Ooff -
Pl Pranvigw

Job Arranger Lite
Reset Deflains Ik Levels

OK Camncnd g
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window.
3. Click the Maintenance tab.
You see the maintenance options:

= *
Moy Moss Optiong  Maintsnarce
‘@ Morde Chedk g EPS0R Statss Morvtor 3
Wi | Head Clearing E Maritaring Preferences
#]-' Extended Setings
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o
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4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
You see this window:

Software Update Settings “-
Check for Software Updates on the Internet
(@) Chedk every 2 weeks W
) Mever
K| Cancel

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
+ To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
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Related tasks
Checking for Software Updates

Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X

Selecting Double-sided Printing Settings - OS X
Managing Color - OS X

Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: | EPSON v

Presets: | Default Settings

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer:  EPSON

(o ff <>

Pregets: | Default Settings

Copies: 1

Pages: © Al
From: |1 to: |1

Paper Size: US Letter k) 850 by 11.00 inches
Ortentation: M *: Ts

Preview ﬁ

Auto Rotate

D Scale: 100%
Scale to Fit: .

Copies per page: 1 E

Cancel w

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

Select Print Settings from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Cover Page

Color Options
Two-sided Printing Settings

Supply Levels
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You see these settings:

Print Settings H
Paper Source:  Auto Select ﬂ.
Media Type: Plain Paper / Bright White Paper u
Print Quality: Normal =)
Grayscale
Mirrer Image
Cancel | (LN

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - OS X

Print Quality Options - OS X

Print Options - OS X

Parent topic: Printing with OS X

Related references

Paper or Media Type Settings - Printing Software

Related tasks
Selecting Page Setup Settings - OS X
Printing Your Document or Photo - OS X
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Paper Source Options - OS X

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 3
Selects the paper in cassette 3 as the paper source.

Front Paper Feed Slot
Selects the paper in the front feed slot as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - OS X
Print Quality Options - OS X

You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.

Draft
For draft printing on plain paper.

Normal
For everyday text and image printing.

Normal - Vivid
For everyday text and image printing with good quality and print speed.

Fine
For text and graphics with good quality and print speed.

Quality
For text and graphics with increased quality and print speed.

Best Quality
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - OS X
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Print Options - OS X

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter d B.50 by 11.00 inches

Orientation: [ # Te

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

le

Note: If you are printing an envelope, select the "= icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with OS X
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Selecting Print Layout Options - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout < |
Pages per Sheet: 1 [T
Layout Direction: g_} } 1 I

Border:  None % |

Reverse page orientation
Flip horizontally

Cancel | UL

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
* Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with OS X

Selecting Double-sided Printing Settings - OS X

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Twao-sided Printing Settings <]

Two-sided Printing: | Off H
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

Select one of the Two-sided Printing options.

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings ﬂ

Two-sided Printing: = Long-Edge binding

Document Type: | Text

¥ Adjustments:
Print Density:
A0 (%)
=50 a
Increasad Ink Drying Timae:
) 0 (sec)
Q +B0
When printing a photo or document containing a lot of solid image
argas, reduce tho density of the Ink and increase its drying tima.

ST Print |

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - OS X

Parent topic: Printing with OS X
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Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.
Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching [

ColorSync ) EPSON Color Controls

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Color Options =

* | Manual Settings
Fix Photo
Off (No Color Adjustment)

F Advanced Settings:

Cance Print

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - OS X

Parent topic: Printing with OS X
Color Matching and Color Options - OS X

You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can

customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

141



Color Options Settings

Manual Settings
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.
Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
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You see a screen like this:

General '-‘-‘Ii'?”-’l-. Supply Levels  LHility

To Rk full dvantnges of your prnters optona, confiem that they ore acounately
shown hees. For indormation on your printer ansd its eptssnal hardware, chock the
printor's documantation.

Thick paper and srvolopos: O =]

Skip Blonk Pege: O B

Cuiet Modec | Off B

Parmit temporary black prnting:  Off =]

High Speed Printing:  On =]

Warning Motificatipna:  On B

Establish bidroctional communication: _Gn B
Lowor Cassette:  Cassetto 2

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X
Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

Permit temporary black printing
Allows you to print using black ink when color ink is expended.
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High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings [~ |
Paper Scurce: Auto Select | |
Media Type:  Plain Paper / Bright White Paper ﬂ
Print Quality: Normal i
Grayscale
Mirror Image
Cancel | UL

Checking Print Status - OS X
Parent topic: Printing with OS X
Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
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1. Click the printer icon when it appears in the Dock.
You see the print status window:

@O W ERSON
n ¥
- et i
Pauso Sottings Seannor
car_art.jpg

2. Select the following options as necessary for your version of OS X:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - OS X

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.

Installing the Epson Universal Print Driver - Windows

Synchronizing Printer Settings - Epson Universal Print Driver - Windows

Selecting Basic Print Settings - Epson Universal Print Driver - Windows

Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows

Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows
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Adding Network Printers - Epson Universal Print Driver - Windows
Parent topic: Printing from a Computer

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. Download the EPSON Universal Print Driver from epson.com/support/wf6590.
2. Double-click the downloaded package.
3. Follow the on-screen instructions until you see this screen:

EPSON Printer Utilities Setup

Debect the prrter, and automatically corfigure the port
la the printer connected via a network 7

o '} Ma: USH conrechon

[ Set Defauk of Printar Cantrol Language to FCLE

oK Bt

4. Select Yes: Network connection and click OK.
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http://epson.com/support/wf6590

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the

default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)

After the software finishes searching for products, you see a screen like this:

L | EPSOM Printer Utilities Setup » IEN |
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5. Do one of the following:

+ If you are installing one product, make sure Add EPSON Universal Print Driver is selected and
continue with the next step.
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* If you are installing more than one product, select Add found printers and go to step 9.
Note: You can customize and filter your product search results by clicking Display Settings.

Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

Click OK, then skip the remaining steps.
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9. Ifyou are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

L] EPSOM Printer Utilities Setup x|
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& Add found prrters

Selact printars from the following kst, and then click the “Add to Panber Folder' bution. (You can
palact mulliphe prinbers fram the bt )

Fourd Printam:
Mclel Name F Address WAL Address Locabon
WP-J00 Senes 192.168.1.131 D02SABFBEDSC
WF- OO Senes 192 168.1 126 ASEESTACADIZ
< >
Add to Prinber Folder Cisplay Settinga

Prinbers ta be added

MName ol added prirter P Address
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The selected products appear in the lower section of the screen.

10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.

Parent topic: Printing with the Epson Universal Print Driver - Windows
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Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
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You see this window:
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3. Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional
equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Related tasks
Enabling the Optional Paper Cassettes - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
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Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select EPSON Universal Print Driver as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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Note: For more information about a setting, right-click it and select Help.
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10.
11.

12.
13.
14.

For the Paper Source setting, select where you loaded the paper you want to print on.
Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.

Select a Color option:

» To print a color document or photo, select the Color setting.

» To print text and graphics in black or shades of gray, select the Grayscale setting.
To print on both sides of the paper, select one of the 2-Sided Printing settings.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.
To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Related references

Paper Source Options - Windows

Print Quality Options - Windows

Multi-Page Printing Options - Windows

Paper or Media Type Settings - Printing Software
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Selecting Additional Layout and Print Options - Epson Universal Print Driver -
Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

i EPSOM Universal Print Drriver Printing Preferences H

Man | Mom Cptos Mantenarce

Printing Presets Dacument S Letier (3 12 x 11n) L
Ackd o Pricidta. .. Dyt Paper Same s Document Sips w
B Deocument - Standard Redure Enlange Document
11 Documendt - 240p
D - IS

= Dooument - 2-Sided with 2-4p
8 Diocumenit - Grayscale

Image DpAONs. ..
Walermark Fealues. ..
[ Corfdentsl Job
— Aggbonal Setings
" 4 ane o | ik S
-_J ‘.._|| "--'ll Aotate L30 igh Speed
Show Settings
Eirset Defoults
0K Cancel Help:

Note: For more information about a setting, right-click it and select Help.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

+ Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the
your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

» Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.
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5.

Select one of the following Color Correction options:

+ Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation
for your image.

» Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout.
Note: Click the Settings button to customize the text and location of the header or footer.

To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

Select any of the Additional Settings options to customize your print.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Related references

Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
You can select maintenance and other optional settings on the Maintenance tab.

i EPSOM Universal Print Drriver Printing Preferences E

Wain | Moe Optiors Mamtenarce

@ hoazie Chek

\N Hend Cheanng

‘_]il Exiarded Settings

%'% Hetwork printer search j_-j Prin Queus
@ ol Arranger Lite :?EJ Prirter and Opltion Infarmation
Language Engish (Enghsh] =
Wersion 260
0K Cancel Haip:

Note: For more information about a setting, right-click it and select Help.

* Nozzle Check lets you print a nozzle check pattern to check for clogged nozzles.
* Head Cleaning lets you clean the print head.
» Network printer search lets you search for and connect to a product on the network.

* Job Arranger Lite lets you save your print job as a project that can be modified and combined with
other print jobs.

+ Extended Settings lets you change a variety of print settings.
* Print Queue displays all the print jobs in queue. You can also cancel or restart print jobs.
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* Printer and Option Information displays information on the printer settings and any optional
equipment installed.

* Language lets you change the language of the printer software screens.
Extended Settings - Epson Universal Print Driver - Windows
Parent topic: Printing with the Epson Universal Print Driver - Windows

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Extended Settings - Epson Universal Print Driver - Windows
You can select from these settings on the Extended Settings window.
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Printer Control Language
Lets you select the printer control language.

Graphics Mode
Lets you select the mode by which to output PDL commands to the product.

TrueType Font
Lets you select how you want to print TrueType fonts.

Offset Settings
Lets you make fine-tune adjustments to the print position of data on your printout.
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Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap

Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the
product to collate your print jobs instead. (This setting is automatically enabled if there is not enough
memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.
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* Windows 7: Click E’ and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

* Windows Vista: Click E and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Printing Preferences.

You see the printer settings window:
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Note: For more information about a setting, right-click it and select Help.

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
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Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Administrators can lock some printer settings to prevent unauthorized changes. The following settings
can be locked:

1. Do one of the following:

Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
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You see this window:
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4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Epson Universal Print Driver Locked Setting Options
Parent topic: Printing with the Epson Universal Print Driver - Windows
Epson Universal Print Driver Locked Setting Options
Select the options you want to use for any locked print settings.
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Setting

Options

Description

Watermark Various text Lets you select the text for the watermark or prohibit
watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based
Settings watermark
Lets you select the size, position, color and other watermark
settings
Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers
Color Color Allows color printing
Grayscale Allows printing in black or shades of gray only
2-sided printing | Off Allows printing on only one side of the paper
On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings
2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

You can use the Epson Universal Print Driver to find and add network printers.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
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* Windows 7: Click E’ and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E’ and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
You see this window:
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3. Click Network printer search.
4. When you see the search results, select Add found printers.
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You see a screen like this:
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. Select the printer or printers you want to add.
6. Click Add to Printer Folder.
The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.

8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wf6590.

Installing the PostScript (PS3) Printer Software - Windows

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Selecting Basic Print Settings - PostScript Printer Software - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows

Parent topic: Printing from a Computer

Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

Download the PS3/Postscript software package from epson.com/support/wf6590.
Double-click the downloaded package.

Click OK.

Click Accept.

Click Install.

Click Next and follow the on-screen instructions.

® oA w N

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.
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Do one of the following:

* Windows 10: Right-click H and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printer Properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

Click the Device Settings tab.
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You see a window like this:
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3. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
4. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Related tasks

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - Windows
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Selecting Basic Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the
Preferences button.

You see the Layout tab of your printer settings window:
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4. Select the orientation of your document.
5. To print on both sides of the paper, select one of the Print on Both Sides settings.
6. To change the printing order of the pages, select one of the Page Order settings.
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7. To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
8. To create a folded booklet out of your photo or document, select the Booklet option.
9. Click the Paper/Quality tab.

You see this window:
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10. Select the Paper Source that matches where you loaded the paper you want to print on.
11. Select Plain as the Media setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
» Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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12. Select one of the following as the Color setting:

» To print a color document or photo, select the Color setting.

» To print text and graphics in black only, select the Black & White setting.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Related references
Paper Source Options - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

You can select a variety of additional layout and printing options for your document or photo by clicking
the Advanced button.
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1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the Print Quality option that matches the print quality you want to use.

170



6.
7.
8.

Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.

To utilize the Windows Image Color Management system, set the ICM Method option to one of the
ICM Handling options and select the ICM Intent setting you want to use.

Adjust the Pages Per Sheet Layout setting to change the order of multiple pages on a single sheet
of paper when you have adjusted the Pages Per Sheet setting on the Layout tab.

Adjust the Booklet Binding Edge setting to change the orientation of your printed booklet.
Expand the PostScript Options heading to access the advanced PostScript printer software features.
Select any of the remaining Printer Features options to customize your printouts.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1.

Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printing Preferences.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

+ Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Printing Preferences.
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You see the printer settings window:

-y EPSOM PS3 Series Printing Preferences E
Leyoud  Papeer, Clusity
Cirsgrvtagicn:
.
Prirt on Both Sedes;
[ Mene b
Page Order
Frant to Back b
Fage Format
& Pages per Sheet 1 w

EBoaklet

Advanced...

QK Cancsl

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - OS X

You can print with the PostScript (PS3) printer software using any OS X printing program, as described
in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wf6590.
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Installing the PostScript (PS3) Printer Software - OS X

Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X
Selecting Basic Print Settings - PostScript Printer Software - OS X
Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X

Sizing Printed Images - PostScript Printer Software - OS X

Managing Color - PostScript Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X

Parent topic: Printing from a Computer

Installing the PostScript (PS3) Printer Software - OS X

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

Download the PS3 Postscript software package from epson.com/support/wf6590.
Double-click the downloaded package.

Double-click EPSON.

Click Continue on the next two screens.

Click Agree.

Click Install.

If necessary, enter the administrator password.

© N bk w D=

. Click Start and follow the on-screen instructions.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X

If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.

1. Inthe Apple menu or the Dock, select System Preferences.
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2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

General f Options | Supply Levels

To take full advantage of your printer's optsons, confirm that they are accurately
shareen here. For information on your printer and s cptlonal hardware, check the
prinmer's documsentation

Lowansr Cassatte Unin: | Mo

Cancel oK |

4. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
5. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks
Enabling the Optional Paper Cassettes - OS X

Selecting Basic Print Settings - PostScript Printer Software - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Select your product as the Printer setting.

Printer: | EPSON H

Presets: | Default Settings

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer: EPSON :
Presets: | Default Settings =
Copies: |1
Pages: (= All
From: 1 to: 1
Paper Size: | US Letter ¥ | 850 by 11.00 inches
Orientation: 1 * Te.
Preview =
| Aute Rotate
Scale:
+ | Scale to Fit: * | Print Entire Image
Fill Entire Paper
Copies per page; L :
Cancel Print

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.

176



6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

+ Preview

Layout
Color Matching
Paper Handling

Paper Feed

Cover Page

Printer Features

You see these settings:

Paper Feed

# | All Pages From: | Auto Select
First Page From: | Rear Paper Feed

Remaining From: = Rear Paper Feed

Cancel Print

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

¥ Preview

Layout

Color Matching
Paper Handling
Paper Feed
Cover Page

You see these settings:

Printer Features H

Feature Sets: | Quality :

MediaType: | Plain

Print Quality: | Fine

Cancel Print

11. Select Plain as the MediaType setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
» Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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12. Select one of the following Print Quality options:
» For fast printing with reduced quality, select Fast.
* For printing text and graphics with good quality and print speed, select Fine.
» For the best printing with reduced speed, select Maximum.
13. Select Color from the Feature Sets pop-up menu.
You see these settings:

Printer Features

Feature Sets:  Color -

Color Mode: | Color =
Press Simulation: | Auto
Simulation Method: = Off

Pure Black Mode: | On

Cancel Print

14. Select a Color Mode option:

» To print a color document or photo, select the Color setting.

+ To print text and graphics in black only, select the Monochrome setting.
15. Select any of the available print options.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks

Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X
Printing Your Document or Photo - PostScript Printer Software - OS X
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Selecting Page Setup Settings - PostScript Printer Software - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: | US Letter T] 8.50 by 11.00 inches

[ |
QOrientation: 'i 1 L

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Related tasks
Selecting Basic Print Settings - PostScript Printer Software - OS X
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Selecting Print Layout Options - PostScript Printer Software - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout =

Pages per Sheet: 1 =

o
Border: MNone
Two-Sided:  OFf B

Reverse page orientation
Flip horizontally

Cancel Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.

» To print on both sides of the page, select one of the Two-Sided settings.

« Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
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Sizing Printed Images - PostScript Printer Software - OS X

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

13

Paper Handling
¥ Collate pages
Pages to Print:  All pages

Page Order: Automatic
Scale to fit paper size

Cancel Print

» To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

» To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.

» To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and
select a paper size from the Destination Paper Size pop-up menu.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Managing Color - PostScript Printer Software - OS X
You can adjust the Color Matching settings to fine-tune the colors in your printout.
1. Select Color Matching from the pop-up menu in the print window.

Color Matching

* | ColorSync In printer

Profile: | Automatic
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2. Do one of the following:

» To print using standard color profiles for your product and paper to help match image colors,
select ColorSync. Select one of the available Profile options to change the active color profile.

» To use the product's default color matching, select In printer.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Printer Features

Feature Sets: | Quality

MediaType: | Plain =

Print Quality: | Fine

Cancel Print

Checking Print Status - PostScript Printer Software - OS X
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Checking Print Status - PostScript Printer Software - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

=i

W =

About Downloads
i

L]

2. Select the following options as necessary for your version of OS X:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - PostScript Printer Software - OS X

Cancelling Printing Using a Product Button

If you need to cancel printing, press the ® Stop button on your product.
Parent topic: Printing from a Computer
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Scanning

You can scan original documents or photos and save them as digital files.

Starting a Scan

Selecting Epson Scan Settings

Scanning with OS X Using Image Capture

Scanning Special Projects

Entering a User ID and Password for Scanning - Windows

Starting a Scan

After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.

Starting a Scan Using the Product Control Panel

Starting a Scan with Document Capture Pro or Document Capture
Starting a Scan Using the Epson Scan Icon

Starting a Scan from a Scanning Program

Starting a Scan from a Smart Device

Parent topic: Scanning

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to a variety of devices and applications using your product's control panel.

1. Make sure you installed the product software and connected the product to your computer or
network.

Note: Restart your computer after installing the product software to enable scanning from the control

panel. Also make sure the Event Manager program is not being blocked by your firewall or security
software.

2. Place your original on the product for scanning.

Note: To scan a double-sided document, place it in the ADF and select the 2-Sided setting.
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3. Press the M home button, if necessary.

4. Select Scan.

You see a screen like this:

[oDF (G
Email i
Metwork FolderAFTP |
Memory Devins
Cloud \
Document Capture Pro E

5. Select one of the following Scan to options:

Email lets you send scanned files through a pre-configured email server.

Network Folder/FTP saves your scan file to a specified folder on a network.

Memory Device saves your scan file on a USB device connected to your product.

Cloud sends your scanned files to a destination that you have registered with Epson Connect.

Document Capture Pro allows you to scan over a network using your saved job settings in
Document Capture Pro or Document Capture.

Note: You cannot use this option to scan an image to Document Capture or Document Capture
Pro when your product is connected to your computer's USB port.

Computer (WSD) lets you manage network scanning in Windows 10, Windows 8.x, Windows 7,
or Windows Vista (English only). To use this feature, you must first set up WSD (Web Services for
Devices) on the computer.

6. Do any of the following, as necessary:

Select the email address, location, destination, or computer, as necessary.
Select Contacts to choose an email address or network folder.

Select Format to choose the file format.

Select Settings to display additional scanning options.
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7. Select Preset to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

Scanning to Email

Scanning to a Network Folder or FTP Server
Control Panel Scanning Options

Creating Contacts for Scanning

Adding and Assigning Scan Jobs

Parent topic: Starting a Scan

Related tasks

Using Epson Scan to Cloud

Using Copy, Fax, and Scan Presets
Entering Characters on the LCD Screen

Related topics
Placing Originals on the Product

Scanning to Email

You can scan an image and email the scanned file using your product's control panel. You must
configure an email server before you can scan to email. Make sure the date and time are set correctly on
your product's control panel so the time stamps on your emails are accurate.

Note: You can also use the Scan to Document Capture Pro function to scan and email the scanned file.
1. Place your original on the product for scanning.
Note: To scan a double-sided document, place it in the ADF and select the 2-Sided setting.

Press the % home button, if necessary.
3. Select Scan.
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You see a screen like this:

= Scanto JERTEE= ] :
Metwork FolderF TP

=

M

Document Capture Pro

-l

Select Email.
You see a screen like this:

B Emal CRELE
"W Enter Email fuddress

o Precet

Do one of the following:
+ Select Contacts and choose an email address from your contacts list.

» Select Enter Email Address, use the keyboard to enter the email address, and press .
Select Format to choose the file format for your scan.

Select Menu > Email Settings. Change the Subject and Filename Prefix settings if necessary,
then press the 3 back button to return to the Email screen.
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8. Select Preset to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

9. Press one of the & buttons.
Your product scans your original and emails the scanned file.
Parent topic: Starting a Scan Using the Product Control Panel

Related tasks

Configuring Email Server Settings
Selecting the Date and Time

Entering Characters on the LCD Screen

Scanning to a Network Folder or FTP Server
You can scan an image and save it to a network folder using your product's control panel.

Note: Make sure the date and time are set correctly on your product's control panel before using this
feature.

1. Place your original on the product for scanning.
Note: To scan a double-sided document, place it in the ADF and select the 2-Sided setting.

2. Press the M home button, if necessary.
3. Select Scan.
You see a screen like this:

= scanto [ADF el

Emai

Metwork: FolderFTR
Memory Devins
Cloud

Document Capture Pro

I- '_I— .
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4. Select Network Folder/FTP.
You see a screen like this:

B9 FoldersF TP
W Criler Localion

LContacts

- Preset

5. Do one of the following to select a folder or FTP location:

+ Select Contacts and choose a saved location in your contact list.

» Select Enter Location, then select the Communication Mode, Location, and other settings.
Note: Enter the folder path name for the Location setting in one of the following formats,
depending on the Communication Mode setting you selected:

* SMB: \\host name\folder
* FTP: ftp://host name/folder name

Select Format to choose the file format for your scan.

Select Menu > File Settings. Change the Filename Prefix setting if necessary, then press the
3 back button to return to the Folder/FTP screen.

8. Select Preset to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

9. Press one of the & buttons.
Your product scans your original and saves it in the selected location.
Parent topic: Starting a Scan Using the Product Control Panel
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Related references

Control Panel Scanning Options

Related tasks

Creating Contacts for Scanning
Entering Characters on the LCD Screen

Selecting the Date and Time

Related topics

Placing Originals on the Product

Control Panel Scanning Options

Select the options you want to use for scanning.

Note: Not all options or settings may be available, depending on the selected Scan to option.

Scan to setting

Available options

Description

Subject

Lets you enter a subject for your email

Filename Prefix

Lets you enter a filename prefix for your scanned
file

Location Communication Lets you select Network Folder (SMB) or FTP
Mode
Location Lets you enter a folder path in which to save
scanned images
User Name Lets you enter a user name for the selected
folder path
Password Lets you enter a password for the selected folder
path
Connection Mode Lets you select the connection mode
Port Number Lets you enter a port number
Format JPEG Select for photos
PDF Select for documents

TIFF (Single Page)

TIFF (Multi Page)

Select for scanned files that you can print from a
device; multi-page TIFF documents are scanned
in black and white
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Scan to setting

Available options

Description

Resolution 200dpi Select for documents
300dpi Select for photos
600dpi Select for highest quality printing
Scan Area Letter Select the page size for documents
A4
Legal
Half Letter
Executive
Auto Cropping Select for photos with dark edges
Max Area Select for most photos
2-Sided Off Lets you scan 2-sided originals placed in the
on AI_DF:_if you sele_ct On, you can also select the
Binding Direction.
Document Type Text Specifies the type of original you are scanning
Text & Image
Photo
Density -4 to +4 Adjusts the lightness or darkness of scanned
images.
Document Orientation Portrait Specifies the orientation of PDF documents
Landscape
Compression Ratio High Select High for smaller file size or Low for best
Middle quality
Low

PDF Settings

Document Open
Password

Lets you set a password for opening the
document using the on-screen keyboard

Permissions
Password

Lets you set a password for printing or editing
the document using the on-screen keyboard
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Scan to setting Available options Description

Attached File Max Size Various sizes Lets you select the maximum file size that can
be attached to an email

Parent topic: Starting a Scan Using the Product Control Panel
Creating Contacts for Scanning

You can create a list of contacts to use for scanning to email or to locations on a network folder or FTP
site.

Note: Contacts can be locked by an administrator. If you cannot access or change contacts, contact
your administrator for assistance. You can create up to 200 contacts and contact groups combined

(including fax contacts).
Press the M home button, if necessary.

Select Contacts. Enter the administrator password, if necessary.
3. Select Menu.

You see a screen like this:

' Add Entry |
CdiGow ]
print Ceetects |

Note: You can print your list of contacts and groups if necessary.

4. Select Add Entry.
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You see a screen like this:

M Sefect a Type

Metweork Folder/T TP |

5. Do one of the following:
» To create a contact for scanning to email, select Email.
» To create a location for scanning to a network folder or FTP site, select Network Folder/FTP.

6. Select the number you want to use for the contact you are adding.

7. Select the Name field, use the displayed keyboard to enter the contact name (up to 30 characters),
and press .

8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for
this entry (up to 30 characters), and press Eﬂ (This field is optional.)

9. Do one of the following:
» For an email contact, select the Email address field, use the displayed keyboard to enter the

address, and press .

» For a network folder or FTP site, select the Communication Mode field and select Network
Folder (SMB) or FTP. Then select the Location field, use the displayed keyboard to enter the

location, and press . Enter other information as necessary.
10. Select Save.

Note: If you need to edit or delete scanning contacts, the procedures are the same as for fax contacts.

Parent topic: Starting a Scan Using the Product Control Panel

Related tasks
Entering Characters on the LCD Screen
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Editing or Deleting a Contact

Related topics
Setting Up Contacts Using the Product Control Panel

Adding and Assigning Scan Jobs

You can view, change, or add available default scan settings when you scan using the Document
Capture Pro option on the product control panel. You do this by accessing the scan jobs in the Document
Capture Pro (Windows) or Document Capture (OS X) program.

1.

2.

Start Document Capture Pro or Document Capture on a computer connected to the product.

Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings
as necessary, and click OK.

You can now use the new scan job when you scan with Document Capture Pro or Document
Capture.

Note: See the Help information in Document Capture Pro or Document Capture for details.

If you want to assign scan jobs to the selection list on the product control panel, do one of the
following:

* Windows: Click Event Settings.
- OS X: Click the ' # ™ jcon at the bottom of the window, then click Event Settings.
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5. Select the jobs that you want to assign to any of the pull-down menus.

]
0
1

i2

Helpy

Ewent Settings - EFS0N

St s oo b b L Wi D B, b presiaesd

2 | Tahe Ma Aoten

3 | Take Mo Acten

Tk Mo Action
Takw Mo Acton

T Mo Aotien

T | Taks ho Acton

Take Mo Action
Takw Mo Acton
Tabie M Aoty
Taken Mo Bt

Takew by Acction

Jeb 283 3 can ba arly selscted from Metwork: Optiors

1 Scanio POF - Aule Debect/Subn. 2000, Save o Dooumenis

oK

Cancel

You can now use the added scan jobs when you scan from the product control panel.

6. Click OK, then click OK again.

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan with Document Capture Pro or Document Capture

When you scan with Document Capture Pro (Windows) or Document Capture (OS X), the program
automatically saves your scanned file on your computer in the folder you specify. You can select
settings, preview, and change the scanned file settings as necessary.

1. Do one of the following to start Document Capture Pro or Document Capture:

* Windows 10: CIickE and select All apps. Select EPSON Software, then select Document

Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.
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» 0OS X: Open the Applications folder, select the Epson Software folder, and select Document
Capture. Select your product and click OK, if necessary.

You see a window like this:

= Dioaumment Cagiure Pro -““_
fde  Jcan  [d8 Yew Bege  Qption  bedp

o kb [j'u, P - Fg temation B

Click the |§| Scan icon.
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You see a window like this:

Scan

Main Settings

Resolution

Heip

Document Size:
Image Type:

Ratation:

- | Auto Detect

Lettar

None

Lo

] Show the confimation dialog after scanning

Cancal

v | (200 - | doi

[] Tesxt Enhancement
[] Comect Document Skew
[] Skip Blank Page

Detailed Settings

<& Scan

Note: With OS X, you can download and install Epson Scan scanning software, which will provide
additional image adjustment features within Document Capture. To download Epson Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

If you want to use a scan job that you created instead, select it from the Job list in the Document
Capture Pro or Document Capture window, click the 2| Start Job button, and skip the rest of these

steps.

Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro or Document Capture for details.

If you want to select detailed scan settings, do one of the following:
* Windows: Click Detailed Settings. Select any displayed scan settings you want to use and click

OK.
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* OS X: If you installed Epson Scan, close the Scan Settings window, open the Scan menu at the

top of the screen and select Displays the EPSON Scan Setup Screen. Click the @ Scan icon.
Select any displayed scan settings you want to use and click OK.

6. Click Scan.
You see a preview of your scan in the Document Capture Pro or Document Capture window.
Check the scanned images and edit them as necessary.
Click one of the Destination icons to choose where to save your scanned file.

Dwectination - -;I- @ 2= lﬁ' I- *

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

9. Select settings as necessary, then click OK, Send, or Print to save the scanned file.
Parent topic: Starting a Scan

Related topics
Placing Originals on the Product

Starting a Scan Using the Epson Scan Icon

You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a
file.

* Windows 10: Click E and select All apps. Select EPSON Software, then select EPSON Scan.

* Windows 8.x: Navigate to the Apps screen and select EPSON Scan under EPSON or EPSON
Software.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select EPSON
or EPSON Software and click EPSON Scan.

* OS X: Open the Applications folder, open the Epson Software folder, and double-click the EPSON
Scan icon.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
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scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).

You see an Epson Scan window like this:

g EPSON Scan - o IEN]|

L ode:
iu'l? EPSON Scan Hm:gmnds -

M arne: Cuireni 5 ething w

S ane Drelete

Docurent Source; Auta Delect W
Size: Letter85=11 i) v
Mone

Dirierkation: (w ﬁ‘ Ij

[ ] Congct Document Skew

Fiotate: o w
Image Tups: Black & White v
Fiesojution: 200 v | dpi

IJ Eieview Q Sean _@]

Help Configuration.,. Cloze

Parent topic: Starting a Scan
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Related tasks

Scanning with OS X Using Image Capture

Entering a User ID and Password for Scanning - Windows
Related topics

Placing Originals on the Product

Starting a Scan from a Scanning Program

You can start Epson Scan from a scanning program to select scan settings, scan, and open the scanned
image in the program.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.
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You see an Epson Scan window like this:

" EPSON Scan - o HEN]

b ode:
ki? EPSON Scan Mm::gm:-ds v

M amme; Cureri Setting W

3 aveE Delete

Diocument Source:; Ao Detect W
Size: Lether(8.5% 11 in) v
Mone

Drrierdation: (" ﬂ Ij

| Congct Document Skew

Rotate: o "
Image Tups: Black & White v
Fiesojution: 200 w | dpi

d Freview Q Secan __@

Help Configuration... LCloze

Note: Epson Scan may start in a different mode when you first access it.

Parent topic: Starting a Scan
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Related tasks
Entering a User ID and Password for Scanning - Windows

Related topics
Placing Originals on the Product

Starting a Scan from a Smart Device

You can start a scan from a smart device using the Epson iPrint app. You can save the scanned
document to your device or a cloud service, e-mail it, or print it.

Note: Your device must be connected to the same wireless network as your Epson product.

Download the Epson iPrint app from your device's app store or from Epson's website.
Place your original on the scanner.

Open the Epson iPrint app and select your product.

Select the scan settings and scan your original.

ok~ wbd -~

Save your scanned image to a file or cloud location.
Parent topic: Starting a Scan

Selecting Epson Scan Settings

After starting Epson Scan, you can select settings in various modes to customize your scan.
Scan Modes

Selecting the Scan Mode

Scanning in Office Mode

Scanning in Professional Mode

Image Preview Guidelines

Scan Resolution Guidelines

Selecting Scan File Settings

Parent topic: Scanning

Scan Modes

Epson Scan provides a choice of scan modes with different levels of control over your settings.
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Office Mode
You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Parent topic: Selecting Epson Scan Settings

Selecting the Scan Mode

Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson
Scan window:

E EPSON Scan = -
N Mode:
ko EPSON Scan Office Made v

Selling: Professional Mode

Parent topic: Selecting Epson Scan Settings

Scanning in Office Mode

When you scan in Office Mode, Epson Scan automatically saves your scanned file in PDF format in your
operating system's Documents or My Documents folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Office Mode as the Mode setting.
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You see this window:

EPSON Scan - o EEN]

L
L& ode:
ke EPSON Scan Difice Made v
Setlings
T Cuirerd Settng v

Main Setings | Image Adjustment

Document Source; Ao Detect v
Size: Letter[8.5 % 11 w
Mone

Drrierdation: (" ﬂ | ‘|

| Congct Document Skew

Rotate: o "
Image Tups: Black & White W
Fiesojution: 200 w | dpi

d Fievies ﬂ Scan _{a]

Help Configuration... LCloze

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF-Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.
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12.

13.

14.

Select the Size and Orientation settings that match your original.
To scan both sides of a 2-sided original into one image, select a Stitch Images setting.

Note: To use the Stitch Images setting, you must select ADF-Double-sided as the Document
Source setting.

To allow Epson Scan to detect and correct any skew in your original, select Correct Document
Skew.

To rotate your original in your scan, select a Rotate setting.

Select the Image Type setting that matches your original.

Select the Resolution setting you want to use for your scan.

Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.

. If you are using the ADF, reinsert your original into the ADF.
11.

If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Click the Image Adjustment tab and select any of the image adjustment settings you want to use.
Before making adjustments, click the image or scan area in the Preview window.

Click Scan.
You see the File Save Settings window.
Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Office Mode
Selecting a Scan Area - Office Mode
Available Image Adjustments - Office Mode

Parent topic: Selecting Epson Scan Settings

Related concepts
Image Preview Guidelines
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Scan Resolution Guidelines

Related tasks
Selecting Scan File Settings
Scanning in Professional Mode
Available Document Source Settings - Office Mode
You can select these Document Source options in Epson Scan Office Mode.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Auto Detect
Automatically detects where the originals are placed on your product for scanning.

Parent topic: Scanning in Office Mode
Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. In the Preview window, click the .Er:. Auto Locate icon to create a marquee (dotted line) on the
preview image.

' VWelcome to
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2. Do the following, as necessary, to work with the selected scan area:
+ If the marquee is correct, continue with the next step.
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

» To create additional marquees (up to 50, if available), click the = ] Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

* To delete a marquee, click the marquee, then click the = Delete Marquee icon.
» To rotate your original in your scan, click one of the Rotate icons.
3. Click inside each scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Office Mode
Available Image Adjustments - Office Mode

You can select these Image Adjustments options in Epson Scan Office Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

b ain Settngs Image.-idp.-@trrﬂnt
Urzharp Mask Descreeninaly]
| Image Optian
® T el Enhancernent Starsdand
Wb frea S egrmentation
_otor Enkance lone
Skip Blark Pages: Off w
Edge Filll)): M W
Bnghiness: 1]
Conftrast; 1]
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Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox. Not all adjustment settings may be available, depending on the Image Type
setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Skip Blank Pages
Ensures that your product does not scan pages that contain no text or images.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with the color you select.

Brightness

Adjusts the overall lightness and darkness of the scanned image.
Contrast

Adjusts the difference between the light and dark areas of the overall scanned image.
Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Professional Mode

When you scan in Professional Mode, Epson Scan automatically saves your scanned file in PDF format
in your operating system's Documents or My Documents folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Professional Mode as the Mode setting.
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You see this window:
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10.

11.

12.

13.

Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF - Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

Select the specific type of original you are scanning as the Auto Exposure Type setting: Document
or Photo.

Select the details of your original and how you want it scanned as the Image Type setting.
Select the Resolution setting you want to use for your scan.

Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
If you are using the ADF, reinsert your original into the ADF.

If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

Note: You cannot select a target size if you chose ADF-Double-sided as the Document Source
setting.

Click Scan.

You see the File Save Settings window.

Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Professional Mode
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Available Image Types - Professional Mode
Selecting a Scan Area - Professional Mode
Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode

Parent topic: Selecting Epson Scan Settings
Related concepts
Image Preview Guidelines
Scan Resolution Guidelines
Related tasks
Selecting Scan File Settings
Scanning in Office Mode
Available Document Source Settings - Professional Mode

You can select these Document Source options in Epson Scan Professional Mode.
Scanner Glass

Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Parent topic: Scanning in Professional Mode
Available Image Types - Professional Mode
You can select these Image Type options in Epson Scan Professional Mode.

24-bit Color
Select this setting for color photos.

Color Smoothing
Select this setting for color graphic images, such as charts or graphs.

8-bit Grayscale
Select this setting for black-and-white photos.

Black & White
Select this setting for black text documents or line art.
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Parent topic: Scanning in Professional Mode
Selecting a Scan Area - Professional Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal Preview mode. To use Thumbnail
Preview mode instead, click the Thumbnail tab.
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1. Do one of the following to select your scan area in the Preview image:

* Normal preview: Click the .EE-. Auto Locate icon to create a marquee (dotted line) on the preview
image.
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+ Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.

= Preview |£|_“

Moimal | Thimbrad

7 R
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2. Do the following, as necessary, to work with the selected scan area:
+ If the marquee is correct, continue with the next step.
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

* Normal preview: To create additional marquees (up to 50, if available), click the ] Copy
Marquee icon to copy the existing marquee and paste it on the preview image.

* To delete a marquee, click the marquee, then click the -15 Delete Marquee icon.

+ Thumbnail preview: To change the preview style, click one of the Size icons.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Professional Mode
Available Image Adjustments - Professional Mode

You can select these Adjustments options in Epson Scan Professional Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Adjustments

Q) (] (b = [@ o=

[+] [¥] Unshamp Mask

[+] [ | Descreening

Color Restoration
|| Backlight Comection

E] (| Diust Remowal

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox.
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Click the | ™ image adjustment icon to access additional settings.
Click the + (Windows) or » (OS X) icon next to a setting to change the level of adjustment.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with the color you select.

Auto Exposure

Automatically adjusts the image exposure settings when you click the 19 Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of auto exposure using a
slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For

advanced users only.) Click the = histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click

the = tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.
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Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.

Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the

highlight and shadow areas of the image. (For advanced users only.) Click the ¥ Color Palette icon
to access the settings.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
Selecting a Scan Size - Professional Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

+] Target Sige Brin___ 1 ~][A]

Note: If you need to rotate the orientation of the target size for your image, click the M orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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3. Do the following, as necessary, to work with the selected scan area:
» To move the marquee, click inside the scan area and drag the marquee where you want it.

» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.
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4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

You see this window:

Target Size Name:

5. Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.

The marquee is automatically proportioned for your custom scan size.
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6. To use additional sizing tools, click the + (Windows) or » (OS X) icon next to the Target Size setting
and select options as desired.

(=] Target Size: 5x7in. v|1 .

w [ 500 H 700| in - ﬁ

Scale: 150 20 & o
Trimming i & On

» Scale: Reduces or enlarges your image by the percentage you enter.
* Trimming: Turns automatic image cropping on or off.
- |2 Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust
it without constraint.
Parent topic: Scanning in Professional Mode

Image Preview Guidelines
You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:

Thumbnail preview

A thumbnail preview displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected.

Normal preview

A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually.

Parent topic: Selecting Epson Scan Settings

Scan Resolution Guidelines

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the
resolution setting you need:

* You will enlarge the image as you scan it.

If you will enlarge the image using Epson Scan's Target Size setting, you do not need to increase the
Resolution setting.
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* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select Epson Scan's Resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 150 dpi
* Print/convert to editable text (OCR): 300 dpi
» Fax: 200 dpi
Parent topic: Selecting Epson Scan Settings
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Selecting Scan File Settings

You can select the location, name, and format of your scan file on the File Save Settings window. You

can also select various optional settings that control how Epson Scan behaves when you scan and save
files.

~ File Save Settings ﬂ
Cutput 1
Location
® My Documents
Pichures
Othes:

File Mame
g0 3 206_23222306 pdi Edt..

Image Fomal
Type POF [".pdi) b Dplions. .

Diatails Paper Sizer Actual Image Size
Qeientahars Peelrail
Margire [Left, Topl{ 0.00mm, 0.00mm]
Pape Mumber: Save File With All Pagas
Compeason Lewel | Standaed Compreszion

[] Ovensite any fikes with the same name
1] Shiow thiz dialog box befoee rest scan

| Open imags folder altes scanning

] Show fdd Page dislog afler sesrring

OK || Cancel | Hep

The File Save Settings window may appear after you click Scan on the Epson Scan window. You may
also be able to access the window by clicking the 4 icon on the Epson Scan window.
1. Do one of the following to select the folder in which you want to save your scanned image:

* Click the button for one of the displayed folders.
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« Click the Other button, click the Browse or Choose button, and select a folder.

2. If you want to change the default name for your scanned image, click Edit and select the options you
want.

Select the file format you want to use in the Image Format Type menu.

If your file format provides optional settings, click the Options button to select them.
Choose any of the optional settings you want to use by selecting their checkboxes.
Click OK.

If you selected PDF or Multi-TIFF as the Type setting, you see this window after Epson Scan scans
your document:

o o bk w

Add Page Confirmation

(@™, Scanning complete. .
)| Do you want ta continue scanning and add more pages?

-

Select Edit Page to finish scanning and edit the paoes
before zaving the file.

Select Save File ta finizh scanning and save the file
without editing the pages.

““hddpage || | Edtpage | SaveFie

7. Choose one of the following options:
« If you are scanning only one page, click Save File.

* If you need to scan additional pages in a document, click Add page. Place additional pages on
the product for scanning, click Scan, and repeat until you have scanned all the pages. When you
are finished, click Save File.
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+ If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

Available Scanned File Types and Optional Settings
Parent topic: Selecting Epson Scan Settings
Available Scanned File Types and Optional Settings

You can select from a variety of scanned file types and optional settings on the File Save Settings
window in Epson Scan.

File Formats

Bitmap (*.bmp)
A standard image file format for most Windows programs.

JPEG (*jpg) | | | |
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and OS X systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most OS X programs.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Optional Settings

Overwrite any files with the same name
Select to overwrite previous files with the same names.
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Show this dialog box before next scan

Select to have the File Save Settings window appear automatically before you scan (in certain Epson
Scan modes).

Open image folder after scanning

Select to have Windows Explorer or OS X Finder automatically open to the folder where your scanned
image is saved after scanning.

Show Add Page dialog after scanning

If you are scanning a multi-page document using the PDF or Multi-TIFF format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with OS X Using Image Capture
With OS X, you can scan with your product using an image-editing application such as Image Capture.
Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).
Open an image editing application, such as Image Capture.

2. Select your Epson product from the DEVICES or SHARED list in the Finder, if necessary. (You may
need to hover over the DEVICES or SHARED list, click Show, and select your product.)

3. Ifyou see the Show Details button, click it.
If you are scanning an item on the scanner glass, your product begins a preview scan.
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Select the Scan Mode setting indicating where you placed your original (if available). Select any
other available scan settings as necessary.

Scan Mode: | Document Feeder

Kind: | E3 Color s |
Resolution: 300 v | dpi
Size: | US Letter 3
Orientation: | g @ ¥ &)
| | Duplex
Scan To: | () Pictures :
Name: Scan '
Format: | PDF N

| | Combine into single document

| Hide Details |

Image Correction: | Mone ™
Unsharp Mask = MNone : |
Descreening | Mone : |
Backlight Correction | Mone : _|
Dust Removal | MNone : |

| | Color Restoration
|| Quiet Mode

| Scan |

228




Note: If you are scanning a multi-page document in the ADF, you can have Image Capture combine
all the pages into a single document. After all pages have been scanned, you see the message No
document loaded.

. Select the folder in which you want to save your scanned file in the Scan To pop-up menu.
6. Click Scan.
Your scanned file is saved in the folder you selected.
Available Scan Settings - OS X Image Capture
Parent topic: Scanning

Related topics
Placing Originals on the Product

Available Scan Settings - OS X Image Capture
You can select these scan settings in your imaging editing application for OS X, if available.

Image Correction
Provides a graphical interface for adjusting brightness, tint, temperature, and saturation.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Quiet Mode
Reduces noise during scanning and may reduce scan speed.

Parent topic: Scanning with OS X Using Image Capture
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Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning to a SharePoint Server or Cloud Service
Scanning Multi-Page Originals as Separate Files

Parent topic: Scanning

Scanning to a SharePoint Server or Cloud Service

You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud
service.

1. Do one of the following to start Document Capture Pro:

* Windows 10: Click E and select All apps. Select EPSON Software, then select Document
Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click e or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.

* OS X: Open the Applications folder, select the Epson Software folder, and select Document
Capture. Select your product and click OK, if necessary.
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You see a window like this:

® Document Cagiure Pro = ““
fd Soan (St Yew Fige Qpten  Mep

san G b Fb scmeer - | T | petinstion =

Click the El Scan icon.
Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro or Document Capture for details.

Click Scan.
You see a preview of your scan in the Document Capture Pro or Document Capture window.
Click one of the cloud service Destination icons to choose where to save your scanned file.

. EIWeb Folder (WebDAV)

E Evernote (Windows only)

. L Google Drive

. * SugarSync
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.
»
[ 3

4] Microsoft SharePoint server (Windows only)

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

6. Select your Destination settings.

Note: The settings may vary, depending on the software version you are using. See the Help
information in Document Capture Pro or Document Capture for details.

7. Select any other scan settings as necessary, and click Send.
Your originals are scanned and uploaded to the indicated server.

Note: You can also create a scan job for uploading scanned images to a SharePoint server or a cloud
service. You can use the scan job when you scan with Document Capture Pro or Document Capture or
when you scan using the Document Capture Pro option on the product control panel.

Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files

You can use Document Capture Pro (Windows only) to scan multi-page originals as separate scanned
files. You indicate where you want the new scanned files to start by inserting a blank page or barcode
between the pages of your original.

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture Pro for details.

1. Load a multi-page original with blank pages or barcodes inserted where you want to start a new
scanned file.
2. Do one of the following to start Document Capture Pro:

* Windows 10: Click IEI and select All apps. Select EPSON Software, then select Document
Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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* Windows (other versions): Click ﬁ or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.

You see this window:

= Documnent Cagiure Pra - ““

fle Gcan gt Yess Page  Qpten  Melp

san G vt Bl semesr - | T | pesinstion =

Click the El Scan icon.
Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro for details.

Click Scan.

You see a preview of your scan in the Document Capture Pro window.
Open the File menu and select Batch Save.

Click File Name Settings.

Select Apply Job Separation and click Separation Settings.

Select the method you used to separate the originals, select a folder name specification and click
OK.
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10. Select any other settings from the File Name settings window as necessary and click OK.
11. Select any other settings from the Batch Save window as necessary and click OK.
Your originals are saved into separate files as specified.

Note: You can also create a scan job for scanning multi-page originals as separate scanned files. You
can use the scan job when you scan with Document Capture Pro or when you scan using the Document
Capture Pro option on the product control panel.

Parent topic: Scanning Special Projects

Entering a User ID and Password for Scanning - Windows

If Access Control is enabled on the product, a user ID and password may be required to scan. You can
enter the user ID and password in Epson Scan Settings.

Note: If you do not know the user ID or password, contact your administrator for assistance.

1. Do one of the following to access Epson Scan Settings:

* Windows 10: Click E and select All apps. Select EPSON, then select EPSON Scan Settings.
* Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings.

* Windows (other versions): Click EI' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings.
2. Click the Access Control button.
3. Enter your user name and password.
4. Click OK.

Parent topic: Scanning
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Faxing

See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Note: When using the PCL or PostScript (PS3) printer software with the product, you can fax using the
printer buttons or the utilities included with the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wf6590.

Connecting a Telephone or Answering Machine
Setting Up Fax Features

Setting Up Contacts and Contact Groups
Sending Faxes

Receiving Faxes

Checking Fax Status

Printing Fax Reports

Connecting a Telephone or Answering Machine

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure Receive Mode is set to Auto.
Otherwise, you cannot receive faxes.
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1. Connect a phone cable to your telephone wall jack and to the LINE port on your product.

4 )

LINE

ANZN
A7

Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.
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DSL connection

o ©

Rib s

/
e

1  Telephone wall jack
2  DSL filter
3 DSL modem
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ISDN connection

1 ISDN wall jack
2  Terminal adapter or ISDN router
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2. If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.

~N

LINE

ANZanN
A2 RN
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3. Connect a second phone cable to your telephone or answering machine and to the EXT port on your
product.

~N

Note: If you connect an answering machine and Receive Mode is set to Auto, set the number of
rings before your product answers a call to a number that is higher than your answering machine's
setting for the number of rings.

Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VolIP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing

Related tasks
Receiving Faxes Automatically
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Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Basic Fax Features

Selecting Advanced Fax Settings

Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - OS X

Parent topic: Faxing

Setting Up Basic Fax Features
See these sections to select the basic settings you need to use the product's fax features.

Selecting Your Country or Region
Selecting the Date and Time

Using the Fax Setup Wizard

Selecting the Line Type

Setting the Number of Rings to Answer

Parent topic: Setting Up Fax Features
Selecting Your Country or Region
Before faxing, select the country or region in which you are using your product.

Note: If you change the country or region, your fax settings return to their defaults and you must select
them again. This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the % home button, if necessary.
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2. Select Setup.

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheet |
. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.

Ill- Sys e A e Irst son

| Printer Settings n
I Hetwork Settings |
(i Eoson Connect Senvdces ]
. Google Clowd Print Services ]d

4. Select Common Settings.

5. Scroll down and select Country/Region.

6. Scroll up or down, if necessary, and select your country or region.
You see a confirmation screen.

7. |Ifthe setting is correct, select Yes. (If not, select No and retry.)

Note: Changing the country or region restores the fax settings to the default settings.

Parent topic: Setting Up Basic Fax Features
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Selecting the Date and Time
Before faxing, select the current date, time, and daylight saving phase in your area, and choose your
preferred date and time format.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.

[ Ik Levels I

Mairtennnoe | |
Paper Selup |

Print Status Sheet

 Hetwark Stalus ltl

3. Scroll down and select System Administration. Enter the administrator password, if necessary.

IL Syslem A e s lraton

| Printer Settings

, Conmon Sellings ] I
| Hetwork Seftings |

[ Epsoa Connect Sendces

[ Goomte Clowd Prin Sexvices ¥
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Select Common Settings.

B Connon Settings

| LCD Brighiness |

&
Sl |

Sleep Timer

|
Power Off Timer |
Dt/ Time Settings |

Select Date/Time Settings.
You see a screen like this:

Bt Date/Tine Seftings

' DirlesTime |
Dergfight Savirsg Time |
Time Difference |

Select Daylight Saving Time.
Select the setting that applies to your area:

* Winter: it is winter or your region does not use Daylight Saving Time (DST)

* Summer: it is spring or summer and your region uses Daylight Saving Time (DST)

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

Select Date/Time.
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9. Select the date format you want to use.
10. Use the numeric keypad to enter the current date.
11. Select the time format you want to use.
12. Use the numeric keypad to enter the current time.
Parent topic: Setting Up Basic Fax Features

Using the Fax Setup Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically
displayed when the product is turned on for the first time. You can also change these settings individually
from the Fax Settings menu.

Note: These settings can be locked by an administrator. If you cannot access or change these setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.

§T Selup

[ Ink Levels I
MaTenanpe | |

Faper Selup ]
Print Status Sheet |
. Retwark Shalus ]_L:
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3. Scroll down and select System Administration. Enter the administrator password, if necessary.

B System Adsinistration

Printer Settings | &
| etwork Setlings |

Epson Conmect Services |
| Goagle Clowad Prnt Services ]ﬂ

4. Scroll down and select Fax Settings.

5. Scroll down and select Fax Setting Wizard.
The Fax Setting Wizard screen appears.

6. Select Start.

7. Onthe Fax Header screen, use the displayed keypad to enter the sender name for your fax source,
such as your name or a business name. You can enter up to 40 characters.

8. Onthe Your Phone Number screen, use the displayed keypad to enter your fax number, up to 20
characters.

Note: The name and phone number in the fax header identifies the source of the faxes you send.

9. On the Distinctive Ring Setting screen, do one of the following:

+ If you have subscribed to a distinctive ring service from your telephone company, select Proceed.
Select the ring pattern to be used for incoming faxes or select On. Go to step 12.

+ If you do not have a distinctive ring service, select Skip and go to the next step.

Note: Distinctive ring services allows you to have several phone numbers on one phone line. Each
number is assigned a different ring pattern. You can use one number for voice calls and another for
fax calls. Select the ring pattern assigned to fax calls in the DRD Setting. If you select On or a ring
pattern other than All, Receive Mode is automatically set to Auto.
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10. On the Receive Mode Setting screen, do one of the following:

+ If you have connected an external telephone or answering machine to the product, select Yes and
go to the next step.

+ If you did not connect an external telephone or answering machine, select No and go to step 12.
(Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)

11. On the next Receive Mode Setting screen, select Yes to receive faxes automatically or select No to
receive faxes manually.

Note: If you connect an external answering machine and select to receive faxes automatically, make
sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to
answer every call and operate the product’s control panel or your phone to receive faxes.

12. On the Confirm Settings screen, confirm the displayed settings and select Proceed, or press the
3 back button to change the settings.

13. On the Run Check Fax Connection screen, select Start and follow the on-screen instructions to
check the fax connection and print a report of the check result. If there are any errors reported, try
the solutions on the report and run the check again.

Note:
 Ifthe Select Line Type screen appears, select the correct line type.

+ If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone
detection function may drop the first digit of a fax number and send the fax to the wrong number.

Parent topic: Setting Up Basic Fax Features

Related tasks
Entering Characters on the LCD Screen

Selecting the Line Type

If you connect the product to a PBX phone system or terminal adapter, you must change the product's
line type. PBX (Private Branch Exchange) is used in office environments where an external access code
such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched
Telephone Network), which is a standard home phone line.

Note: This setting can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.
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Press the M home button, if necessary.
Select Setup.

[ Ik Levels |4

Paper Selup I
Print Status Shee I
. Metwork Stalus ]

T

Scroll down and select System Administration. Enter the administrator password, if necessary.

Ii. DS eE e s Drst son

| Printer Settings ]
I.| Common Settings | I
| Metwork Seltings |

i Epsos Coomect Sendoes ]

| Goonke Ciood Print Services v

Scroll down and select Fax Settings.
Select Basic Settings.

Select Line Type.

Select PBX.
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You see a screen like this:

Bt Access Code

=7 [0 Mot Use Lise

8. Select Use.
9. Select Access Code.
10. Use the displayed keypad to enter the access code, such as 9, and select OK.
Parent topic: Setting Up Basic Fax Features
Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the
Rings to Answer setting is correct. The number of rings should be higher than the number of rings your
answering machine is set to for answering a call.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
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Select Setup.

[ Ink Levels I
Paper Selup |

Print Status Sheet |
 Metwark Stilus ||w

Scroll down and select System Administration. Enter the administrator password, if necessary.

B Svstem Adsns bration

| Printer Settings | a

"| Cosmon Setlings | I

[ Meworksetiss |

| Epson Connect Services |

| Goooke Clowd Pyt Services |v|

Scroll down and select Fax Settings.
Select Receive Settings.
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6. Select Rings to Answer.

Bt Fings 1o Answer

7. Select the number of rings and select OK. Make sure to select a number higher than the number of
rings your answering machine is set to for answering a call.

Note: An answering machine picks up every call faster than the product, but the product can detect fax
tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has
started receiving the fax, then hang up the phone.

Parent topic: Setting Up Basic Fax Features

Selecting Advanced Fax Settings

You can select a variety of advanced fax settings.

Note: These settings can be locked by an administrator. If you cannot access or change these setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
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Select Setup.

[ Ink Levels I
Paper Selup |

Print Status Sheet |
 Metwark Stilus ||w

Scroll down and select System Administration. Enter the administrator password, if necessary.

B Svstem Adsns bration

| Printer Settings | a

"| Cosmon Setlings | I

[ Meworksetiss |

| Epson Connect Services |

| Goooke Clowd Pyt Services |v|

Scroll down and select Fax Settings.
You see a screen like this:

Bl Fm Settings

LIE'F’UE[HU||.5'4.‘-|.|JI1'EI‘5

Sen Setbings | |
Recetee Settings |

Cutput Settings |
' Basic Seltings Ik
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5. Select the group of settings you want to change.
User Default Settings - Fax
Send Settings - Fax
Receive Settings - Fax
Output Settings - Fax
Basic Settings - Fax
Security Settings - Fax
Parent topic: Setting Up Fax Features
User Default Settings - Fax

Set the default settings you want to use for faxing.

Setting Options Description
Resolution Standard Adjusts the scan resolution and print quality of
Fine outgoing faxes.
Super Fine
Ultra Fine
Photo
Density Auto Automatically adjusts the darkness of outgoing
faxes. Select this option when sending black-and-
white text documents.
Manual Lets you select from various density levels.
Document Size (Glass) |Half Letter Sets the size for a document placed on the scanner
glass.
A5
Letter
Legal
A4
ADF 2-Sided Off Select On to enable 2-sided faxing from the ADF.
o The Direct Send option and color faxing are disabled
n ) .
when you turn on this setting.
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Setting Options Description
Direct Send Off Select On to send black-and-white faxes to a single
on recipient without saving the scanned image to
memory; setting is disabled when sending a color fax
or sending a fax to multiple recipients
Continuous Scan from | Off Select On to have the product to ask if you want to
ADF on scan another page after a document in the ADF has

finished scanning

Transmission Report

Print on Error

Lets you select when to print transmission reports

Print

Do Not Print

Parent topic: Selecting Advanced Fax Settings
Send Settings - Fax

Set the send options you want to use for outgoing faxes.

Setting Options Description

Batch Send Off Sorts outgoing faxes by recipient in the product's
on memory and sends them as a batch.

Save Failure Data Off Saves faxes that failed to be sent in the product’s
on memory; you can resend them from the product's

Status Menu.

Parent topic: Selecting Advanced Fax Settings
Receive Settings - Fax

Set the receive options you want to use for incoming faxes.

Setting Options Description
Receive Mode Manual Lets you confirm whether an incoming fax should be
printed; a telephone must be connected to the product
Auto Automatically receives and prints faxes
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Setting Options

Description

Distinctive Ring All

Single

Double

Triple

Double&Triple

If you are using a Distinctive Ring Service on your
phone line, your telephone company can assign two
or more phone numbers to the same line and assign
different ring patterns to each. If you use this service,
select the number of rings for your fax number so your
product can receive faxes on the correct number of
rings. Select All for phones lines that do not use this
service.

Rings to Answer 1109

Sets the number of rings before your product receives
a fax. If Receive Mode is set to Auto and an
answering machine is connected to the product, make
sure this setting is set higher than the number of rings
your answering machine is set to answer a call.

Remote Receive Off

On

Start Code

Lets you start receiving faxes using your phone
instead of operating the product (if the Receive Mode
is set to Auto). When you select On, you must also
set a Start Code. If you are using a cordless handset
with its base connected to the product, you can start
receiving the fax by entering the code using the
handset.

Parent topic: Selecting Advanced Fax Settings
Output Settings - Fax

Set the output options you want to use for incoming faxes.

Note: If you select Save to Inbox, faxes are saved in the product's memory. Delete faxes after viewing
or printing them to prevent the memory from filling up. Even if you select other options for saving faxes,
they may be saved temporarily in the product's memory.
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Setting

Options

Description

Fax Output

Other Settings

Lets you create a folder for saving faxes on a memory
device and select settings for forwarding faxes

Save to Inbox

Saves incoming faxes in the product's memory; you
can view the faxes on the LCD screen and print them.

Save to Computer

Select Yes and Print to have faxes saved to your
computer and printed automatically; requires Epson
FAX Utility

Save to Memory
Device

Saves incoming faxes to a connected USB device;
select Yes and Print to have faxes saved to the
device and printed automatically

Forward Forwards incoming faxes to as many as 5 numbers in
your contact list; select Yes and Print to have faxes
forwarded and printed automatically (black-and-white
faxes only)

Auto Reduction On Select to reduce the size of large received faxes to fit
on the paper size in the selected paper source

Off Select to print large incoming faxes at their original
size on multiple sheets, if necessary

Auto Rotation On If you have loaded A5-size paper, select On to rotate

Off landscape-oriented incoming faxes so that they print
correctly on the paper.

Collation Stack On Select On to print incoming faxes so that the pages

Off are stacked in the correct page order; may not be
available in low-memory conditions

Print Suspend Time Off Select On to set a time period to stop automatic

on printing of faxes or reports and save received faxes in
the product’s memory; check available memory space

Time to Stop before using

Restart Time

Forwarding Report Print on Error Selects whether or when to print a report after an

Pri incoming fax is forwarded

rint
Do Not Print
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Setting

Options

Description

Attach Image to Report

Off

Does not include an image of the fax on transmission
reports

On(Small Image)

On(Large Image)

Prints transmission reports with an image of the first
faxed page; disabled if usingDirect Send.)

Fax Log Auto Print

Off

Does not print the fax log

On(Every 30) Prints the fax log after 30 faxes are sent or received
On(Time) Prints the fax log at a time you select using the
numeric keypad displayed on the LCD screen
Report Format Simple Selects the amount of information on fax reports
Detail

Parent topic: Selecting Advanced Fax Settings

Basic Settings - Fax

Set the basic options you want to use for incoming and outgoing faxes.

Setting Options Description

Fax Speed Fast(33,600bps) Sets the speed at which you send and receive faxes.
Medium(14,400bps)
Slow(9,600bps)

ECM On Turns on Error Correction Mode (ECM) to

automatically correct errors in sent or received fax
data

Off Turns off Error Correction Mode (ECM); color faxes
cannot be sent or received.
Dial Tone Detection On Automatically dials the number you enter for faxing
when the product detects a dial tone
Off Turns off automatic dial tone detection, which may

be necessary if the product is connected to a PBX
(Private Branch Exchange) or a TA (Terminal
Adapter); may cause the product to drop the first digit
of a fax number.
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Setting Options Description
Line Type PSTN Selects a standard phone line (Public Switched
Telephone Network)

PBX Selects Private Branch Exchange, the type of phone
line used in office environments where an access
code such as 9 must be used to call an outside line

Header Fax Header Select to enter the header information and your

Your Phone phone number for inclusion on outgoing faxes

Number

Parent topic: Selecting Advanced Fax Settings
Security Settings - Fax

Set the security options you want to use for fax data.

Settings

Setting Options Description
Direct Dialing Off Does not restrict dialed fax numbers
Restrictions On Allows faxing only to numbers stored in the contacts
list or history
Enter Twice Requires you to enter fax numbers twice to prevent
errors
Confirm Address List Off Selects whether or not to display a recipient
on confirmation screen before a fax is sent
Inbox Password Register Select to set a password for viewing incoming faxes

Backup Data Auto Clear

Off

On

Automatically erases sent or received fax data from
your product's memory

Clear Backup Data

Deletes all sent or received fax data remaining in your
product's memory; run this function if you are giving
away or disposing of your product

Parent topic: Selecting Advanced Fax Settings
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Setting Up Fax Features Using the Fax Utility - Windows
You can set up your fax header and select your fax settings using the FAX Utility for Windows.
1. Do one of the following:
* Windows 10: Click E and select All apps, then select EPSON Software.
* Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click B or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
You see this window:

- FAX Utility - olEN|

11y

Fax Transmussesn Send Cover Shesst Onily

Tzl PC-FAX Phone Baok

Fax Transmusson Record

Fax Setfings FOFAX Settings
Fax Settings for Printer
Others Add Anathar Prirter {Fax)

Onbine Hap

3. Select Fax Settings for Printer. (Select your product, if prompted.)
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You see this window:

- Fax Settings for Printer - o IEN

Tool Check Fax Connection

Fao: Setings

Receved Fax Ouiput Sethings

Speed Dial/Group Dial List

Halp [ Help

4. Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.
Note: For detailed information, select the FAX Utility Help option.

Parent topic: Setting Up Fax Features

Setting Up Fax Features Using the Fax Utility - OS X
You can set up your fax header and select your fax settings using the FAX Utility for OS X.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Double-click FAX Utility, if necessary.
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You see this window:

a8 n FAX, Litility
Printer FAX EPSOMN
Tool \ II. =
— -t 3
r —=3
Fam Tramemasson Srrainpe T Fan Recess Monnor
Esind Comueni
Fax Settings 7 i
v 3 A\ lil
2 BN |
Chech Fan Fiix SEImags Spend Dial ) Crows
? Cannsction Diial L

3. Select your FAX product in the Printer list.
Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features

Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You
can also set up contact groups to send a fax message to multiple contacts.

Setting Up Contacts Using the Product Control Panel
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Ultility - OS X

Parent topic: Faxing

Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.
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Note: Contacts can be locked by an administrator. If you cannot access or change contacts, contact
your administrator for assistance.

Creating a Contact

Editing or Deleting a Contact
Creating a Contact Group

Editing or Deleting a Contact Group

Parent topic: Setting Up Contacts and Contact Groups

Related tasks
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Ultility - OS X

Creating a Contact
You can create a list of contacts to save frequently used fax numbers.

Note: You can create up to 200 contacts and contact groups combined.

1. Press the f home button, if necessary.
2. Select Fax.
You see a screen like this:

fom Fa B = | B =1 F
@

Ii!esulutlun Contacts

History

i Hceok

P Hreview

3. Select Contacts. Enter the administrator password, if necessary.
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You see a screen like this:

™ F ﬂ“
I—um IEnl-m:

|_|:m ¥ Susan |

r“r:m 003 G Bokes 00 | (5
|
m

4. Select Menu.

You see a screen like this:

' Add Entry |
CaGow |
Cprntcontats |

Note: You can print your list of contacts and groups if necessary.

5. Select Add Entry.
6. Select the number you want to use for the contact you are adding.
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You see a screen like this:

™ Add Entry A |

Hame '
Hod Entered l I
Index Word

Hiol Enfered ﬁ

7. Select the Name field, use the displayed keyboard to enter the contact name (up to 30 characters),

and press .
8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for
this entry (up to 30 characters), and press . (This field is optional.)

9. Select the Fax Number field, and use the numeric keypad on the LCD screen or the buttons on the
product to enter the fax number. You can enter up to 64 characters.

Note: If necessary, enter an outside line access code (such as 9) at the beginning of the fax number.
If the access code has been set up in the Line Type setting, enter the # pound sign instead of the
code.

10. Set the Fax Speed, if necessary.

11. Select Save.

Parent topic: Setting Up Contacts Using the Product Control Panel
Editing or Deleting a Contact

You can edit or delete any of the contacts on your list.

1. Press the M home button, if necessary.

2. Select Fax.
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You see a screen like this:

fm Fa S = | T 0
i [

3. Select Contacts. Enter the administrator password, if necessary.
You see a screen like this:

™ Fa D“
I—um IEnl-m:

l_tmﬂsum |‘

r“r:m B Bk chubs

4. Select the i icon for the contact you want to edit or delete.
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You see a screen like this:

™ Detals

Delete

5. Do one of the following:
» To delete the contact, select Delete and select Yes on the confirmation screen.
» To edit the contact, select Edit, select the item you want to change, enter the correct information,
and select . When you are finished editing, select Save.

Parent topic: Setting Up Contacts Using the Product Control Panel

Creating a Contact Group
You can create a group of contacts so that you can easily send faxes to multiple recipients.

Note: You can create up to 200 contacts and contact groups combined.

1. Press the M home button, if necessary.
2. Select Fax.
You see a screen like this:

fm Fax = | B =0
=
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3. Select Contacts. Enter the administrator password, if necessary.
4. Select Menu.
You see a screen like this:

™ Menu H |

[l

i Entry |

fulil Cancsup |
Print Contacts |

Note: You can print your list of contacts and groups if necessary.

5. Select Add Group.
6. Select the number you want to use for the group you are adding.
You see a screen like this:

™ add Group

Hame

l Hod Entered I

Index Word

l Mol Entered I

7. Select the Name field, use the displayed keyboard to enter the group name (up to 30 characters)
and press .

8. Select the Index Word field, use the disEIai/ed keyboard to enter a word to use when searching for a
group (up to 30 characters) and press . (This field is optional.)
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9. Select Proceed.
You see your contacts list.
10. Select the number next to each contact you want to include in your group.
A check mark appears next to each selected contact.
11. Select Save.
Parent topic: Setting Up Contacts Using the Product Control Panel
Editing or Deleting a Contact Group
You can edit an existing contact group to add or delete entries. You can also delete the entire contact
group.
1. Press the M home button, if necessary.

2. Select Fax.
You see a screen like this:
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3. Select Contacts. Enter the administrator password, if necessary.
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You see a screen like this:
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Proceed

4. select the [ icon for the group you want to edit or delete.
You see a screen like this:

™ Detals

non AR

Delete

5. Do one of the following:
* To delete the entire group, select Delete.

* To edit the group, select Edit, select Proceed, then select the number next to the contact you
want to add or delete. When you finish, select Save.

Parent topic: Setting Up Contacts Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

You can set up your speed dial and group dial lists using the FAX Utility for Windows. The utility also lets
you import fax numbers from the Windows Address Book and back up fax numbers stored in your
product's memory.

269



Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:

* Windows 10: Click E and select All apps > EPSON Software.
* Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click @ or Start > Programs or All Programs > EPSON Software.

2. Select FAX Utility.
You see this window:

3. Select Fax Settings for Printer. (Select your product, if prompted.)
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You see this window:

4. Select Speed Dial/Group Dial List.
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7.
8.

You see this window:

wi Speed Dial/Group Dial List m
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Select an empty entry and click the # icon.

Note: To edit an entry, select it and click the # icon. To delete an entry, select it and click the "
icon.

Do one of the following:

» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.

» To create a group dial entry, select Group, enter a name, select your desired fax numbers, and
click OK.

Repeat the previous steps as necessary to add all your speed dial or group dial entries.

+*
When you are finished, click the &= icon to save the entries to your product's memory.

Parent topic: Setting Up Contacts and Contact Groups

Related topics
Setting Up Contacts Using the Product Control Panel
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Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.
2. Double-click FAX Utility, if necessary.
You see this window:

an FAX Lhility
Printer FAX EPSON
Taool \ II- —
— . 3
r —=3
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Fax Settings . % 1 | r
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3. Select your FAX product in the Printer list.
4. Select Speed Dial/Group Dial List.
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You see this window:

8eoon Speed Dial fGroup Dial List = FAX EPSON
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5. To add an entry, double-click an empty entry.
Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.
6. Do one of the following:
» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
» To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,
and click OK.
7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.
IR .
8. To import entries from your MacAddress book, click the L icon.
9. When you are finished, click the - icon to save the entries to your product's memory.

Parent topic: Setting Up Contacts and Contact Groups

Related topics
Setting Up Contacts Using the Product Control Panel
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Sending Faxes

See these sections to send faxes using your product.

Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - OS X

Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.

Sending a Fax Using the Keypad, Contact List, or History
Fax Sending Options
Sending a Fax at a Specified Time
Sending a Fax on Demand
Sending a Stored Fax
Sending a Fax from a Connected Telephone
Parent topic: Sending Faxes
Sending a Fax Using the Keypad, Contact List, or History

You can send a fax from your product control panel by entering the fax number, or selecting the number
from either the contact list or fax history.

Note: You can send a black-and-white fax to up to 200 recipients at a time, or send a color fax to one
recipient at a time. If your recipient's fax machine does not print in color, your fax is automatically sent in
black-and-white.

Note: The product can queue up to 50 black-and-white fax jobs. You can check or cancel fax jobs in the
queue using the Status Menu.

1. Place your original on the product for faxing.

2. Press the M home button, if necessary.
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3. Select Fax.

fm Fx S = | T 0
=

Ii!es.nluthm l:l Demsily Comacls

Hisbory

-l-l- IJI:h:urIEfﬂ " 1 ﬁ.l'.'ll- 2=5lded
i Hook

Henu Lﬂ' Preview

Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-
Sided setting. (You cannot fax double-sided documents in color.)

4. Do one of the following to select fax recipients:

5.

* Manually enter a fax number: Press the Enter a Fax Number field, enter a fax number, and

press the - button. To add another fax number, repeat this step. You can also use the numeric
keypad on the control panel to enter a fax number.

Note: If direct dialing has been restricted, you can only select the number from the contact list or
fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax
number. If the access code has been set up in the Line Type setting, enter the # pound sign
instead of the code.

Select from the contact list: Select Contacts to display the contact list screen. Select the
checkbox next to one or more contact (select the checkbox again to deselect it). You can also
select the Search field to search for recipients by name, index name, or entry number. Select
Proceed when you are finished.

Select from the sent fax history: Select History to display the sent fax history. Select a recipient
from the list, select Menu, and select Send to this number.

Note: To delete entered recipients, select the Enter a Fax Number field, select the recipient you
want to delete, and select Delete from the List.

If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.
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6. If you want to preview your fax in black-and-white on the LCD, select Preview. (If the preview looks
incorrect, select Retry, reposition the document or change the fax settings, and repeat this step.)

Note: If you do not touch the preview screen for 20 seconds, your product sends the fax
automatically. You cannot preview images when the Direct Send setting is turned on. Once you
preview a fax, you cannot send it as a color fax.

7. If you want to save your fax settings for later use, select Presets and add a new entry.

If you want to listen to sounds or voices (such as audio prompts) while preparing a fax, select On
Hook and follow the on-screen prompts. You can adjust the speaker volume using the + or —
buttons.

9. Press one of the & buttons.

Note: To cancel faxing, press the @ Stop button. You can also cancel the job or check the job status
from the Status Menu.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: Your product does not save sent color faxes to its memory. If the Save Failure Data option is
enabled, faxes that failed to be sent are stored to the product's memory and you can resend them from
the Status Menu screen.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related tasks
Selecting the Line Type
Using Copy, Fax, and Scan Presets

Related topics
Setting Up Contacts and Contact Groups
Placing Originals on the Product

Fax Sending Options
While sending a fax, you can select Menu and select these options from the Fax Send Settings menu.
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Note: You can also select these options in the User Default Settings menu.

Setting Options Description
Resolution Standard Adjusts the scan resolution and print quality of
Fine outgoing faxes
Super Fine
Ultra Fine
Photo
Density Auto Automatically adjusts the darkness of outgoing faxes;
select when sending black-and-white text documents
Manual Lets you select from various density levels
Document Size (Glass) |Half Letter Sets the size for a document placed on the scanner
A5 glass
Letter
Legal
A4
ADF 2-Sided Off Select On to enable 2-sided faxing from the ADF;
On disables the Direct Send option and color faxing
Direct Send Off Select On to send black-and-white faxes to a single
On recipient, without saving the scanned image to
memory; setting is disabled when sending a color fax
or sending a fax to multiple recipients
Priority Send Off Select On to send the current fax before other faxes
o waiting to be sent
n
Continuous Scan from | Off Select On to have the product to ask if you want to
ADF On scan another page after a document in the ADF has

finished scanning

Transmission Report

Print on Error

Print

Do Not Print

Lets you select when to print transmission reports
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Parent topic: Sending Faxes from the Product Control Panel
Sending a Fax at a Specified Time
You can send a fax at a time of your choice.

Note: Make sure the product's date and time settings are correct. You can only send faxes in black-and-
white when you use this option.

1. Place your original on the product for faxing.

2. Pressthe M home button, if necessary.

3. Select Fax.
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Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-
Sided setting.

4. Enter a fax number, or select Contacts or History and select a number.
5. Select Menu.

6. Select Send Fax Later.

7. Select On.

8

Select Time, use the displayed keypad on the LCD screen to enter your desired time, and select
OK.

9. Press one of the & buttons.

Note: To cancel faxing, press the & Stop button.
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After scanning your originals, your product dials the number and sends the fax at the specified time.
Note: If the product is turned off at the specified time, the fax is sent when it is powered on.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related tasks
Selecting the Date and Time

Related topics
Placing Originals on the Product
Setting Up Contacts and Contact Groups

Sending a Fax on Demand

You can store one scanned original (up to 100 black-and-white pages) and have it faxed automatically
when another fax machine requests it. Other fax users can receive the fax by calling your fax number
and using the polling receive function on their fax machines.

1. Place your original on the product for faxing.
2. Pressthe M home button, if necessary.
3. Select Fax.
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4. Select Menu.
5. Select Polling Send and select On.
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6. If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.

7. Pressthe & B&W button.
Your original is scanned and stored until you overwrite or delete it.

Note: You can store only one original at a time. Subsequent stored faxes overwrite the existing fax.
You can also delete a stored fax from the Status Menu.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Stored Fax
You can store one scanned original (up to 100 black-and-white pages) and fax it whenever necessary.

1. Place your original on the product for faxing.
2. Pressthe M home button, if necessary.
3. Select Fax.
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4. Select Menu.
5. Select Store Fax Data and select On.

6. If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.
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7. Pressthe & B&W button.
Your original is scanned, stored, and briefly previewed.

8. When you are ready to send the stored fax, press the i Status button.
You see a screen like this:

B Status Mena
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9. Select Job Monitor.

10. Select Communication Job.

11. Select the stored fax you want to send.
12. Select Send/View and select Send.

Note: You can store only one original at a time. Subsequent stored faxes overwrite the existing fax. You
can also delete a stored fax from the Status Menu.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Fax from a Connected Telephone

If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone. If the recipient's phone number and fax number are the same,
you can speak to the recipient before sending the fax.

1. Place your original on the product for faxing.
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7.

Press the M home button, if necessary.
Dial the fax number from the connected telephone. Speak to the recipient if necessary.

Note: If you are using a pre-paid calling card, enter the number and password required to use the
card before entering the destination fax number.

Select Start Fax on the LCD screen.
Select Send.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.

When you hear a fax tone, press one of the & buttons to start sending the fax.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

Hang up the telephone.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related tasks
Connecting a Telephone or Answering Machine

Related topics
Placing Originals on the Product

Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,
including a cover sheet.

1.

Open the file you want to fax and select the print command.
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You see a window like this:

General

Selact Prinder
% Add Printer
=5 EPSON
(S EPSON (FAX)

<

Status: Oz
Location
Coemment :

Faga Range
oL

Selection

Pages

Select your product with the FAX option as the printer.

To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the
Preferences or Properties button.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

Select the Page Range as necessary. (Leave the Number of copies setto 1.)
Click Print or OK.
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If you're faxing for the first time, you see a window like this one:

Enter Sender Information ﬂ

Naclkonamee:
Nearme:
Phone Humber: Fax Humber:

Addriss:

Company)/Corp.:
Divicion) Tithe:

QK I Cancel

6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.
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You see a window like this:

Faix Mumissr:

Becmuse *-" actt a5 & pause, do not use it b
punCtuabe phons rumbens,

DevisionTite:

|

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.
Note: For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.

9. Click Send to transmit your fax.
Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - OS X
You can send a fax from a OS X printing program using the FAX Utility. You can fax up to 100 pages at a
time, including a cover sheet.

1. Open the file you want to fax.
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Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Printer:  FAX [T
Presets:  Default Settings kd
Copias: 1
Pages: £ Al
From: 1 to: (1
Paper Size: US Letter kJ 8500y 11.00 inches
Oriantation: ' * f » Scale: 100 %

Select your product FAX option as the Printer setting.

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

Select the number of pages you are faxing as the Pages setting.
Note: Leave the Copies setting set to 1.

Select Recipient Settings from the pop-up menu.
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You see this window:

Raciplant Settings ﬂ
Recipient List:
Marma Company/Carp. Fax Murmber
1
Add:

MName:;

Company/Corp.:

Fax Mumber:

A nyphen (-] ls evailable only at the
beginning of the phone number bacause
it acts as a pausa in dialing.

External Access Prefix:

Cancel

Do one of the following to choose your recipient:

» Select a name or group from the Recipient List.

* Enter a name, company, and fax number and click the + button.
» Click the |1| icon and select a recipient from your address book.
Select Fax Settings from the pop-up menu.

288



You see this window:

Fax Settings % |

Color: ) Black & White
Calor

Image Quality:  MNormal [+ |

Cancel

9. Select the Color and Image Quality settings you want to use for your fax.
10. Click Fax.
Parent topic: Sending Faxes

Receiving Faxes
See these sections to receive faxes with your product.

Fax Reception

Receiving Faxes Automatically
Receiving Faxes Manually
Forwarding Received Faxes
Receiving a Fax by Polling
Viewing a Saved Fax

Parent topic: Faxing

Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to Auto.
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If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.

Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes

Receiving Faxes Automatically

To receive faxes automatically, make sure Receive Mode is set to Auto (the default setting for the
product).

To change the Receive Mode if necessary, select Setup > System Administration > Fax Settings >
Receive Settings > Receive Mode.

If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

Parent topic: Receiving Faxes

Related references
Receive Settings - Fax

Related tasks
Receiving Faxes Manually

Receiving Faxes Manually

You can set up your product to receive faxes manually by setting the Receive Mode to Manual. This lets
you check for a fax tone on the connected telephone before receiving a fax.

1. Select Setup > System Administration > Fax Settings > Receive Settings > Receive Mode and
select Manual.

When the connected telephone rings, answer the call.
If you hear a fax tone, select Start Fax on the LCD display.
Select Receive.

o &~ N

Press one of the & buttons to start receiving the fax.
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6. Hang up the telephone.
Parent topic: Receiving Faxes

Related references
Receive Settings - Fax

Related tasks
Receiving Faxes Automatically

Forwarding Received Faxes
You can forward received faxes to another fax machine, or convert the faxes into PDF documents and
forward them to a shared folder on the network or to an email address.

Note: You cannot forward color faxes to another fax machine. Forwarded faxes are deleted from the
product's memory. Before using this feature, make sure the date and time are set correctly, the
forwarding destination is set up in the contact list, and the email server settings are configured.

1. Press the M home button, if necessary.
2. Select Setup.

§T Selup

[ Ik Levels I
Malenanpe | |

Paper Setup

e

Print Status Sheed
. Ketwark Shalus

=
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3.

10.
11.

12.

Scroll down and select System Administration. Enter the administrator password, if necessary.

B System Adsinistration

Printer Settings |
| etwork Setlings |

Epson Connescl Senioes |
_' Googie Cloisd Print Senvices ]ﬂ

Select Fax Settings > Output Settings > Fax Output > Settings > Forward and select Yes.
Note: If you want to print the fax automatically before forwarding it, select Yes and Print.

Select Other Settings.
Select Where to Forward.
Select up to 5 forwarding destinations from the contact list.

Note: Select View to sort your contacts by destination type.

When you finish, select Proceed.
Confirm the displayed destinations are correct and select Close.
Select Options When Forwarding Failed.

Select the option to use if received faxes cannot be forwarded: print the faxes or save them in the
printer's inbox.

If you are forwarding to an email address, select Email Subject to Forward to enter an email
subject.

Note: If you are forwarding faxes to a shared folder on the network or an email address, you can test
if fax forwarding was set up correctly by sending a scanned image to the destination using the scan
to email or scan to network folder/FTP option. If you are forwarding faxes to a shared folder on the
network, you can set up FAX Utility to notify you whenever a new fax is received.
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Parent topic: Receiving Faxes

Related tasks
Selecting the Date and Time
Starting a Scan Using the Product Control Panel

Related topics
Setting Up Contacts and Contact Groups

Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

Note: You cannot use polling to receive a fax from a fax information service that uses audio guidance.
Select On Hook and follow the displayed instructions to listen to the audio guidance.

. Press the  home button, if necessary.
2. Select Fax.

You see a screen like this:
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Select Menu.
Select Polling Receive and select On.
Enter the fax number you expect to receive the fax from.

o o bk w

Press one of the & buttons to start receiving the fax.
Parent topic: Receiving Faxes
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Viewing a Saved Fax
You can save received faxes in your product's memory and view them on the LCD screen.

Note: To use this feature, you must first enable Save to Inbox in the Output Settings menu. The Inbox
can be locked by an administrator. If you cannot access the Inbox, contact your administrator for
assistance.

1. Press the f home button, if necessary.

2. Check the (B | jcon on the LCD screen. It turns on if there are any unread or unprinted faxes in the
product's memory.

3. Select Fax.
Select Open Inbox. Enter the administrator password, if necessary.
5. Select the fax you want to view.
You see the fax displayed on the screen.
Select Menu.
Select one of the printing/deleting options and follow the on-screen instructions.

Note: Delete faxes after you print or view them to prevent the product's memory from filling up. When the
memory is full, you cannot receive or send faxes.

Parent topic: Receiving Faxes

Checking Fax Status
You can check the status of current fax jobs, or faxes that have been received or sent.
1. Press the i Status button.
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You see a screen like this:

B Status Mena
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2. Do one of the following:

» To check the status of current fax jobs, select Job Monitor, select Communication Job, and
select the fax you want to check.

» To check the history of faxes that have been sent or received, select Job History, select Receive
Job or Send Job, and select the fax you want to check.

» To check received faxes that have been saved in the product's memory, select Job Storage and
select Inbox.

Parent topic: Faxing

Printing Fax Reports

You can select from several fax reports to print whenever necessary.

Note: You can also have the fax log printed automatically by turning on Fax Log Auto Print in the
Output Settings menu.

1. Press the M home button, if necessary.
2. Select Fax.
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You see a screen like this:
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3. Select Menu, select Fax Report, and select the report you want to print.
Fax Report Options
Parent topic: Faxing

Fax Report Options
Select the fax report or list you want to print.

Fax Settings List
Print a list of the current fax communication settings.

Fax Log
View or print a report on recent fax transmissions.

Last Transmission
Print a report on the previous fax that was sent or received through polling.

Stored Fax Documents
Print a list of the fax jobs currently stored in the product's memory.

Protocol Trace
Print a detailed report for the previous sent or received fax.

Parent topic: Printing Fax Reports
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Viewing or Printing from a USB Flash Drive or External

Device

You can view and print photos from a USB thumb drive or other external storage device, such as an
external hard drive.

Note: Make sure the files on your device are compatible with the product.

Connecting and Using a USB Flash Drive or External Device
Disconnecting a USB Device

Viewing and Printing From the LCD Screen

Transferring Files on a USB Device

Connecting and Using a USB Flash Drive or External Device

You can view and print files from a USB thumb drive or other external storage device, such as an
external hard drive. Before you connect your thumb drive or device, make sure the product is turned on
but not printing.

Note: Epson cannot guarantee the compatibility of your device. Make sure the files on the device are
compatible with the product.

1. Remove any memory cards from the product.

2. Insert your USB thumb drive or the USB cable that came with your device into the USB port on the
front of your product.

3. When you see a message that the device is recognized, select OK.

When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

USB Device Photo File Specifications
Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Related tasks
Disconnecting a USB Device

USB Device Photo File Specifications

You can use USB devices with your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
TIFF 6.0-compliant uncompressed images: RGB full-color or binary
(not CCITT-encoded)
PDF version 1.7-compliant

Image size 80 x 80 pixels to 10200 x 10200 pixels

File size Up to 2GB

Number of files JPEG: Up t0 9990

TIFF: Up to 999
PDF: Up to 999

Parent topic: Connecting and Using a USB Flash Drive or External Device

Disconnecting a USB Device
After you finish working with a USB device, follow these steps to remove it.
1. If your product is connected to your computer using a USB cable, do one of the following:

* Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility. Then
right-click the name of your USB device (listed as a removable disk) and select Eject.

» OS X: Drag the removable disk icon for your USB device from the desktop into the trash.

Caution: Do not remove a USB device before completing the procedure above or you may lose data
from the flash drive.

2. Pull the USB device out of the USB port on the front of the product.
Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Viewing and Printing From the LCD Screen

See these sections to view and print photos or other files displayed on your product's LCD screen.
Printing JPEG Photos

Printing TIFF and PDF Files

Photo Adjustment Options - Device Mode

Print Setting Options - Device Mode

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Printing JPEG Photos

You can select JPEG photos for printing as you view them on the LCD screen.

1.

Press the M home button, if necessary.

2. Select Memory Device.
3. Select JPEG.

You see a screen like this:

® Select Images

5
-

Note: If you have more than 999 JPEG images on your device, the images are divided into groups,
and you must first select the group you want to display.

Do one of the following to select your photos:

» To select individual photos, select the thumbnail image of the photo you want to print, then use the
numeric keypad on the control panel or press + or — on the LCD screen to select the number of
copies (up to 99). Press the left or right arrow button to scroll through and select additional photos,
or press the 3 back button to return to the thumbnail image view and select another photo.
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* To select all photos, select Menu > Select All Images.

To adjust a photo (adjustments modify only your printed copy, not the original file), select its
thumbnail image and select Adjustments. Make the necessary adjustments and press the 3 back
button.

To change the print settings, select Settings and select the necessary settings. When you are
finished, press the 3 back button.

When you are ready to print, press one of the & buttons.

Note: To cancel printing, press the @ Stop button.

Parent topic: Viewing and Printing From the LCD Screen

Related references
Photo Adjustment Options - Device Mode
Print Setting Options - Device Mode

Printing TIFF and PDF Files
You can select and print TIFF or PDF files from a USB flash drive.

1.
2.
3.

Press the M home button, if necessary.
Select Memory Device.

Select TIFF or PDF.

You see a list of the available files.
Select the file you want to print.

You see information about the file.
Select Proceed.

Do the following as necessary:

» To print more than one copy, use the numeric keypad on the control panel or press + or — on the
LCD screen to select the number of copies (up to 99).

» To change the print settings, select Settings and select the necessary settings. When you are
finished, press the 3 back button.

Select Proceed.
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8. When you are ready to print, press one of the < buttons.
Note: To cancel printing, press the @ Stop button.

Parent topic: Viewing and Printing From the LCD Screen

Related references
Print Setting Options - Device Mode

Photo Adjustment Options - Device Mode

Select the image adjustment options you want to use when viewing and printing photos displayed on the

LCD screen.
Photo Available options Description
adjustment
settings
Fix Photo On Automatically adjusts the brightness, contrast, and saturation
of the photo based on the Advanced > Scene Detection
setting that is selected
Off Turns off automatic adjustments; see Note below
P.l.M. Uses your camera's PRINT Image Matching or Exif Print
adjustments
Fix Red-Eye [ Off - This Image Automatically fixes the red-eye effect in photos
On - This Image
Off - All Image
On - All Image

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing From the LCD Screen
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Print Setting Options - Device Mode

Select the print settings you want to use when printing from a USB flash drive.

Note: Not all options or settings may be available, depending on the file format.

Print settings Available options Description
Paper Source Various paper size Select the paper source that contains the paper size and
and type settings type you want to print on
Quality Standard Provides good quality for most prints
Best Provides the highest quality for special prints
Date Various date formats | Prints the date the photo was taken on the photo in the
format you select
Fit Frame On Automatically crops the photo to fit into the selected photo
layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality
2-Sided On Select On to print PDF files double-sided. You can also
Off select the Binding Margin and Dry Time if necessary.
Print Order Last Page on Top Select the order for printing multi-page TIFF or PDF files

First Page on Top

Parent topic: Viewing and Printing From the LCD Screen

Transferring Files on a USB Device
You can transfer files to and from a USB device inserted into the USB port on the front of your product.

Setting Up File Sharing for File Transfers From Your Computer
Transferring Files from a USB Device to Your Computer

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Setting Up File Sharing for File Transfers From Your Computer

Before you transfer files from a computer to a USB device inserted into the USB port on the front of your
product, you may need to set up your product's file sharing settings.

Caution: Remove the USB device before you change this setting or you may lose data from the device.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Press the M home button, if necessary.

Select Setup.

Scroll down and select System Administration. Enter the administrator password, if necessary.
Select Printer Settings.

o kM wbd =

Select Memory Device Interface.

You see a screen like this:

Bt Memory Device Interface

| Menoey Devce [Enatle |
o starng use |

6. Make sure Memory Device is set to Enable.

7. Select File Sharing.

8. Select the way your computer is connected to the product: either USB or Network.
Parent topic: Transferring Files on a USB Device

Related tasks
Disconnecting a USB Device
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Transferring Files from a USB Device to Your Computer

You can transfer files to and from a USB device inserted into the USB port on the front of your product
and a computer connected to your product.

Note: Do not transfer files to and from a USB device while you are printing from the device.

Make sure your product is connected to a computer.
2. Insert a USB device into the USB port on the front of your product.
3. Do one of the following to access your USB device files from your computer:

* Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility, then
select the removable disk icon.

+ 0OS X with a USB connection: Look for the removable disk icon on your desktop, then select it.

+ OS X with a network connection: Select the hard drive icon on your desktop or select Computer
from the Go menu, select your product in the SHARED section of the sidebar (you may need to
widen the sidebar to see the name), and select the USBSTORAGE icon.

4. Select the folder that contains your files.
5. Drag the files you want to transfer to the desired folder on your computer or on your USB device.

Note: Your product's LCD screen does not update to display new information about your USB device
after you copy files to it or delete files from it. Remove and insert the USB device to update the
information.

Parent topic: Transferring Files on a USB Device

Related tasks
Connecting and Using a USB Flash Drive or External Device
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Replacing Ink Cartridges and Maintenance Boxes

The maintenance box stores ink that gets flushed from the system during print head cleaning. When an
ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges

Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Replacing the Maintenance Box

Check Cartridge and Maintenance Box Status

Your product and its software will let you know when an ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink cartridge and maintenance box status by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wf6590.

Checking Cartridge and Maintenance Box Status on the LCD Screen
Checking Ink and Maintenance Box Status With Windows
Checking Cartridge and Maintenance Box Status with OS X

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Cartridge and Maintenance Box Status on the LCD Screen

When one of your cartridges is low, you see the icon on the LCD screen and the orange { Status
light flashes.
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When a cartridge is expended, you see the B¢ icon and the orange { Status light stays on.
You can press the { Status button check the status of the cartridges and maintenance box.
1. Press the i Status button.

2. Select Printer Information.

You see a screen like this:

Feady:

7 1 10 1 1T

The ink and maintenance box levels are displayed at the bottom of the screen.
Note: The displayed ink and maintenance box levels are approximate.

3. For more information, select the ink cartridge images at the bottom of the screen.
Parent topic: Check Cartridge and Maintenance Box Status

Related tasks
Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Checking Ink and Maintenance Box Status With Windows
You can check your ink or maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop, double-click the product icon in the Windows
taskbar, and click Details.
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You see this window:

'i EPSOM Status Monitor 3 —
EPSON "
It s ready to prind.
-—
A
Hide Ink Levels Crlne Supgort
Irk Levels
l I |
Elack Yedow Magenta Cyan
Information
Mol benanoe Box Service Life
Prnit Queue o

2. Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If any of the ink cartridges installed in the product is broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

3. Todisable promotional offers, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

Monitoring Preferences : EPSON 7 )4
Select Motification
Event Screen Notification e
& Errer On
O communication Error Off
& Printer Selection Error On
O Ink Low Off o
(A Simple status notification Default
Select Shortout Icon

[ register the shortout icon to the taskbar

Double-dicking the Shortout Icon
opens the Printer Status Window.
[ Allow monitoring of shared printers

A Display Epson Offers
[~ Share my usage information with Epson

i o

4. Deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge and Maintenance Box Status

Checking Cartridge and Maintenance Box Status with OS X

You can check the status of your ink cartridges and maintenance box using a utility on your Mac.
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In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.
Select EPSON Status Monitor.
You see this window:

an Epson Printer Utility 4

G

Buy Epson Ink

EPSON o

!:. EPSOM Status Monitor

Can

Hak Masyrran Vallom

Imk Liwels

Information

2 |

Maintenance Box Service Life

Update . oK |

Do the following as necessary:
* You can update the ink cartridge and maintenance box status by clicking Update.
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* Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge and Maintenance Box Status

Related tasks
Removing and Installing Ink Cartridges
Replacing the Maintenance Box

Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com/ink3 (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge and Maintenance Box Part Numbers

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Ink Cartridge and Maintenance Box Part Numbers
Use these part numbers when you order or purchase a new maintenance box or ink cartridges.
Maintenance box part number: T671200

Note: For best printing results, use up a cartridge within 6 months after installing it.

Ink color Part number
Standard-capacity High-capacity Extra High-
capacity
Black 748 748XL 748XXL
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Ink color Part number
Standard-capacity High-capacity Extra High-
capacity
Cyan 748 748XL 748XXL
Magenta 748 748XL 748XXL
Yellow 748 748XL 748XXL

Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

Turn on your product.

2. Ifanink cartridge is low or expended, a message appears on your product and on your computer
screen. Note which cartridges need to be replaced.

3. Open the front cover.
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4. Pushin the ink cartridge that you want to replace.

The ink cartridge pops out slightly.
5. Pull the ink cartridge out of the slot.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,

flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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6. Remove the cartridge from the package.

>
7

~L

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

7. Gently shake the ink cartridge horizontally for about five seconds as shown.
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Caution: Do not remove any labels or seals, or ink will leak.

8. Insert the new cartridge into the holder and push it in until it clicks into place.

9. Ifyou see the Check option on the LCD screen, select it to make sure the cartridges are installed
correctly.

Caution: If you see a message that an ink cartridge is installed incorrectly, press in the ink cartridge
until it clicks into place.

10. When you are finished, close the front cover.
The product starts charging the ink and returns to its previous state when finished.

Note: Do not turn off the printer during ink replacement.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box
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Printing with Black Ink and Expended Color Cartridges
When a color ink cartridge is expended, you can temporarily continue printing from your computer using
black ink. Replace the expended color cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - OS X

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Printing with Expended Color Cartridges - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.
1. Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

Load plain paper or an envelope in your product.

Access the print settings in your print application.

Click the Main tab.

Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
Select the Black/Grayscale checkbox.

Click OK.

Print your document.

©® N o ok 0D

Epson Status Monitor 3 displays a print message.
9. Click Print in Black to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges
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Printing with Expended Color Cartridges - OS X

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.

1.
2.

Click the printer icon in the Dock.
If you see a message telling you that you can temporarily print with only black ink, click the Delete or
button to cancel your print job. If you see an error message, click OK.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

In the Apple menu or the Dock, select System Preferences.

Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

Select Driver or Options.
You see a screen like this:

General (el OEE Supply Levels  Utility
Ta takis full advaninge of your prnter's opsons, confinm that they s scoumtely
shewn heso. For infarmation on your prister and fs oplional hasdwane, check tho
printer's documasntation.
Thick papes and envelopes: | O =}
Skip Blank Page: | Of [}
Cuiot Moda: |_Of |}
Parmif temporary black printing: | Gf =)
High Spood Printing: | On =}
Warning Molifications: | On =]
Establish bidinctional communication: |_On =)
Lower Cassotio: | Moo |~}
Cancel | (L

Select On as the Permit temporary black printing setting.
Click OK.
Close the utility window.
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9. Load plain paper or an envelope in your product.

10. Access the print settings in your print application.

11. Select Print Settings from the pop-up menu.

12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.

14. Click Print to print your document.

Parent topic: Printing with Black Ink and Expended Color Cartridges

Conserving Low Black Ink with Windows

The following window appears when black ink runs low and there is more color ink.

[ EPSOM Status Monitor 3

Black ink is bow. You can extend black ink cartridge ife by printing with a
mixture of other colors ko create composite black,
Do you want to do this for the current print job?

Yes ]

[ ]

Disable this feature

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

» Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

+ Click Disable this feature to continue using the remaining black ink.
Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes
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Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week. Keep the maintenance box away from direct sunlight.

Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box. Do not remove the film on the box, or
ink may leak.

3. Open the rear cover 1 (D1).
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4. Grasp the maintenance box as shown and pull it out of its holder.

Note: Do not tilt the used maintenance box or take it apart.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep the maintenance box out of the reach of children and do not drink the ink.

5. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.
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6. Insertthe new maintenance box into the holder and push it all the way in.

5

7. Close the rear cover 1 (D1).

Parent topic: Replacing Ink Cartridges and Maintenance Boxes
Related concepts
Purchase Epson Ink Cartridges and Maintenance Box
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can clean and align the print head and run a nozzle check by using the printer buttons or the utilities

included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wf6590.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide Rollers

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality

Related topics
Replacing Ink Cartridges and Maintenance Boxes

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
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Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen.

Load a few sheets of plain paper in the product.

Press the M home button, if necessary.

Select Setup.

o &~ DN

Select Maintenance.
You see a screen like this:

o Martenance

Print Head Cleaning

l
| Print Head Allgnmend

|
|
|
I Thick Paper I
|

. Paper Guide Cleaning

6. Select Print Head Nozzle Check.
You see a screen like this:

'ﬁ Frint Head Hozzks Check

Load Letierdfid sizp
Plein Paper

to print
nozzie cheok patiem
Press HF .

7. Press the & Color button.
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The nozzle pattern prints.
8. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

9. Do one of the following:
« If there are no gaps, select Done.
+ Ifthere are gaps or the pattern is faint, select Clean the Print Head and continue.

10. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, turn off the product, if
possible, and wait at least 6 hours. Then try cleaning the print head again. If quality still does not
improve, one of the ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning

Related topics
Loading Paper
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Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

+ OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
You see a window like this:

L.V Nozzle Check H

To perform a nozde check, make sure that the printer is on and
connected to the computer. Also make sure that A4 or Letter size plan
paper is kpaded in the rear paper feed or the paper cassette, Click
[Print] to print & noxde dheck pattern or dick [Cancel] to quit.

Cancel Print

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

7. |Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning

Related topics
Loading Paper

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance
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Related tasks
Removing and Installing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.

Load a few sheets of plain paper in the product.

Press the M home button, if necessary.

Select Setup.

o &~ DN

Select Maintenance.

You see a screen like this:

o Martenance

[ Print Head Nozzle Check |

Prink Head Cleaning |

! Print Head Allgnmend |
I Thick Paper I

.. Paper Guide Cleaning

6. Select Print Head Cleaning.
You see a screen like this:

=4 Print Head Cleaning
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8.
9.

Press the & Color button to clean the print head.
When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

Select Print Nozzle Check Pattern.
Press the & Color button to confirm that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 4 times, turn off the product, if
possible, and wait at least 6 hours. Then try cleaning the print head again. If quality still does not
improve, one of the ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Cleaning the Print Head Using a Computer Utility

Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility

You can clean the print head using a utility on your Windows or Mac computer.

1.
2.
3.

Make sure there are no errors on the LCD screen.

Load a few sheets of plain paper in the product.

Do one of the following:

* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

+ OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

Select Head Cleaning.
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You see a window like this:

4 Head Cleaning "

\&. Click [Start] to dean the print head nozzies. Because deaning
consumes some ink, only dean the print head when fant areas or
gaps appear in your printout. Use the "Nozzle Chedk” utiity first to
confirm that the print head needs to be deaned. If the ink is kow or
expended, replace the cartridge first.

Start Canicel

5. Click Start to begin the cleaning cycle.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean




Print head needs cleaning

* If there are no gaps, click Finish.
« If there are gaps or the pattern is faint, click Clean to clean the print head again.

If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be
replaced. If you don’'t see any improvement after cleaning the print head up to 4 times, wait at least 6
hours without printing. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Cleaning the Print Head Using the Product Control Panel

Related topics
Loading Paper

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.

3. Press the M home button, if necessary.
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Select Setup.
Select Maintenance.
You see a screen like this:

= Martenance

* Print Head Hozzle Check |

Print Head Cleaning |
Print Head Allgnmend |

Thick Paper ]

. Paper Guide Cleaning

Select Print Head Alignment.

Do one of the following:

+ If vertical lines are misaligned, select Ruled Line Alignment.

« If your printouts look blurry, select Vertical Alignment.

+ If you see horizontal bands at regular intervals, select Horizontal Alignment.
Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

Check the printed patterns on the alignment sheet and do one of the following:

+ If you printed a ruled line alignment sheet, select the number of the pattern with the least
misaligned vertical line.
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* If you printed a vertical alignment sheet, select the number of the most solid printed pattern for
each set on the LCD screen.

I@II
1 3 4

« If you printed a horizontal alignment sheet, select the number of the pattern with the least amount
of separation or overlap on the LCD screen.

#1

1

n

Parent topic: Print Head Alignment

Related topics
Loading Paper

Cleaning the Paper Guide Rollers

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink. If
paper does not feed correctly from the rear paper feed slot, you can use a cleaning sheet to clean the
rollers.

1. Do one of the following:

+ If printouts are smeared or scuffed, load plain paper in the paper source that you want to clean in
this size: Letter (8.5 x 11 inches [216 x 279 mm]).

* If paper does not feed correctly from the rear paper feed slot, load the cleaning sheet that comes
with genuine Epson paper in the rear paper feed slot.

. Press the M home button, if necessary.
3. Select Setup.
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4. Select Maintenance.
You see a screen like this:

' Print Head Nozzle Check |

Print Head Cleaning |
Print Head Alignmend |

Thick Paper I
. Paper Guide Cleaning |

Scroll down and select Paper Guide Cleaning.

Select the paper source for the paper guide rollers you want to clean.
Press the & Color button.

Do one of the following:

® N o O

* If you loaded plain paper, repeat as necessary until the paper comes out clean..
+ If you loaded a cleaning sheet, repeat these steps up to 3 times.

Note: If the paper is not clean after cleaning several times, try cleaning the paper guide rollers for
the other paper sources.

Parent topic: Adjusting Print Quality

Related topics
Loading Paper
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.
Cleaning Your Product

Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

Turn off the product.

Unplug the power cord.

Disconnect any connected cables.

N~

Remove all the paper from the product.
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Clean the scanner glass and the glass area on the left with a soft, lint-free cloth (microfiber is
recommended) moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

Note: If lines appear on the printout or in scanned images, carefully clean the scanner glass on the
left.
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6. Raise the lever and open the ADF cover (F).
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7. Use a soft, dry, lint-free cloth (microfiber is recommended) to clean the rollers and the interior of the
ADF.

4 )

8. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it, prepare it for transportation as described here.

Caution: During transportation and storage, follow these guidelines:
» Use two or more people to lift the product.
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* When lifting the product, hold it as shown here. Holding other areas may cause the product to fall or
cause you to pinch your fingers when placing the product down.

» Leave the maintenance box installed; otherwise ink may leak.
+ Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

* Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.

Unplug the power cord.

Disconnect any connected cables.
Remove all the paper from the product.

Make sure there are no originals on the product.
Close the paper support and output tray.

No o bk owhd =

Remove the optional paper cassettes (if they are installed) before lifting the product.
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8. If you are transporting the product over a long distance, place the product in its original packing
materials, if possible, or use equivalent materials with cushioning around the product. Make sure the
box adequately protects the product control panel.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment

Related tasks
Removing and Installing Ink Cartridges
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Status Menu Error Codes

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Copying Problems

Solving Paper Problems

Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving Scanning Problems

Solving Scanned Image Quality Problems
Solving Faxing Problems

Solving USB Device Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site at (U.S. downloads or Canadian downloads).

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:

» Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
* On the Maintenance tab in the printer settings window
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http://www.epson.com/support
http://www.epson.ca/support

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending

on your version of Windows.

* OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Solving Problems

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also check for errors by pressing the i Status button to display the Status Menu.

Note: If the screen is dark, press the screen to wake the product from sleep mode.

LCD screen message

Condition/solution

Printer error. Turn the power off and
on again.

Turn the product off and then back on again. If the error
continues, check for and remove any paper jams or protective
materials from the product. If the error is still displayed, contact
Epson for support.

Printer error.

The product may be damaged. Contact Epson or an authorized
Epson service provider. Non-printing features such as scanning
may be available.

Cannot print because XX is out of
order. You can print from another
paper source.

Turn the product off and then back on again. Reinsert the
indicated paper cassette.

Maintenance rollers on XX are
nearing the end of their service life.

The maintenance rollers need to be replaced periodically for
optimal performance. (Paper may not feed correctly from the
paper cassette when the maintenance rollers are near the end of
their service life.)

Maintenance rollers on XX are at the
end of their service life.

Contact Epson to replace the maintenance rollers.

You need to replace the following ink
cartridge(s).

Replace the ink cartridge indicated on the LCD screen.
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LCD screen message

Condition/solution

No dial tone detected.

Make sure the phone cable is connected correctly and the
phone line works. If you connected the product to a PBX (Private
Branch Exchange) phone line or Terminal Adapter, change the
Line Type setting to PBX. If you still cannot send a fax, turn off
the Dial Tone Detection setting. (Turning off the Dial Tone
Detection setting may cause the product to drop the first digit of
a fax number.)

Failed to receive faxes because the
fax data capacity is full.

Received faxes may accumulate for the following reasons: a
product error has occurred or the incoming file cannot be saved
on the computer or memory device.

If a product error has occurred, press the { Status button and
select Printer Information to view details of the error.

To check whether received faxes have been saved, press the
{ Status button, select Job Monitor, and then select
Communication Job. To save received faxes, connect a
computer or memory device to the product.

Combination of IP address and
subnet mask is invalid.

There is a problem with the network connection to your product.

Recovery mode

An error has occurred during firmware updating. Connect your
product using a USB cable and try downloading the Firmware
Update from the Epson support site. If you still need help,
contact Epson for support.

Parent topic: Solving Problems

Related references
Where to Get Help

Related tasks
Checking for Software Updates

Removing and Installing Ink Cartridges

Selecting the Line Type

Connecting a Telephone or Answering Machine

Related topics
Wi-Fi or Wired Networking
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Status Menu Error Codes

If a job does not complete successfully, you can check the error code. Press the i Status button, select
Job History, and locate the incomplete job. Select the job to display the error code and additional

information.

Code

Condition/solution

001

The product was turned off by a power failure.

101

Memory is full. Reduce the size of the print job.

102

Collated printing has failed due to a lack of available memory. Clear fonts and macros
from the product's memory using the Clear Font and Macro option from the Setup menu,
reduce the size of the print job, or print one copy at a time.

103

Print quality was decreased due to a lack of available memory. If the quality of the printout
is unacceptable, try simplifying the page by reducing the number of graphics or the
number and size of the fonts.

104

Reverse printing has failed due to a lack of available memory. Clear fonts and macros
from the product's memory using the Clear Font and Macro option from the Setup menu
or reduce the data size of the print job.

106

Cannot print from the computer due to access control settings. Contact your product
administrator.

107

User authentication failed and the job has been canceled. Contact your product
administrator.

108

Confidential job data was deleted when the product was turned off.

109

The received fax was already deleted.

110

The job was printed 1-sided because the loaded paper does not support 2-sided printing.

111

Available memory is running low. Reduce the size of the print job.

201

The product's memory is full. You can send pages individually, or print received faxes and
delete them to free up memory space.

202

The line was disconnected by the recipient's fax machine. Wait a moment, then try again.
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Code

Condition/solution

203 The product cannot detect a dial tone.
Make sure the phone cable is connected correctly and the phone line works. If you
connected the product to a PBX (Private Branch Exchange) phone line or Terminal
Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
Dial Tone Detection setting. (Turning off the Dial Tone Detection setting may cause the
product to drop the first digit of a fax number.)

204 The recipient's fax machine is busy. Wait a moment, then try again.

205 The recipient's fax machine does not answer. Wait a moment, then try again.

206 The phone cable is incorrectly connected to the product's LINE and EXT ports. Connect
the phone cable correctly.

207 The phone cable is not connected. Connect the phone cable.

208 The fax could not be sent to some of the specified recipients.
Print a fax log to check which recipients failed to receive the fax. If the Save Failure Data
setting is turned on, you can resend a fax from Job Monitor in the Status menu.

301 There is not enough storage space available to save the data on the external memory

401 device. Clear space on the device or use a different device.

302 The external memory device is write-protected. Disable write protection.

402

303 No folder is available for saving the scanned file. Create a folder or use a different
memory device.

304 The external memory device has been removed. Reinsert the device.

404

305 An error occurred while saving data to an external memory device. Reinsert the memory
device or use a different device.

405

306 The product's memory is full. Wait until current jobs are finished processing.

311 A DNS error has occurred. Check the DNS settings for the server, computer, or access

391 point. DNS settings for the server can be checked from the DNS Server option in the
Setup menu.

411

421
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Code

Condition/solution

312 An authentication error has occurred. Check the Server Settings from the Setup menu.

412

313 A communication error has occurred. Check the Server Settings or network connection by

413 running a connection check. If you selected Off as the authentication method, make sure
to select None for the email server authentication method.

314 The data size exceeds the maximum size for the attached files. Increase the Attached
File Max Size setting in the scan settings or lower the file size of the scanned image.

315 The memory is full. Retry after other ongoing jobs have finished.

327

322 An authentication error occurred. Check the Location settings.

323 A communication error has occurred. Check the Location settings or the network
connection.

324 A file with the same name already exists in the specified folder. Delete the duplicate file or
change the file name prefix in File Settings.

325 There is not enough storage space available in the specified folder. Increase the storage
space in the specified folder, delete unnecessary files, or reduce the file size of the
scanned image.

328 The destination was wrong or the destination does not exist. Check the Location
settings.

331 A communication error occurred while acquiring the destination list. Make sure the
product is connected to the network correctly.

332 There is not enough space available for saving the scanned files in the specified folder.
Delete unnecessary files from the specified folder.

333 The destination could not be found because the destination information was uploaded to
the server before sending the scanned data. Select the destination again.

334 An error occurred while sending the scanned data.

341 A communication error has occurred. Make sure the product is connected to the computer

or network correctly. Make sure you have installed Document Capture Pro or Document
Capture. Make sure the Event Manager program is not being blocked by your firewall or
security software.
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Code Condition/solution

422 An authentication error has occurred. Make sure the settings are correct for the folder
selected in the Where to Forward setting in the Setup menu.

423 A communication error has occurred. It is also possible that a file with the same name is
open or the file is a read-only file.

Check the network connection, make sure the settings are correct for the folder selected
in the Where to Forward setting in the Setup menu, close the duplicate file, or disable
read-only protection.

425 There is not enough storage space available in the forwarding destination folder. Increase
the storage space in the destination folder.

428 The destination was wrong or the destination does not exist. Make sure the settings are
correct for the folder selected in the Where to Forward setting in the Setup menu.

Parent topic: Solving Problems

Related tasks

Connecting a Telephone or Answering Machine
Selecting the Line Type

Viewing a Saved Fax

Selecting Advanced Fax Settings

Setting User Feature Restrictions (Access Control)
Entering a User ID and Password for Printing

Related topics
Sending Faxes
Wi-Fi or Wired Networking

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.

Load plain paper in the product.

Press the M home button, if necessary.

Select Setup.

o &~ N

Select Maintenance.
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You see a screen like this:

=1 Makntenance

;' Print Head Nozzle Check |

———

Print Head Cleaning |
l [
| Print Head Allgnmen |

|
I Thick Paper I

: |
Paper Guide Cleaning |

Select Print Head Nozzle Check.
You see a screen like this:

=} Print Head Mozzke Check

Losad Letierffid sizp
Plein Paper

to print
noezhe check patiem
Press B .

Press the & Color button.
The nozzle pattern prints.
Do one of the following, depending on the results of the product check:

+ If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

+ If the page prints but the nozzle check pattern has gaps, clean or align the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.
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Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Head Alignment

Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

Press the M home button, if necessary.
Select Setup.
Scroll down and select System Administration. Enter the administrator password, if necessary.

o nh =~

Scroll down and select Restore Default Settings.
You see a screen like this:

B Restone Default Settigs

Metwork Seilings

| J
| Cowy Setings |
Scan Seftings ]
l

J

| FaSetiings

| Clear Al Data and Settings

5. Select one of these options:
* Network Settings: Resets all network settings.
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+ Copy Settings: Resets all settings for copying.
+ Scan Settings: Resets all settings for scanning.
» Fax Settings: Resets all settings for faxing.
+ Clear All Data and Settings: Resets all control panel settings including the contacts list.
You see a confirmation screen.
6. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Product Does Not Turn On or Off
Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

* If you cannot turn on your product, make sure the power cord is securely connected and hold down
the power button a little longer.

* If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off
your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

» The first time you install the ink cartridges, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on.

« If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.
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Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

* Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

* If you are printing over a network, make sure your product is set up properly on the network.
Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references

Windows System Requirements
OS X System Requirements

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in OS X Printer Window

Cannot Print Over a Network

Cannot Scan Over a Network
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Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

350



Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Printing a Network Status Sheet
Selecting Wireless Network Settings From the Control Panel

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

* Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

» Make sure your product is not connected to a guest network.

* If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

« If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems
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Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window

If your product does not appear in the OS X printer window, try these solutions:

Turn your product off, wait 30 seconds, then turn it back on again.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna
icon with connection bars on your LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.
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If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD is not lit, make sure you select one of the WPS options from the product control panel
within 2 minutes of pressing the WPS button on your router.

Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
+ Try connecting with a different Ethernet cable.
» Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks

Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking
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Cannot Scan Over a Network
If you cannot start Epson Scan for scanning over a network, try these solutions:

« If you cannot scan from your product control panel, make sure you restarted your computer after
installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

 If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

 If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few
seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan again.

» Check the connection setting and test the connection using Epson Scan Settings:
Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the Connection setting is set to Network, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the Connection setting is set to Network, then click the Test button.

* If the user restriction feature (Access Control) is enabled, a user ID and password are required to
scan. If you do not know the user ID or password, contact your administrator for assistance.

» Make sure the option selected as the Timeout Setting in the Epson Scan Settings program is long
enough to complete scanning over a network.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems
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Related tasks

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan Icon
Entering a User ID and Password for Printing

Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Originals Do Not Feed From the Automatic Document Feeder

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

« If the nozzle check page does not print, but the product's power is on, make sure your product
software is installed correctly.

* Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder
If your originals do not feed when placed in the ADF, try these solutions:
» Make sure the ADF icon appears on the LCD screen. If not, reload the originals.
* Make sure the size, weight, and number of your originals are supported by the ADF.
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* Make sure the originals are loaded correcily.
» Try cleaning the inside of the ADF.
Parent topic: Solving Copying Problems

Related references

Document Jams in the Automatic Document Feeder (F)
Automatic Document Feeder (ADF) Specifications
Related tasks

Placing Originals in the Automatic Document Feeder
Cleaning Your Product

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)

Paper Jam Problems in the Front Paper Feed Slot (B2)

Paper Jam Problems in the Cassette (C1/C2/C3)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)

Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

+ If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette or rear feed slot.

« If paper does not feed from the rear feed slot, try cleaning the paper guide using an Epson cleaning
sheet.

* Be sure to insert the paper cassette all the way into your product.
« If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
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 If multiple pages continue to feed at once, turn on the Paper Feed Assist Mode setting in the Setup >
System Administration > Printer Settings menu.

* Do not load more than the recommended number of sheets.

» Make sure your paper meets the specifications for your product.

 If paper jams when you print on both sides of the paper, try loading fewer sheets.

» Make sure the paper size and paper type settings are correct for the paper source.

* If you installed an optional paper cassette unit, be sure to enable the cassette unit in the printing
software.

* If your product pauses during printing, make sure the front cover is closed.
» For best results, follow these guidelines:
* Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
» Load paper in the cassette printable side down.
* Do not load binder paper with holes in the cassette.
» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)
Paper Loading Capacity

Paper Specifications

Related tasks

Cleaning the Paper Guide Rollers

Related topics
Loading Paper
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Paper Jam Problems in the Front Cover (A)
If paper has jammed in the front cover, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Open the front cover.

Caution: Be careful to not touch any parts inside the product to prevent damage to it.

4. Close the front cover.
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5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Note: If any torn pieces of paper remain in the product, select Menu > Maintenance > Remove
Paper after clearing the paper jam error.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Rear Paper Feed Slot (B1)

Paper Jam Problems in the Front Paper Feed Slot (B2)

Paper Jam Problems in the Cassette (C1/C2/C3)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)

Paper Jam Problems in the Rear Paper Feed Slot (B1)

If paper has jammed in the rear paper feed slot, carefully remove the paper.

1 M

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Front Paper Feed Slot (B2)

Paper Jam Problems in the Cassette (C1/C2/C3)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)
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Paper Jam Problems in the Front Paper Feed Slot (B2)
If paper has jammed in the front paper feed slot, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Close the output tray.
3. Remove the output tray and pull out the paper cassette.

4. Pull the lever to lower the cover.

360



5. Carefully remove any paper jammed inside the product.

6. Raise the cover.
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7. Reattach the output tray and insert the paper cassette.

8. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)

Paper Jam Problems in the Cassette (C1/C2/C3)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
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Document Jams in the Automatic Document Feeder (F)

Paper Jam Problems in the Cassette (C1/C2/C3)

If paper has jammed in the cassette, follow the steps here to clear the jam.

Note: If the optional paper cassettes are installed, do not remove more than one paper cassette ata
time.

1. Cancel the print job, if necessary.
2. Pull out the paper cassette.
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3. Carefully remove any paper jammed inside the product.

4. Carefully follow all paper loading instructions and reload the paper.
5. Keep the cassette flat as you gently insert it.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)

Paper Jam Problems in the Front Paper Feed Slot (B2)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)

Paper Jam Problems in the Rear Cover 1 (D1)
If paper has jammed in the rear cover 1, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
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2. Open rear cover 1 (D1).

Caution: Do not touch the paper feed mechanism.
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4. Pull out rear cover 2 (D2).

5. Remove any jammed paper from the duplexer.

6. Replace rear cover 2 (D2).
7. Close rear cover 1 (D1).

8. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
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Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Document Jams in the Automatic Document Feeder (F)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
If paper has jammed in any of the optional paper cassettes, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Open rear cover (E) on the optional paper cassette unit with the jammed paper.

4. Close rear cover (E).
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5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Cover (A)

Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Document Jams in the Automatic Document Feeder (F)

Document Jams in the Automatic Document Feeder (F)

If you have problems with document jams in the automatic document feeder (ADF), follow the steps here
to clear the jam.

1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Raise the lever and open the ADF cover.
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ny jammed pages.

4. Carefully remove a
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5. Close the ADF cover, then raise the document cover.
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. Carefully remove any jammed pages.

(

. Lower the document cover.
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8. Raise the ADF input tray and carefully remove any jammed pages.

9. Lower the ADF input tray.
10. Reload your originals.

Caution: Make sure you do not load the ADF beyond its capacity for your paper size. Also make sure
your originals are not bent, folded, or curled and do not have tape, staples, or other materials that
could obstruct the feeder.

11. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
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Paper Jam Problems in the Front Paper Feed Slot (B2)

Paper Jam Problems in the Cassette (C1/C2/C3)

Paper Jam Problems in the Rear Cover 1 (D1)

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Solving PCL/PostScript Problems
Check these sections if you have problems with the PCL or PostScript printer software.

Nothing Prints Using the Postscript Printing Software
Documents Print Incorrectly Using the Postscript Printing Software
Accessing Printer Properties - Postscript - Windows

Parent topic: Solving Problems

Nothing Prints Using the Postscript Printing Software
If your document doesn't print, try these solutions:
* Make sure your product is turned on and properly connected.
» Make sure the printing language setting on the control panel is correct.

» If Text Detection is enabled on the control panel and you cannot print text, set the printing language
to PS3.
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* Make sure your product is selected as the printer in your printing program.

* In Windows, the product may not print if a large number of print jobs are sent. Try selecting Print
directly to the printer on the Advanced tab in the printer properties.

Parent topic: Solving PCL/PostScript Problems

Related tasks
Accessing Printer Properties - Postscript - Windows

Related topics
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Documents Print Incorrectly Using the Postscript Printing Software
If your document does not print correctly, try these solutions:

« If the file you are printing was created in an application that allows you to change the data format, such
as Adobe Photoshop, make sure the settings in the application match the printer software settings.

* EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.

* In Windows, the product cannot print binary data if it is connected to the computer using a USB cable.
Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer
properties.

* In Windows, select the appropriate substitution fonts on the Device Settings tab in the printer
properties.

« If the printed colors are incorrect, try adjusting the Color Mode setting on the Advanced tab of the
printer software.

+ If printing is slow, try selecting Fast as the Print Quality setting on the Advanced tab of the printer
software.

Parent topic: Solving PCL/PostScript Problems

Related tasks
Accessing Printer Properties - Postscript - Windows
Accessing Printer Properties - Postscript - Windows

Accessing Printer Properties - Postscript - Windows
You can access the printer properties to view and change product settings.
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1. Do one of the following:

* Windows 10: Right-click H and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click the postscript driver for your product, and select Printer
properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click the postscript driver for your
product and select Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click the postscript driver for your product and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click the postscript driver for your
product and select Properties.

2. Click any tab to view and change the printer property settings.
Parent topic: Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
» Make sure your product is turned on.
* Make sure any interface cables are connected securely at both ends.
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If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

If you are printing a large image, the computer may not have enough memory. Print the image at a
lower resolution or a smaller file size.

In Windows, click Print Queue on the Maintenance tab in the printer settings window and check for
the following:

» Check for any stalled or paused print jobs. Cancel or unpause any jobs as necessary.
* Open the Printer menu and make sure the product is not offline.
» Open the Printer menu and set the product as the default printer, if necessary.

In OS X, select System Preferences from the Apple menu or Dock, select Print & Scan or Printers
& Scanners, then double-click your printer icon. Check to see if any jobs are paused. Cancel or
resume any jobs as necessary.

If the user restriction feature (Access Control) is enabled, a user ID and password is required to print.
If you do not know the user ID or password, contact your administrator for assistance.

Note: In OS X, you may not be able to print if the user restriction feature is enabled. Contact your
administrator for assistance.

If you are using AirPrint, make sure AirPrint is enabled with the correct settings using Web Config.

Parent topic: Solving Problems Printing from a Computer

Related tasks

Running a Product Check

Using AirPrint

Entering a User ID and Password for Printing

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

* Windows 10: Right-clickn and select Control Panel > Hardware and Sound > Devices and
Printers.
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+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.

* Windows 7: Click E]' and select Devices and Printers.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and Printers and Faxes.)

Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3, then click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.
Click OK to close the open program windows.

Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.

If you are using OS X, make sure you download and install the Epson printer driver.
Make sure Quiet Mode is turned off.

Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.
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For the fastest printing, select the following settings in your product software:

* Make sure the paper type setting matches the type of paper you loaded.

» Turn on any high speed settings in your product software.

» Select a lower print quality setting.

» Make sure the ink drying time has not been increased for double-sided printing.

» Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

» High Speed Copies
» Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap
Parent topic: Solving Problems Printing from a Computer

Related references

Paper or Media Type Settings - Printing Software
Windows System Requirements

OS X System Requirements

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image

Too Many Copies Print
Blank Pages Print

Incorrect Margins on Printout
Incorrect Characters Print
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Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.
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* Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.
» Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
» Make sure any cables are securely connected at both ends.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

« If your product is connected to a USB hub, connect it directly to your computer instead.
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« If your computer entered sleep mode the last time you printed, the next print job after your computer
exits sleep mode may contain garbled characters. Print your document again.

« Ifincorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

* Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

* Make sure you selected the correct paper size on the control panel.

» Make sure your paper is positioned correctly for feeding into the printer.

+ Clean the scanner glass and document cover.

You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - OS X

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Windows

Selecting Page Setup Settings - OS X

Cleaning Your Product

Slanted Printout
If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
» Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
» Align the print head.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
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Selecting Basic Print Settings - Windows

Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

+ Align the print head.

* You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning
Print Head Nozzle Check
Print Head Alignment
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Related references

Paper or Media Type Settings - Printing Software
Related tasks

Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - OS X

Related topics
Loading Paper
Replacing Ink Cartridges and Maintenance Boxes

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:

Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Use a support sheet with special paper, or load special paper one sheet at a time.

Make sure your paper meets the specifications for your product.

Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

Make sure the paper type setting in your product software matches the type of paper you loaded.
Make sure you loaded the printable side of the paper correctly for your product.

If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel
or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

In Windows, if the paper is still smeared after selecting the Thick Paper and Envelopes setting,
select the Short Grain Paper setting in the Extended Settings of the printer software.

Remove each sheet from the output tray as it is printed.
Avoid handling printouts on glossy paper right after printing to allow the ink to set.
Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increase Ink Drying Time settings.

If printed copies are smeared, lower the copy density setting on the product control panel.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.
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+ Align the print head.
* Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning

Print Head Alignment

Related references

Paper Specifications

Available Epson Papers

Double-sided Printing Options - Windows

Related tasks

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Selecting Double-sided Printing Settings - OS X
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - OS X

Cleaning the Paper Guide Rollers

Related topics

Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* The ink cartridges may be old or low on ink, and you may need to replace them.
* Make sure the paper type setting matches the type of paper you loaded.
» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Align the print head.
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Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references

Paper or Media Type Settings - Printing Software
Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X

Cleaning the Paper Guide Rollers

Related topics
Loading Paper
Replacing Ink Cartridges and Maintenance Boxes

Grainy Printout
If your printouts are grainy, try these solutions:

Make sure you loaded the printable side of the paper correctly for your product.
Select a higher print quality setting and turn off any high speed settings in your product software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.
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Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - OS X

Selecting Printing Preferences - OS X

Selecting Additional Layout and Print Options - Windows

Related topics
Loading Paper

Incorrect Colors

If your printouts have incorrect colors, try these solutions:

Make sure the paper type setting matches the paper you loaded.
Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.

If you selected Standard-Vivid (Windows) or Normal-Vivid (OS X) as the quality setting in the printer
software, try selecting Standard (Windows) or Normal (OS X) instead.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

The ink cartridges may be old or low on ink, and you may need to replace them.

After you print, the colors in your printout need time to set as the ink dries. During this time, the colors
may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

For best results, use genuine Epson ink and paper.
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Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Related references
Available Epson Papers

Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Managing Color - OS X

Related topics
Replacing Ink Cartridges and Maintenance Boxes

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

» Make sure your computer has adequate memory and meets the system requirements for your
operating system.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

« If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).
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Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
OS X System Requirements

Related tasks
Scanning with OS X Using Image Capture

Cannot Start Epson Scan
If you cannot start Epson Scan, try these solutions:
» Make sure your product is turned on and any interface cables are securely connected at both ends.
* Make sure Epson Scan is selected in your scanning program.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan.

» Check the connection setting and test the connection using Epson Scan Settings:

Windows 10: Click E and select All apps. Select EPSON, then select EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the correct
Connection setting is selected, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

* Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions
and install one version.

+ If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

* If the user restriction feature (Access Control) is enabled, a user ID and password are required to
scan. If you do not know the user ID or password, contact your administrator for assistance.
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Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems

Related tasks

Scanning with OS X Using Image Capture

Entering a User ID and Password for Scanning - Windows
Starting a Scan Using the Epson Scan Icon

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked

Image is Distorted or Blurry

Image Colors are Patchy at the Edges

Image is Too Dark

Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image

Scanned Image Colors Do Not Match Original Colors
Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
* Make sure you placed your original for scanning facing the correct way.

+ If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and
scan again.

Parent topic: Solving Scanned Image Quality Problems
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Related references
Available Image Adjustments - Office Mode

Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:

» Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the
scanner glass.

* Do not move your original or your product during scanning.

* Your product will not operate properly while tilted at an angle. Place your product on a flat, stable
surface that extends beyond its base in all directions.

» Adjust these Epson Scan settings (if available) and try scanning again:
+ Select the Unsharp Mask setting.
+ Adjust the Auto Exposure setting.
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* Increase the Resolution setting.
Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.

Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark

If your scanned image is too dark, try these solutions:

» Adjust these Epson Scan settings (if available) and try scanning again:
» Auto Exposure
* Brightness
* Histogram Adjustment

+ Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:

+ Select the Descreening setting.
+ Select a lower Resolution setting.
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Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try
scanning again:

+ Change the Image Type setting and experiment with different combinations of the next settings.
+ Adjust the Tone Correction setting.

* Adjust the Auto Exposure setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scan Area is Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:
» Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
+ Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems

Related tasks
Selecting a Scan Area - Office Mode
Selecting a Scan Size - Professional Mode

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems
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Related topics
Placing Originals on the Product

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes

Cannot Receive Faxes with a Telephone Connected to Your Product
Fax Memory Full Error Appears

Sent Fax Quality is Poor

Sent Fax is Received in an Incorrect Size

Received Fax Quality is Poor

Received Fax is Not Printed

Parent topic: Solving Problems

Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:

If an error code is displayed on the control panel, try the solutions suggested in the error code list.
If you are faxing from a computer, use the Epson FAX Utility to send your fax.

Make sure the recipient's fax machine is turned on and working.

Make sure paper is loaded correctly in your product.

Make sure you have set up your header information and have not blocked your caller ID. Otherwise,
your faxes might be rejected by the recipient's fax machine.

If user restriction has been enabled, you may need to enter a user name and password. Contact your
administrator for assistance.

If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can
receive faxes automatically.

Check that the cable connecting your telephone wall jack to your product's LINE port is secure.

Print a fax connection report using your product control panel or fax software to help diagnose the
problem.

Verify that the telephone wall jack works by connecting a phone to it and testing it.

If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line
or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
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turn off the product's dial tone detection setting. (Turning off the dial tone setting may cause the
product to drop the first digit of a fax number.)

« If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to
enable faxing over the line. Contact your DSL provider for the necessary filter.

« If your telephone line has static, turn off your product's error correction mode fax communication
setting and try faxing again.
» Try lowering your product's fax speed setting.

» Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a
color fax.

« If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to
prevent disruption of incoming faxes.

+ If you have subscribed to a call forwarding service, the product may not be able to receive faxes.
Contact your service provider for assistance.

» Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot
receive faxes.

 If you cannot send faxes at a specified time, make sure the date and time are set correctly on the
product.

Note: Do not turn the product off while it is receiving a fax. Otherwise, the fax transmission will be lost.

Note: If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VolP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems

Related references

Status Menu Error Codes

Related tasks

Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard

Selecting the Line Type

Selecting Advanced Fax Settings
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Receiving Faxes Automatically
Printing Fax Reports
Viewing a Saved Fax

Related topics
Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product
If you cannot receive faxes when a telephone is connected to your product, try these solutions:
» Make sure your telephone is connected to your product's EXT port.
* Make sure the Receive Mode is set to Manual.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard

Fax Memory Full Error Appears
If you see an error message telling you that the product's fax memory is full, try these solutions:

* If you set the product to save received faxes in the product's memory or inbox, delete any faxes you
have already read.

 If you set the product to save received faxes on a computer, turn on the selected computer. Once the
faxes are saved on the computer, they are deleted from the product's memory.

+ If you set the product to save received faxes on a memory device, connect the selected memory
device containing the save fax folder to the product. Once the faxes are saved on the memory device,
they are deleted from the product's memory.

Note: Make sure the memory device has enough available memory and is not write protected.

+ If the memory is full, try sending a monochrome fax using the Direct Send feature or sending your
faxes in smaller batches.
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« If the product cannot print a received fax due to a product error, such as a paper jam, the memory full
error may appear. Clear any product errors, then ask the sender to resend the fax.

Parent topic: Solving Faxing Problems

Related references
Output Settings - Fax
Fax Sending Options

Related tasks
Viewing a Saved Fax

Sent Fax Quality is Poor
If the sent fax quality is poor, try these solutions:
* Clean the scanner glass.
* Clean the ADF.
* Try changing the resolution setting on the control panel.
» Try adjusting the density setting on the control panel.

* If you are sending a monochrome fax to a single recipient, try sending the fax using the Direct Send
feature.

Note: If you send a high-resolution monochrome fax without using the Direct Send feature, the
product may automatically lower the resolution.

» Try enabling the error correction mode (ECM) setting.
Parent topic: Solving Faxing Problems

Related references

Fax Sending Options

Basic Settings - Fax

Related tasks

Cleaning Your Product
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Sent Fax is Received in an Incorrect Size
If your recipient receives a fax in an incorrect size, try these solutions:

« If you are sending a fax using the scanner glass, make sure your original is placed correctly on the
scanner glass and that the correct paper size is selected on the control panel.

» Clean the scanner glass and document cover.
Parent topic: Solving Faxing Problems

Related tasks
Placing Originals on the Scanner Glass
Cleaning Your Product

Received Fax Quality is Poor
If you receive a poor quality fax, try these solutions:
» Try enabling the error correction mode (ECM) setting.
+ Contact the fax sender and ask them to send the fax in a higher resolution.
* Try reprinting the received fax.
Parent topic: Solving Faxing Problems

Related references
Basic Settings - Fax

Received Fax is Not Printed
If a received fax is not printed, try these solutions:

» Make sure the product is clear of any errors. The product cannot print received faxes if an error has
occurred with the product, such as a paper jam.

« Ifthe product has been set to save received faxes in the product's memory or inbox, received faxes
are not automatically printed. Check the Fax Output setting on the product control panel and change
it, if necessary.

Parent topic: Solving Faxing Problems

Related references
Output Settings - Fax
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Solving USB Device Problems

Check these solutions if you have problems using USB devices with your product.

Cannot View or Print from a USB Device
Cannot Save Files on a USB Device
Cannot Transfer Files To or From a USB Device

Parent topic: Solving Problems

Cannot View or Print from a USB Device

If you cannot view or print photos or documents from a USB device inserted in your product, try these
solutions:

* Make sure memory devices are enabled on the product.

» Make sure your device is compatible with the product.

* Make sure the files on your device are in the correct format.
Parent topic: Solving USB Device Problems

Related references
Interface Specifications
USB Device Photo File Specifications

Related tasks
Setting Up File Sharing for File Transfers From Your Computer

Related topics
Viewing and Printing From the LCD Screen

Cannot Save Files on a USB Device
If you cannot save files on a USB device inserted in your product, try these solutions:

» To save faxes on a USB device, you need to create a folder in the Fax Output settings on the product
control panel.

» Make sure the device is not write-protected.

* Make sure the device has enough available space.

* Make sure memory devices are enabled on your product.
* Make sure the device is compatible with the product.
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Parent topic: Solving USB Device Problems

Related references
Output Settings - Fax
Interface Specifications

Related tasks
Setting Up File Sharing for File Transfers From Your Computer

Cannot Transfer Files To or From a USB Device

If you have problems transferring files to or from a USB device inserted in your product, try these
solutions:

» Make sure your device is compatible with the product.

* Make sure your product is securely connected to your computer.

» Make sure that the file sharing setting for your product is set correctly.
Parent topic: Solving USB Device Problems

Related references
Interface Specifications

Related topics
Transferring Files on a USB Device

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - OS X

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.

398



Do one of the following:

* Windows 10: Right click IEI and select Control Panel > Programs > Programs and Features.
Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
* Windows 10: Select Epson Event Manager and click Uninstall.

» Windows 8.x: Select Epson Event Manager and click Uninstall.

* Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and
Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

* Windows XP: Open the Windows Control Panel utility. Double-click Add or Remove Programs.
Select Epson Event Manager and click Change/Remove.

Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:

* Windows 10: Select EPSON Scan and click Uninstall.

* Windows 8.x/Windows 7/Windows Vista: Select EPSON Scan and click Uninstall/Change.
* Windows XP: Select EPSON Scan and click Change/Remove.
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6. Restart your computer, then see the Start Here sheet to re-install your software.
Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.

Double-click the Uninstaller icon.

Select the checkbox for each software program you want to uninstall.
Click Uninstall.

Follow the on-screen instructions to uninstall the software.
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To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software
Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.
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Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

» U.S.:(5662) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

+ Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Windows System Requirements
OS X System Requirements
Scanning Specifications

Automatic Document Feeder (ADF) Specifications
Fax Specifications

Paper Specifications

Printable Area Specifications

Ink Cartridge Specifications
Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications
PostScript Fonts

PCL Fonts

Symbol Sets

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10

* Windows 8.x

* Windows 7

* Windows Vista
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* Windows XP Professional x64 Edition
* Windows XP SP3

* Windows Server 2012R2

* Windows Server 2012

* Windows Server 2008R2

* Windows Server 2008

* Windows Server 2003R2

* Windows Server 2003

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
+ OS X 10.10.x

OS X 10.9.x

OS X 10.8.x

OS X 10.7.x

0S X10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Scanning Specifications

Scanner type Flatbed
Photoelectric device CIS
Effective pixels 10200 x 16800 pixels at 1200 dpi
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Document size
Scanning resolution

Output resolution

Color depth

Light source

Maximum: 8.5 x 14 inches (215.9 x 355.6 mm); legal-size
1200 dpi (main scan)

2400 dpi (sub scan)

50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)

Color: 10 bits per pixel per color internal, 8 bits per pixel per color
external

Black and white: 10 bits per pixel per color internal, 1 or 8 bits per
pixel per color external

LED

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

Paper size

Paper type
Paper weight
Sheet feeding capacity

Minimum size: A6 (4.1 x 5.8 inches [105 x 148 mm]) landscape
Maximum size: Legal (8.5 x 14 inches [216 x 356 mm])

Plain paper

14 1b (52 g/m?) to 28 Ib (105 g/m?)

Total thickness: 0.12 inch (3 mm)

Approximately 50 sheets

Parent topic: Technical Specifications

Fax Specifications

Fax type

Support line

Speed

Walk-up black-and-white and color fax capability (ITU-T Super
Group 3)

Standard analog telephone lines
PBX (Private Branch Exchange) telephone systems
Up to 33.6 kbps
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Resolution Monochrome
Standard: 203 x 98 dpi
Fine: 203 x 196 dpi
Super Fine: 203 x 392 dpi
Ultra Fine: 406 x 392 dpi
Photo: 203 x 196 dpi
Color
Fine: 200 x 200 dpi
Photo: 200 x 200 dpi

Page memory Up to 550 pages (ITU-T No. 1 chart in monochrome draft mode)

Redial 2 times (with 1 minute intervals); specifications may differ by country
or region

Interface RJ-11 Phone Line

RJ-11 Telephone set connection
Parent topic: Technical Specifications

Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)
Thick paper: 25 Ib (91 g/m?) to 68 Ib (256 g/m?)

Envelopes

Size No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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Weight 20 Ib (75 g/m?) to 24 Ib (90 g/m?)
Parent topic: Technical Specifications

Printable Area Specifications
Note: Print quality may decline in the shaded areas shown here.

Single sheets
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1 Top/bottom/sides: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.81 inch (46 mm) minimum
3  Reduced print quality area/bottom: 2.01 inches (51 mm) minimum
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Envelopes
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Sides: 0.12 inch (3 mm) minimum
Top/bottom: 0.20 inch (5 mm) minimum
Reduced print quality area/right: 2.01 inches (51 mm) minimum
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Reduced print quality area/left: 1.81 inch (46 mm) minimum
Parent topic: Technical Specifications
Ink Cartridge Specifications

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Cyan, Magenta, Yellow, Black
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired
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Temperature

Storage: 4 to 104 °F (-20 to 40 °C)

1 month at 104 °F (40 °C)

Ink freezes at -9.4 °F (-23 °C)

Ink thaws and is usable after 3 hours at 77 °F (23 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Dimension Specifications

Product Only

Height

Width

Depth

Weight

(without ink cartridges or power

cord)

Stored: 20.2 inches (514 mm)
Printing: 21.3 inches (540 mm)
Stored: 20.3 inches (516 mm)
Printing: 20.3 inches (516 mm)
Stored: 20.6 inches (522 mm)
Printing: 29.8 inches (756 mm)
68.3 Ib (31 kg)

Product with Optional Cassettes (2)

Height

Width

Depth

Stored: 30.3 inches (770 mm)
Printing: 31.3 inches (796 mm)
Stored: 20.3 inches (516 mm)
Printing: 20.3 inches (516 mm)
Stored: 20.7 inches (527 mm)
Printing: 29.8 inches (756 mm)
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Weight 108.5 Ib (49.2 kg)

(without ink cartridges or power
cord)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100to 240V
Rated frequency range 50/60 Hz
Rated current 100to 240 V model: 1.2-0.6 A

Power consumption (with USB Printing: Approx. 36 W (ISO/IEC24712)
connection)

(100 to 240 V model)

Ready mode: Approx. 16 W
Sleep mode: Approx. 2.7 W
Power off mode: Approx. 0.5 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type Hi-Speed USB (for computer)
Hi-Speed USB (for external USB device)
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Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications

Related references
USB Device Photo File Specifications

External USB Device Specifications
Do not use devices with the following requirements:
+ Dedicated driver
» Security settings
* Built-in USB hub
Note: Use only external storage devices with independent AC power sources. External storage devices

that are powered via USB are not recommended. Epson cannot guarantee the operation of externally
connected devices.

Magneto-optical drive 1.3GB
Hard disk and USB flash 2TB
drives Formatted in FAT, FAT32, or exFAT

Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi

Standard IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE
802.11 b/g/n, depending on purchase location

Security WEP (64/128 bit)
WPA2-PSK (AES); complies with WPA2 with support for
WPA/WPA2 Personal
WPA2-Enterprise

Frequency range 2.4 GHz
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Coordination modes Infrastructure mode
Ad hoc mode; no supported by IEEE 802.11 n
Wi-Fi Direct; not supported for IEEE 802.11b

Note: Wi-Fi Direct Simple AP mode available with a Wi-Fi
infrastructure or Ethernet connection.

Ethernet

Standards IEEE802.3i (10BASE-T)
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)
IEEE802.3az (Energy Efficient Ethernet); connected device should
be IEEE802.3az compliant

Communication mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

Connector RJ-45

Note: Use a category 5e or higher STP (shielded twisted pair) cable to prevent risk of radio interference.

Security Protocol

IEEE802.1X; connected device must be IEEE802.1X compliant
IPsec/IP Filtering

SSL/TLS: HTTPS Server/Client or IPPS

STARTTLS (SMTPS)

SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
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Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
» Manufacturer: Askey Computer Corporation.
+ Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications

PostScript Fonts
Font name Family HP equivalent
Nimbus Mono Medium, Bold, Italic, Bold ltalic Courier
Letter Gothic Medium, Bold, ltalic, Letter Gothic
Nimbus Mono PS Regular, Bold, Oblique, Bold Courier PS

Oblique

Nimbus Roman No4 Medium, Bold, ltalic, Bold Italic |CG Times
URW Classico Medium, Bold, Italic, Bold Italic |CG Omega
URW Coronet — Coronet

URW Clarendon Condensed

Clarendon Condensed
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Oblique

Font name Family HP equivalent

URW Classic Sans Medium, Bold, ltalic, Bold lItalic Univers

URW Classic Sans Medium, Bold, ltalic, Bold lItalic Univers Condensed

Condensed

Antique Olive Medium, Bold, ltalic Antique Olive

Garamond Antiqua, Halbfett, Kursiv, Kursiv | Garamond
Halbfett

Mauritius — Marigold

Algiers Medium, Extra Bold Albertus

NimbusSansNo2 Medium, Bold, ltalic, Bold Italic | Arial

Nimbus Roman No9 Medium, Bold, ltalic, Bold Italic | Times New

Nimbus Sans Medium, Bold, Oblique, Bold Helvetica

Nimbus Sans Narrow

Medium, Bold, Oblique, Bold
Oblique

Helvetica Narrow

Palladio Roman, Bold, ltalic, Bold ltalic Palatino
URW Gothic Book, Demi, Book Oblique, Demi [ ITC Avant Garde
Oblique
URW Bookman Light, Demi, Light Italic, Demi ITC Bookman
Italic
URW Century Schoolbook Roman, Bold, ltalic, Bold ltalic New Century Schoolbook

Nimbus Roman

Medium, Bold, ltalic, Bold lItalic

Times

URW Chancery Medium lItalic

ITC Zapf Chancery ltalic

Symbol — Symbol

URW Dingbats — Wingdings
Dingbats — ITC Zapf Dingbats
Standard Symbol — SymbolPS

Parent topic: Technical Specifications
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PCL Fonts

Scalable Fonts

Bold Oblique

Font name Family HP equivalent Symbol set

Nimbus Mono Medium, Bold, ltalic, Bold |Courier 1
Italic

Letter Gothic Regular, Bold, Italic, Letter Gothic 1

Nimbus Mono PS Regular, Bold, Oblique, CourierPS 3
Bold Oblique

Nimbus Roman No4 Medium, Bold, ltalic, Bold |[CG Times 2
Italic

URW Classico Medium, Bold, Italic, Bold [CG Omega 3
Italic

URW Coronet — Coronet

URW Clarendon — Clarendon Condensed

Condensed

URW Classic Sans Medium, Bold, ltalic, Bold | Univers 2
Italic

URW Classic Sans Medium, Bold, Italic, Bold |Univers Condensed 3

Condensed Italic

Antique Olive Medium, Bold, ltalic Antique Olive

Garamond Antiqua, Halbfett, Kursiv, |Garamond
Kursiv Halbfett

Mauritius — Marigold 3

Algiers Medium, Extra Bold Albertus 3

NimbusSansNo2 Medium, Bold, ltalic, Bold | Arial 3
Italic

Nimbus Roman No9 Medium, Bold, ltalic, Bold | Times New 3
Italic

Nimbus Sans Medium, Bold, Oblique, Helvetica 3
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Font name Family HP equivalent Symbol set

Nimbus Sans Narrow | Medium, Bold, Oblique, Helvetica Narrow 3
Bold Oblique

Palladio Roman, Bold, ltalic, Bold |Palatino 3
Italic

URW Gothic Book, Demi, Book ITC Avant Garde 3
Oblique, Demi Oblique

URW Bookman Light, Demi, Light Italic, ITC Bookman 3
Demi ltalic

URW Century Roman, Bold, Italic, Bold |[New Century Schoolbook 3

Schoolbook Italic

Nimbus Roman Medium, Bold, ltalic, Bold |Times 3
Italic

URW Chancery — ITC Zapf Chancery ltalic 3

Medium Italic

Symbol — Symbol 4

URW DingBats — Wingdings 5

Dingbats — ITC Zapf Dingbats 6

Standard Symbol — SymbolPS 4

URW David Medium, Bold HP David 7

URW Narkis Medium, Bold HP Narkis Tam 7

URW Miryam Medium, Bold, Italic HP Miryam 7

URW Koufi Medium, Bold Koufi 8

URW Naskh Medium, Bold Naskh 8

URW Ryadh Medium, Bold Ryadh 8

Bitmap Font

Line Printer, Symbol set 9
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OCR/Barcode Bitmap Font (PCL5 Mode Only)

Font name Family Symbol set
OCRA — 10
OCRB — 11
Code 39 9.37cpi, 4.68cpi 12
EAN/UPC Medium, Bold 13

Note: Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts
may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications

Symbol Sets

Your product can access a variety of symbol sets. Many of these symbol sets differ only in the
international characters specific to each language.

Note: Since most software handles fonts and symbols automatically, you may never need to adjust your
product settings. However, if you write your own product control programs, or if you use older software
that cannot control fonts, refer to these tables for details on the symbol sets.

When you consider which font to use, also consider which symbol set to combine with the font. Available
symbol sets vary depending on the mode and font you choose.

PCL5 Mode Symbol Sets

Symbol set | Attribu | Font classification

name te 4 T2 3 Ja [5 [6 [z [8 [o [10 [11 [12 [13
ISO60: (0D v, v v - - |- |- |- |- |- |- |- |—
Danish/Nor
wegian
Roman |OE |[— |— |— |[— |— |— |— |— [V |— |[— |— |—
Extension
Iso1s: (o0 |V |V IV |- |- |- |- |- |- |- |- |— |—
ltalian
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Symbol set | Attribu | Font classification

name e 1 |2 |3 |4 9 (10 [11 [12 [13
ISO 8859/1 |ON v VvV | — v |- |- |— |—
Latin 1

ISO 11: 0S v VvV | — - = |= |= |=
Swedish

ISO 6: ou v VvV |— - = |= |= |=
ASCII

ISO 4: 1E v VvV | — - = |= |= |=
United

Kingdom

ISO 69: 1F v VvV | — - = |= |= |=
French

ISO 29: 1G v VvV | — - = |= |= |=
German

Legal 1U v VvV | — v o= = [— |=
ISO 8859/2 | 2N v VvV | — v = |— = |[—
Latin 2

ISO 8859/4 |4N v VvV | — — = |= |= [|=
Latin4

ISO 17: 28 v VvV | — — = |= |= [|=
Spanish

Roman-9 |4U v V|V — — = = = |=
PS Math 5M v VvV | — - = |= = |=
ISO 8859/9 | 5N v VvV | — v |- |- |= [—
Latin 5

Windows [5T v V|V — _ = = = |=
3.1 Latin 5

Microsoft  |6J v V|V — _ = = = |=
Publishing

Ventura 6M v VvV | — — = = = |=
Math
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Symbol set | Attribu | Font classification

name © 1 |2 [3 |4 9 |10 |11 |12 |13
ISO 6N v V|V — v = |— |— |[—
8859/10

Latin 6

DeskTop 7J v V|V — _ = = = |=
Math-8 8M v V|V — - = = = [|=
Roman-8 |8U v VvV | — v o= = [= |=
Windows [9E v V|V — _ = = = |=
3.1 Latin 2

Pc1004 9J v VvV |— - = = = [|=
ISO 9N v VvV | — v |- |- |—= [—
8859/15

Latin 9

PC-8 9T v VvV | — — = = |= |=
Turkish

Windows ou v |V V| — — = = [= |=
3.0 Latin 1

PS Text 10J v VvV |— _ = = = |—=
PC-8, Code | 10U v VvV | — v |- |— |—= [—
Page 437

PC-8 D/N 11U v VvV | — —_ = = =
Danish/Nor

wegian

MC Text 12J v |V VvV |— — = = = |=
PC-850 12U v Vv V= v |- |- |— [|—
Multilingual

Ventura 13J v VvV | — = = = =
Internationa

I

PcEur858 |13U v VvV |— _ = = = |=

418




Symbol set | Attribu | Font classification

name e 1 [2 [3 Ja 10 [11 |12 [13
Ventura US | 14J v V|V — — = = |—=
Pi Font 15U v VvV = — = = 1=
PC852, 17U v VvV | — — = = |—=
Latin 2

Unicode 3.0 | 18N v V|V — — = = =
Windows 19L v V|V — _ = = |=
Baltic

Windows 19U v V|V — _ = = |=
3.1

Latin/Arabic

PC-755 26U v VvV | — — = = =
PC-866, 3R v Vv = = _ = = =
Cyrillic

Greek8 8G v v = |- _ = = =
Windows 9G v Vo= |— _ = = =
Greek

Windows 9R VA KV Py g —_ = = =
Cyrillic

PC-851, 10G v Vv = = _ = = |—=
Greek

ISO 8859/5 | 10N v |V — |[— - = = =
Cyrillic

PC-8, 12G v Vv = = _ = = |—=
Greek

ISO 8859/7 |12N v |V — |[— - = = =
Greek

PC-866 14R v |V — |[— - = = =
UKR

Hebrew7 OH v |—= |- |- —_ = = =
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Symbol set | Attribu | Font classification

name te 1 |2 (3 |4 |5 |6 |7 |8 10 |11 |12 |13
ISO 8859/8 |7H v |- |- |- |- |- |V |- — |= = [=
Hebrew

Hebrew8 8H v, |- = = = [|— v, |— = = =
PC-862, 15H il - |- |- [—- |V |- - = |— |—
Hebrew

PC-862, 15Q vi|l— |—= |- |- |— |V |— — |= = [=
Hebrew

Arabic8 8V —_ = = = |- |- |- |V — |—= = [—
HPWARA |9V —_ = = |- |- |- |- |V — |= = [=
PC-864, 10V —_ = |- |- |- |- |- |V - |= = [=
Arabic

Wingdings |[579L —_ = = |- |V |= |- |- — = = |-
Symbol 19M —_ |- = |V |—= |- |—= |- — = = |—
ZapfDigbats| 14L —_ = = = |- |V |- |—= — |= = |=
OCRA 00 —_ = |- |- |- |- |- |- v |- |— |—
OCRB 10 —_ - |- |- |- |- |- |- — v = |—=
OCRB 3Q —_ = = |- |- |- |- |- — v |= |-
Extension

Code3-9 oYy — == |- |- |- |- |- — = |V |—
EAN/UPC |8Y — = = |- |- |= |- |—= — = |= |V
PCL6 Mode Symbol Sets

Symbol set Attribute |Font classification

name 1 |2 |3 4 |5 7 8

ISO Norwegian | 4 v v v — — — _ _
ISO Italian 9 v v v — — — — _
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Symbol set
name

Attribute

Font classification

©

ISO 8859-1
Latin 1

14

ISO Swedish

19

ASCII

21

ISO United
Kingdom

37

ISO French

38

ISO German

39

Legal

53

ISO 8859-2
Latin 2

78

ISO Spanish

83

Roman-9

149

PS Math

173

ISO 8859-9
Latin 5

174

Windows 3.1
Latin 5

180

Microsoft
Publishing

202

ISO 8859/10
Latin 6

206

DeskTop

234

Math-8

269

Roman-8

277

Windows 3.1
Latin 2

293

AN YR YR N NN AN AN AN RN AN AN AN BN AN AN BN I
NANAYA VYR YR VYR VRN AN AN AV ER VAN AN AN ER N AN AN BN by
AN YR NN NN AN AN AN AR N AN AN AN ERN AN AN RN by
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Symbol set
name

Attribute

Font classification

Pc1004

298

ISO 8859-15
Latin 9

302

PC-Turkish

308

Windows 3.0

309

PS Text

330

PC-8

341

PC-8 D/N

373

MC Text

394

PC-850

405

PcEur858

437

Pi Font

501

PC852

565

Unicode 3.0

590

WBALT

620

Windows 3.1
Latin 1

629

PC-755

853

Wingdings

18540

Symbol

621

ZapfDingbats

460

PC-866,
Cyrillic

114

Greek8

263

1 2 3
A L7
A L7
A L7
A L7
R I 4
vV |V
v oo v |V
A L7
A L7
A L7
R I 4
vV |V
v oo v |V
A L7
A L7
A L7
v —
VAR I e
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Symbol set Attribute |Font classification

name 1 2 3 - 3
Windows 295 v v — _ _
Greek

Windows 306 v v — _ _
Cyrillic

PC-851, Greek | 327 v v — _ _
ISO 8859/5 334 v v — — _
Cyrillic

PC-8, Greek |391 v v — _ _
ISO 8859/7 398 v v — — _
Greek

PC-866 UKR |466 v v — — _
Hebrew?7 8 v — — v —
ISO 8859/8 232 v — — v _
Hebrew

Hebrew8 264 v — — v _
PC-862, 488 v — — v _
Hebrew

Arabic8 278 — — — — v
HPWARA 310 — — — - v
PC-864, Arabic| 342 — — — — v

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions

Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions
LCD Screen Safety Instructions

Parent topic: Notices

General Product Safety Instructions
» Be sure to follow all warnings and instructions marked on the product.
» Use only the type of power source indicated on the product's label.

» Use only the power cord that comes with the product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

» Place the product near a wall outlet where the plug can be easily unplugged.

* Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system
that regularly switches on and off, or on an outlet controlled by a wall switch or timer.

» Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

424


http://global.epson.com/SR/environment/recycle/?rdct=recycle

If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

Place the product on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Allow space behind the product for the cables, and space above the product so that you can fully raise
the document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place or store the product outdoors.

Do not place the product near excessive heat sources or in direct sunlight.

Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the product away from potential sources of electromagnetic interference, such as loudspeakers
or the base units of cordless telephones.

When connecting the product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the product.
Do not move the print head by hand; this may damage the product.
Do not spill liquid on the product or use the product with wet hands.

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may
cause fire.

Do not press too hard on the document table when placing originals.

Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

Be careful not to trap your fingers when closing the document cover or scanner.
Except as specifically explained in your documentation, do not attempt to service the product yourself.
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Unplug the product and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged,; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not remove or tear the label on the cartridge; this can cause leakage.

Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to
become unusable.

Do not break the hooks on the side of the cartridge when removing it from the packaging.
Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.
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+ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

» Store ink cartridges with their labels facing upward. Do not store cartridges upside down.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk
of fire, electric shock, and personal injury, including the following:

* Do not use the Epson product near water.

+ Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from
lightning.

» Do not use a telephone to report a gas leak in the vicinity of the leak.
Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

» Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

» Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions
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FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
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This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering
fax header information.

According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Industry Canada technical specifications.

2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENSs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)
Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.

L’indice d’équivalence de la sonnerie (IES) sert a indiquer le nombre maximal de terminaux qui peuvent
étre raccordés a une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, a la seule condition que la somme d’indices d’équivalence de la
sonnerie de tous les dispositifs n’excéde pas 5.

CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Related tasks
Using the Fax Setup Wizard

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™ is a trademark of Seiko Epson Corporation.

Epson Store®™ is a service mark of Epson America, Inc.
Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint and the
AirPrint logo are trademarks of Apple Inc.

Google® is a registered trademark and Android™, Chromebook™, Gmail™, and Picasa™ are trademarks
of Google Inc.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
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certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets

Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2015 Epson America, Inc.
10/15
CPD-42771R1
Parent topic: Copyright Notice
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